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THIS NEW YEAR marks the beginning of a New
Era at Digit. Digit has new parents! In December
2007, 9.9 Mediaworx (www.9dot9.in) acquired
Jasubhai Digital Media, the founding publishers
of Digit.

Today, Digit stands tall in the clutter of
consumer technology magazines. It is
unsurpassed in its popularity—and we thank you,
our readers and advertisers, for your unwavering
support in making this happen. It is an inspiring
story of entrepreneurship and independence
spanning more than a decade.

Digit started as the first home-grown magazine
in its genre. Despite the onslaught of several “me-
too” offerings and global brands, Digit has held its
own due to constant innovations brought about
by a set of outstanding editors and managers,
unstintingly supported by Jasubhai Digital Media.
Today, Digit is more than a magazine about
information technology alone—it encompasses
the gamut of digital personal technologies that
you and I use at home and work.

We at 9.9 Media value and respect the
leadership of this powerful brand and the
following it has created. We are committed to
building on this legacy by bringing about
continuous innovation in our offerings—to
readers as well as advertisers—as we power Digit’s
growth into this new era. Given the potential that
exists, moving forward, we intend to offer you
increased content and insights. Over the next few
months, look for editorial and design
enhancements in the magazine. Expect a more
contemporary online presence at www
.thinkdigit.com. Continue to enjoy lots of value-
addition and stay ahead with Digit.

As we shift gears, this is also a good time to get
more demanding of us! While we enjoy the kudos
we receive, what would help is constructive
feedback on where we are falling short. Tell us what
you expect beyond what we have on offer. Give us
fresh, new ideas. Join us in taking Digit to the next
level. I am confident that 9.9 Media’s association
with Digit will ultimately help in strengthening

your bonds with this wonderful magazine.
As India’s newest diversified media group, we

are committed to a level of quality—in whatever
we do—such that we always deliver above and
beyond the expected and the ordinary. We believe
magazines and content-providers have a
tremendous responsibility to their readers in
delivering content that is not only
uncompromising in its quality, but also clearly
shows respect for the privilege of having the
reader’s undivided attention. I hope you will keep
us honest in our commitment to you! 

Thank you once again for your continued
enthusiasm for Digit. I look forward to staying in
touch and building on our partnership. A very
Happy New Year to all of you!

MD’s Note

A New Era
For Digit

“Given the potential that exists,
moving forward, we intend to offer
you increased content and insights”

Dr. Pramath Raj Sinha
Founder and Managing Director

9.9 Mediaworx



A
AS I MEET and discuss with the various departments
under the Digit banner, I get a feeling that the age
bracket of readers has, over the years, shifted. While
a few years ago the average age of the Digit reader
would not have crossed 22, today it is much higher.
Just to substantiate: we are running a daily contest
for Digit subscriptions on our Web site, and guess
what: over 40 per cent of the contenders are over the
age of 40. I get about three letters on an average, per
day, from readers over 35 years of age. So is it true
that some cool, funky technologies are only for the
young and restless? Data says otherwise…

They say the youth is fleeting; well, maybe in the
gaming world. This definitely is not the case in the
IT industry. Remember the tech stalwarts: Bill Gates,
who started Microsoft at the age of 19, and Steve Jobs,
who started Apple at 21? What is happening to the
youth of today? Looks like they are fleeing!

The revelations that I have received remind me
of the famous Charms cigarette case study. The cig-
arette was launched in a denim pack, to target
youth in the 18-to-25 age bracket. But when a survey
was undertaken, it was found out that the pack was
being lapped up by smokers in the 35-plus age cat-
egory. The reason—smokers in the 35-plus age cat-
egory wanted to relive their youth, so they found
the pack attractive—much more than did the
intended target audience. (I’m not condoning this
mental association, but facts are facts.)

Now coming back to Digit: do we spot a similar
trend in the readership profile of the magazine?
The 40-somethings are individuals who grew up on
the cusp of the IT wave. Since that is a generation
which has dramatically seen how IT can impact
their personal and professional lives, maybe it
wants to ensure that it stays on the cutting edge of
technology. Naturally, people from this generation
are readers of Digit.

The youth, on the other hand, has not seen how
life used to be in all fields before the dawn of the IT
revolution. And how life used to be before Digit.

Maybe I’m reading too much into the phenom-
enon, but it just goes to show that a digital divide

does not exist between the earlier generation and
the current one. In the years gone by, you would
have expected a strong case of IT phobia in the older
generation. Remember the strikes that used to
happen in certain sections of the industry to protest
computerisation? When Big Blue was shown the
door on a political whim? In this day and age, IT has
become the holy grail, as the desktop has become
ubiquitous in every organisation. 

IT has now become an inclusive technology. That
is to say, it does not exclude anyone from reaping
the benefits of technology utilisation. 

The jury is still out on this one. I would love to
hear from your side on this issue—and I am sure that
I’ll get to listen to a fair share of “veteran” voices!

editor@thinkdigit.com

Editorial

Sujay Nair Editorial Director

Young Tongue
And Old Gold

“The youth has not seen how life
used to be before the dawn of the

IT revolution”
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Droolmaal
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DIGIT JANUARY 2008 For any queries regarding the CD or DVD, e-mail help@jasubhai.com with “CD/DVD” as the subject. If the subject is not
mentioned, your mail might not reach the right person.

MOVIES
Done The Impossible

The story of the rise and fall and rebirth
of the cult TV show “Firefly,” as told from
the perspective of the fans who helped
save it.

MUSIC
Aeonblue by Subatomicglue

The artist’s description: “aeonblue fills
the dark chasm of dream and light with a
harder techno edge while keeping the
subatomicglue you’ve come to know. the
aeonblue is a new beginning.”

Wake Up by Dan Masquelier

The artist’s description “Some of my
poems that inspired songs over the past
several years.”

TRAILERS
NCAA March Madness 08
Classic Teams Trailer (HD)
ESPN’s Erin Andrews introduces the
Classic Teams feature

MULTIMEDIA
Paint.NET 3.10

Paint.NET is image and photo
manipulation software designed to be
used on computers that run Windows. It
supports layers, unlimited undo, special
effects, and a wide variety of useful and
powerful tools

Websmartz Banner
Designer Pro 3.0

WebSmartz Professional banner
designer 3.0 allows you to use
professionally designed website flash
templates, add text and image entry
effects to build flash banners in no time.
Banner maker allows you to design
banner of specific size by choosing from
a set of 11 size options

� Aimersoft iPod Copy Manager 2.1.19
� Audiograbber 1.83
� DVDFab HD Decrypter 4.0.1.4
� Hugin 0.7 beta 4
� ImgBurn 2.3.2.0
� KMPlayer 2.9.3.1421 Beta
� MediaCoder 0.6.0.3905
� Movienizer
� PhotoOnWeb 0.7.0.2
� Mobile Ringtone Converter 2.3.64

SYSTEM
Norton Ghost 12.0

Norton Ghost protects presentations,
photos, music, videos, historical
documents, or any other kinds of data you
keep on your computer by making a
backup of your computer’s entire hard
disk. Or, limit your backup to include only
those files that mean the most to you

Microsoft Virtual PC 2007 1.0

Virtual PC allows you to maintain the
compatibility of legacy and custom
applications during migration to new
operating systems and increases the
efficiency of support, development, and
training staffs

� Advanced WindowsCare Personal
� DoublesFinder
� Process Manager 2 Lite
� Sysinternals Troubleshooting Utilities
� Vispa 0.1.2
� Vista Inspirat 2
� Wise Registry Cleaner 2.9.6

INTERNET
NASA World Wind 1.4.0
World Wind lets you zoom from satellite

altitude into any place on Earth.
Leveraging Landsat satellite imagery and

Shuttle Radar Topography Mission data,
World Wind lets you experience Earth
terrain in visually rich 3D, just as if you
were really there

Trend Micro Internet
Security 2008
Trend Micro Internet Security 2008

makes it easy to protect your home
network, personal identity, and online
activity. It guards against present viruses,
spyware, and identity theft as well as the
web threats of tomorrow. Confidently e-
mail, shop, bank, or share photos online,
knowing your privacy and files are well
protected

� Direct Connect for Windows 1.0
� Flock 1.0.1
� Gizmo Project for Windows 4.0.0.324
� GMailGarner 0.95b
� Hamachi 1.0.2.4
� Network Magic Basic 4.2.7234.0
� WebSite-Watcher 4.35

LINUX APPS
APTonCD

APTonCD is a tool with a graphical
interface which allows you to create one
or more CDs or DVDs (you choose the type
of media) with all of the packages you’ve
downloaded via APT-GET or APTITUDE,
creating a removable repository that you
can use on other computers. APTonCD will
also allow you to automatically create
media with all of your .deb packages
located in one specific repository

FREE
Dance Mela
Dance Mela is India’s first Multiplayer Online Dancing
Game. Groove to the latest Bollywood hits. Enter the never-
ending party.

For Digit readers only: Register at http://dancemela
.kreeda.com/partner/digit/ to get your free points!

� Alien Arena 2007 v6.10
� Bear Go Home

DEMOS
Age of Empires 3: The Asian Dynasties
Age of Empires III: The Asian Dynasties, the second expansion
pack for the massively popular Age of Empires III, features the
Japanese civilisation, a new random map (Honshu), and the
chance to play King of the Hill—a new game type.

PERSONAL
Buddi for Windows 2.9.17.0

Buddi is a personal finance and
budgeting program aimed at those
who have little or no financial
background

VisualCron 4.7.7

VisualCron, or cron for Windows, is
a free task scheduler for Windows.
VisualCron has an easy-to-use
interface with a lot of features and
functionality

RocketDock 1.3.5

RocketDock is a smoothly animated,
alpha-blended application launcher
that is similar to ObjectDock.
RocketDock renders quickly like
MobyDock, has the visual sharpness
of Y’z Dock, and the stability that
neither seem to possess.
� FileBox eXtender 2.0
� FreeMind 0.9.0 Beta 15
� iTALC
� Rainlendar 2.2
� Samurize 1.64.3
� Weather Watcher 5.6.24a
� Yahoo! Widget Engine 4.5
� BusinessCards MX 3.6
� CD-DVD Lock 2.7
� Peanut Butter PC 2.2.1.0
� Sandboxie 3.20.01
� SendPhotos Gold v. 3
� ZipRecover 3.10 Build 0729

DEVELOPERS
SWiSHmax 2.0 Build
2007.11.02

SWiSH Max is packed with features
that make producing stunning
interactive Flash animations a
simple and painless experience

Productivity

Entertainment

Tools

GamingF
8,700 MB Of Quality Content!

DUAL LAYER

FREE
Crayon Physics
Crayon Physics
showcases a
gameplay
element right
out of the
recent arcade
favorite Chalk.
Draw squares to guide the red ball
towards the stars to complete each
stage, with challenges usually requiring
the placement of bridges, weights or
elevation objects around the landscape

Bombermania
You will have to
eliminate all
rebelled robots.
To do this use a
unique bomber-
o-mobil equipped
with highly destructive bombs. Blow all
robots up and free your city
� Brixout XP
� Deadly Stars
� Stunt Playground v2

MULTIMEDIA
LEGO Digital Designer for
Windows 2.3
LEGO Digital
Designer lets
you build
anything in your
imagination
using virtual
bricks, right on
your computer

� BlueScreen Screen Saver 3.2
� CamStudio 2.5 Beta 1
� DivX for Windows

2000/XP/2003/Vista 6.8.0.11
� EvilLyrics 0.1.9 Final
� iDeaS 1.0.2.0
� Paint.NET v3.10
� Recuva 1.09.194
� The Gimp 2.4.2
� Tux Paint for Windows 0.9.18
� Xion Audio Player 1.0 Build 85
� XnView for Windows 1.92
� ACDSee 10.0.238
� Axialis IconWorkshop

SYSTEM
Revo Uninstaller 1.4
Revo Uninstaller
might be pulling
into the lead with
the release of
version 1.4. This is
the first version
that comes in portable or installable
versions. In other words, you can
download a ZIP file containing Revo
Uninstaller, throw it on a flash card and
take it from PC to PC, making Revo a
killer app for optimizing every PC in your
home or office.

� ATI Tool 0.27 Beta 3
� Attribute Changer 5.30
� CCleaner 2.03.532
� Ctfmon Remover 2.2
� HostsMan 3.1.51 Beta 3

� PortableApps 1.0.1 Patch
� Remove Hotfix Backup Files
� Shup 0.20
� SSL-Explorer for Windows 1.0.0
� Startup Delayer 2.3 Build 129
� TeraCopy 2.0
� DTweak 3.6
� Trojan Remover 6.6.5

PORTABLE APPS
GIMP Portable
2.2.17
GIMP Portable is the
popular the GIMP for
Windows image editor
packaged as a
portable app, so you
can take your images
with you and do your editing on the go.

VirtualDub
Portable
VirtualDub Portable
is a desktop video
processing and capture application.
� 7-Zip Portable 4.42 R2
� FileZilla Portable 2.2.32
� Mozilla Thunderbird Portable Edition

2.0.0.9
� Notepad++ Portable
� Opera USB 9.24
� Pidgin Portable 2.1.1
� PuTTY Portable 0.60
� Sumatra PDF Portable
� VLC Media Player Portable 0.8.6c

INTERNET
GigaSmilies v1.1b
GigaSmilies is
very simple to
use. Created by
Digit readers
Santosh. S and
Charan. K, you just have to click on the
smiley you want to add in the forum.
The Smiley URL along with the [IMG]
Code will be copied to clipboard
automatically. Then you can simply
paste it in the forum to insert the
smiley!

AI RoboForm
6.9.85
AI RoboForm is a one-
click web form filler and
password manager with
some serious Artificial
Intelligence inside

� Broadband Download Accelerator 1.01
� DreamMail 4.4.1.0
� Dynu Basic 3.24
� FeedFusion 0.92
� FileZilla v3
� GMail Quick Login Green 2.0
� Halite 0.2.9
� Juice 2.2.2-a1
� Youtube Video Downloader 2.3
� IP Sniffer 1.95.02

ESSENTIALS
� .net Framework 2.0
� µTorrent 1.7.5
� Avast Home Edition 4.7
� Avast Update
� Comodo Firewall Pro 3
� Digit Software Archive 2006 Beta
� DirectX Redistributable 9.0c August

2007
� Foxit Reader

TOOLS

GAMING

LAshampoo Photo Commander 5
A Digit Exclusive! Ashampoo Photo Commander 5 is an
all-in-one application for organising, editing, sharing and
presenting photo collections. It also features additional
creativity tools and audio and video management capabilitiesAmerica’s Army (also known as AA or

Army Game Project) is a tactical
multiplayer first-person shooter owned
by the United States Government and
released as a global public relations

initiative to help with U.S.
Army recruitment.

America’s Army
Special Forces

(Overmatch)

Movie
of the
Month

5000
Points
FREE!

MULTIMEDIA

� Free Download Manager 2.5
� Irfan View 4.10
� Irfan View 4.10 Plugins
� Java(TM) 2 Runtime
� K-Lite Mega Codec Pack 3.5.7
� Microsoft XNA Framework

Redistributable 1.0 Refresh
� Opera 9.4
� Silverlight
� Spybot Search and Destroy 1.51
� Spybot Search and Detection updates
� VLC Player 0.8.6c
� WinRAR 3.71

DEVELOPERS
EventLog Analyzer
Free Edition 4.0
ManageEngine
EventLog
Analyzer is a
Web-based,
agent-less
syslog and event
log management solution that
collects, archives, and reports on
event logs from distributed Windows
host and, syslogs from UNIX hosts,
Routers and Switches. It helps
organizations meet host-based
security event management (SEM)
objectives and adhere to demands of
regulatory compliance requirements
likes HIPAA, SOX, and GLBA

Volta from Microsoft Live
Labs Technology Preview

The Volta technology preview is a
developer toolset which enables you
to build multi-tier web applications by
applying familiar techniques and
patterns. You architect and build your
application as a .NET client
application, assigning the portions of
the application that run on the server
and the target client platform late in
the development process. The
compiler manages creating cross-
browser JavaScript for web
applications, web services for any
server side code, and all of the
communication, serialization and
other boilerplate code to tie the tiers
together. You’ll need the the Visual
Studio 2008 Beta from the December
DVD to use this

� VSO Image Resizer
� XAMPP 1.6.4
� Contentteller Pro 1.0 Preview Release

PERSONAL
� Back2zip
� Baraha 7.0 Build 6
� DAEMON Tools 4.10
� HTML Optimizer
� Jabref for Windows 2.3.1
� JustZIPit
� My Pictures 3D Album ver. 0.96
� Outclass v1.2.4.1
� PinNotes 1.2
� Polyglot 3000 2.8
� PopFile 0.22.5
� wikidPad 1.9 Beta 13

PRODUCTIVITY

FreeFor DigitReaders!
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By Demand
You get to choose what goes
on Digit Interactive. This
month, you chose:

Age of Empires 3: Asian
Dynasties
Size: 612 MB

Scratch 
Size: 34 MB

taste technology at www.thinkdigit.com

This Month’s Question                                                 Vote at www.thinkdigit.com

What are your views on electronic publications?

Digit Reader Poll

You just can’t beat the feel of paper
I only read small articles online; it’s still print for me
I’d rather read the electronic version than not read at all
Dump paper! Save the trees! Make Digit an e-mag!

Subscribe
No more snail-mail! No need to visit
post offices! All you have to do is log
on to www.thinkdigit.com/subscribe
and use your Credit Card to make
sure you never miss another issue of
your favourite magazine!

Web Special
Cheapest Trumpet
The Internet can be an inexpensive
way to advertise your business.
Find out how!
(Log on to www.thinkdigit.com)

What do you think of government-imposed security measures in
cyber cafés, such as key loggers, ID checks, and security cameras?

Last Month’s Question

To
ta

l:
6,

11
6

They’re
important
for
homeland
security
24.14%

They
intrude
on our
privacy
10.84%

ID checks
and
cameras
are good,
key loggers
are not
39.79%

Corrupt
government
officials
may misuse
our data
25.23%

Online

FEATURED REVIEW FROM DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
This month we feature a member review from the forum here.

I got Creative’s in-hear noice-cancellation earphones
from the IT Mall,Lamington Rd.,Mumbai for Rs 975.

1.Build Quality - it’s strictly OK.it contains no button
to change songs,that’s a bit dissapointing.the cable
length is just fine coz i’m kinda used to my 5300’s
cable which runs almost a normal person long.the’ve
provided two extra sets of earbuds which is kinda
cool.one pair has larger buds.

2.Bass - The bass in all the songs was very
good,twice or even more better than SE.5300’s has
virtually no bass at all.the bass is low for the drums in
the background.bass guitars sound good.Bass pro-
duced is both types deep and near.whereas W700i only 
has bass thumping closer to the earphone.

3.Sound Quality - Impressive stereo division
although the central voice could have been a tad bet-
ter.almost equal to both 5300 and W700i.
Depth in sound is very good;also xcellent reproduction
of every beat and instrument used in the song.the

vocalists breathing and guitar riffs are quite clear.
The whispers(central not stereo) in some songs are
not that clear. W710i and 5300 sound very mono com-
pared to EP-630.though depth and stereo division is
good in 5300 too.W700i is only loud(less than ep-630)
and the quality is largely due to it’s in-ear type.no
match for EP-630 though.

4.Comfort - not comapring 5300 here.comfortable to
the ears but u do get the suction feeling when you open
your mouth wide-enough.you sense putting on these
when you talk which is not sensed otherwise.the buds
look cheap but do a gr8 job.also the’re very lite.

5.Noice Cancellation/isolation - not comapring
5300 here which doesn’t have any sort of
isolation.Xcellent noice cancellation even at the 3rd
level of volume....

For more visit:
http://www.thinkdigit.com/forum/showthread.p
hp?t=76210

11-10-2007, 10:23
PM

ratedrsuperstar
The Sexy Beast
Join Date: Feb
2006
Location: Mumbai
Posts: 378

MMyy RReevviieeww ooff CCrreeaattiivvee EEPP--663300
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networking sites by
launching OpenSocial, a set
of APIs for creating
applications compatible
across various such sites.
And now, Facebook has
jumped into the fray by
allowing competitors to use
its source code and create
interoperable applications.
For once, Google has been
caught off guard.

Senior executives at
Facebook have announced
that the architecture for its
development platform would
be licensed to its
competitors. This would
mean that applications
developed for Facebook could
run on sites like Bebo, Hi5, or
Orkut. So theoretically, it
would be possible to “tattoo”
your Bebo friends or to send
a “hatching egg” to
Friendster buddies, which is
now only possible within
Facebook. Bebo, a social
network popular in the UK,
has already redesigned its
platform so that it can host
features found only on
Facebook. Last we checked,
they had iLike—one of the
most-used Facebook
applications—on their front
page, no less.

For Google with its
OpenSocial, Facebook’s
move will be hard to
counter. Facebook has

cornered a large slice of the
social networking pie, and
has thousands of third-
party developers around the
world playing around with
their API to make great,
good, and downright silly
applications (like throwing
a cow at friends). These
apps have large user bases,
and developer support for
them is strong. With an
entirely new format and
platform, this loyalty will
be hard for Google to break,
which it has to if it is to
have any hope of catching
the social networking bus.

OpenSocial is, for now,
just a concept with lots of
potential (those millions of
Gmail accounts and Orkut
users)—nothing concrete. It
makes sense for other social
networking sites to
piggyback on Facebook and
use its development
platform. There is the
danger that those sites
could look start looking like
clones of Facebook and lose
their identity, but that’s a
chance they seem to be
willing to take.

In related news, other
sites—like LinkedIn and
Friendster—have opened up
their sites for developers.
Both LinkedIn and
Friendster are partners in
Google’s OpenSocial

initiative, though there is
speculation that they would
also enable their platform
to allow interoperability
with Facebook.

For users the world over,
all this would mean the
breaking down of the walls
around the individual sites,
enabling them to seamlessly
connect with friends and
contacts across networks.
But naturally, this means a
trade-off between
convenience and identity...

Exercise And The
Wii
The world’s getting in
on the get-off-yer-
arse gaming wave—
what could be better

than losing weight while
gaming? There’s even Wii Fit to
keep you, well, fit! Sure, you
look like a total chump while
you’re at it, but people have
done worse to get in shape.

It Doesn’t Help!
According to a
study by the British
Medical Journal,
gaming on the Wii
doesn’t expend
enough energy to count as
“real exercise”, so stop
fooling yourself, and instead
of getting off yer arse and
gaming, get off yer arse and
go for a jog!
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S. Somasegar, Corporate Vice
President, Developer Division
at Microsoft, was in Hyderabad
at the Microsoft India
Development Centre early
December; we caught up with
him for some geek speak about
the new Visual Studio (2008),
among other things

How have programming
enthusiasts reacted to the
Visual Studio Express
Editions? What does the new
Visual Studio hold for them?
The Visual Studio 2005 Express
Editions were huge successes for
us—we saw over 17 million down-
loads for them, and we expect a
similar response for Visual Studio
2008. We realised that not every-
one had access to a high-speed
Internet connection—especially in
developing countries—so we’ve
even decreased the download
size of each Express Edition to
about 30-40 MB. 

How newbie-friendly is VS
2008?
We’ve designed the software
with one thing in mind: people
with a basic understanding of
programming should be able to
start developing their software
fifteen minutes after they start
Visual Studio for the first time.

What do the Express Editions
offer teams of enthusiasts in
terms of collaboration?
Right now, nothing—the
collaboration features are
present in Visual Studio Team
System right now, but that
doesn’t mean we won’t see
these features trickling down to
the Express Editions in future
releases. Distributed
development is growing today,
and it’s going to be a core
scenario to think about when
we develop future editions.
Teams should be able to share
application spaces no matter
where they are. The Express
Editions do have better
collaboration features than the
previous versions, but still not
as much as we’d like.

Direct To Net
Paramount Pictures is experimenting with a radically new
distribution model by releasing a full-length movie
exclusively over the Internet, skipping movie halls. For a
week starting 19 December, Jackass 2.5 was available for free
viewing on the Web (www.jackassmovie.com).

SpeedWire
FireWire has gotten a makeover. The data transfer interface
will see transfer rates ramped up from 800 Mbps to 3.2 Gbps.
FireWire is the commercial name for IEEE 1394, and the new
standard will be called S3200. This is faster than the eSATA
standard, used for connecting hard drives, and also USB 2.0.

Afew weeks ago, the
FBI launched
operation Bot

Roast II, and busted a
ring of cyber-criminals,
who were then charged
with running a botnet
(a network of
compromised computers
under the control of a
central server) that
spanned a million
computers worldwide—and
caused losses worth $20
million (Rs 80 crore). So
how exactly do phishers,
rootkit makers, and
“botmasters” manage to
make their money? The
system is complicated
and ingenious, and like
any efficient criminal
enterprise, it operates
behind multiple, difficult-
to-penetrate layers.

For sale in this
underground
“cybereconomy” are
products that automate the
creation of Trojans. Even
support services are
provided for a period of
time, usually one year. Most
of these Trojan-spewing
rings work out of Germany
and Eastern European
countries, but their services
are available globally.
Botnets can be “rented” out
for spamming or launching
DoS attacks. In 2007’s worst
security attack is believed to
have affected millions of
computers—which came to
be called the Storm botnet.
Botnets, as mentioned,
depend on a central
command-and-control server.
Locating it and shutting it
down is extremely difficult

because of evasive
measures—like DNS
masking—that the
botmasters adopt.

Another hotbed of
piracy, China is home to a
virtual industry that rakes
in millions of dollars for its
players. A study by
researchers at Peking
University in Beijing and the
University of Mannheim in
Germany has shed some
insights into how this
economy works. Malicious
code has high value, with
the market price for
packages of Trojan
generator and evasion
services ranging from tens
to thousands of Chinese
Yuan Renmimbi (RMB). (1
RMB is about Rs 5.) Selling
user data to third parties
means big money as well.
The modus operandi is to

attract visitors to sites by
offering freebies like
music and videos. The
users’ IPs are logged
and sold to cyber-

crooks. Upon the next
visit, the visitors are

redirected to malicious
sites that install malware
on the victims’ machines.
10,000 IPs are sold for 40 to
60 RMB.

Gamers make up one of
the most frequently-targeted
groups. Password theft and
loss of in-game credits is
rampant: in fact, a batch of
Seagate’s hard disks sold
in Taiwan was reported to
have come installed with
Trojans that stole
MMORPG passwords and

other account information.
The kind of criminals

we’re talking about use
bulletin boards to
communicate with each
other and advertise services.

The good guys in this
fight are the security and
anti-virus firms, who have
been slowly buckling under
the onslaught of the attacks.
For now, online crime seems
to pay, and lot.

SOCIALLY OPEN

Facebook
Opens Up

The social networking
world has been seeing
some not-insignificant

upheavals of late. A little
while ago, it was Google’s
attempt to break down the
walled gardens of social

Enter

Security Watch

CRIMINOMICS

Crime Pays, And How!
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n British drivers to be jailed for using mobiles while driving n Online version of OpenOffice.org available n Google Talk introduces in-chat translation n Firefox 3 beta 2 released with completely revamped download manager n Physiotherapists have been prescribing the Wii to patients n 

S. Somasegar
Corporate Vice President

Developer Division Microsoft

Patch IE, Update
Flash Player
The Problem
Vulnerabilites have been
reported in Adobe Flash Player
as well as in Internet Explorer (6
and 7). The former is “Highly
Critical” according to security
firm Secunia, and the latter is
worse—“Extremely Critical.”

The IE vulnerabilities are
four in number, and one of
them is reportedly being
actively exploited. Successful
exploitation can mean your
computer being used to execute
arbitrary code (read: it can be
taken over).

The Flash Player vulnerabili
-ties are in versions prior to
9.0.115.0, and there happen to
be as many as 10 of them.
There are also multiple things
that an attacker can now do as
a result of the vulnerabilities,
but being safe is only a matter
of updating the software.

The Solution
If you have Flash Player 9.0.48.0
and earlier, you need to update
to version 9.0.115.0; get it from
www.stage.adobe.com/go/getfl
ash. As regards the IE
vulnerability, if you have XP SP2
with IE6, visit
http://tinyurl.com/2r63sb. For
XP SP2 with IE7, visit
http://tinyurl.com/2qdbqv

Do you use your cellphone to access the Web using GPRS/EDGE/WAP?
(You, too, can participate in this poll—at www.thinkdigit.com)

Yes, I surf the Web on mobile daily Yes I use it only once-twice a week

I don’t, because I feel it is not secure (Bad experiences, if any) No; speeds are very slow. (Name the service provider)DC

BA

(You, too, can participate in this poll—at www.thinkdigit.com)

Opinion Poll

Option B. I use it only twice a week, and
that too for checking e-mails and offline
PMs. The pathetic speeds are
waste of time and on top of
that we have to pay huge bills
every month. Its my last resort
on the Internet but its useful
when I’m on vacation.
Gaurish Sharma
Jaipur

I have a Symbian phone and using GPRS is
such a breeze that I can get info of any-
thing on the go—anywhere,
anytime. In addition, I use it as
modem with my PC too.
Rajesh Kumar Jaiswal 
Jaipur

I’ll definitely go with option D. I don’t
use the Mobile phone for surfing simply
because the speeds are
extremely slow and expen-
sive too with my service
provider—Vodafone.
Sukhdeep Singh Kohli
Jalandhar

Option D. I did use GPRS when I had nokia
N-Gage QD for the N-Gage Arena service to
talk to other N-Gage users and
download games. After I sold
the N-Gage, I got GPRS deacti-
vated—there was no point pay-
ing so much for slow speeds.
Niranjan Naik
Pune

I’ll go for option D. I don’t surf the Web
on my mobile since I heard that speeds
aren’t too good. I don’t mind
trying to surf on my mobile
phone, though.
Prakash Jose Kokkatt
Muvattupuzha, Kerala

My choice is option D. I never even think
of connecting my Mobile phone for surf-
ing as the speed is as slow as
a snail. In place of that, I’d
love using my Laptop for surf-
ing by connecting through
AirTel Broadband.
Amit Anand
Jharkhand
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GO GREEN—LITERALLY!

Bamboo
Goodness

Apple, which today
sells sleek
aluminium iMacs,

started out with the Apple
1 in a wooden box.
Manufacturers soon shifted
to synthetic materials for
casings, which were
cheaper but turned out to
be harmful to the
environment. E-waste is a
growing problem the world
over, and is exacerbated by
the rapid changes in
hardware, which
necessitates frequent
upgrades.

ASUStek Computer,
which markets its products
like notebooks and
motherboards under the
ASUS brand, has unveiled a
laptop which, it hopes, will
change the trend. The ASUS
Eco Book, in the prototype
stage, is encased in bamboo.
Laminated strips cover all
the surfaces of the prototype
except for the keys,
trackpad, and monitor.

For countries in
South-East Asia, this
environmentally-
friendly laptop is a
boon. Bamboo grows
abundantly in this
part of the world,
and its rate of
growth is way faster
than that of a tree.
With municipal
landfills in
developing countries
chock-full of plastics
and hazardous
chemicals like the
lead and arsenic used in
computers, the demand for
such green computers is
likely to be huge. But these
laptops are still not ready
for prime time. The heat
released from processors
and monitors is a big
concern, as are problems
related to rough handling.
These laptops are also not
entirely green: the glues
and laminates used for
fortifying the bamboo
might contain toxins.

Green computing has
been a growing corporate
trend. Manufacturers have
been trying to make each
and every component more
eco-friendly—whether it’s

chemicals used in
fabricating cases, or the
materials used in chips. Dell,
Lenovo, Apple, and HP are
all concentrating on cutting
power wastage, recycling
components, and improving
efficiency. A laptop made
from bamboo fits neatly into
the scheme of things.

HACK ATTACK

Apple? And
Security?

The iPhone is
undeniably hot. It’s so
hot that people have

stood for days in long
queues to buy it, and its
manufacturers have had to
prevent people from buying
more than five handsets.
Now, though, the rock-star
popularity of the iPhone
might work to Apple’s
disadvantage in terms of
increased security attacks.

Apple’s operating
systems have always had a
reputation for solid
security. While Apple and
its legions of fans tout these
as features, more neutral
observers ascribe the
seemingly hacker-proof
features to a miniscule
market share (single digits).
Hackers and cyber-crooks
simply do not get enough
returns on their efforts.

With the release of the
iPhone, Apple has come
from niche to mainstream.
And it’s not only Apple’s
competitors that have
noticed the surging sales:
since the iPhone runs a full-
blown Mac OS X 10.5, the
iPhone is wide open to
malicious attacks. With
millions of iPhones in the
market, volumes have
become enough to justify
serious attacks that would

A Round-up Of Technology News From Across The GlobeThe Digital World

CHINA
Yahoo! China has
been accused of
promoting piracy, as
search results lead to
sites that are
repositories of
illegally-copied music

SAUDI ARABIA
YouTube is the rage
among the country’s
youth, with videos of
drinking binges and crazy
car chases being uploaded

NORWAY
By 2014, all government
documents must
compulsorily be published in
three open formats—HTML,
PDF, and ODFGERMANY

After a challenge by
Vodafone, higher courts have
forced T-Mobile to sell the
iPhone without locking the
device to its network

UNITED STATES
Microsoft, Yahoo, and Google are to
pay fines totalling $31.5 million (Rs
125 crore) for having promoted
illegal online gambling in 1997 IRAN

Authorities shut down 24 Internet
cafes as part of a crackdown on
immoral behaviour. They were
particularly annoyed by computer
games and obscene photos

n Apple rumour site ThinkSecret.com closes after settlement with Apple n Iran builds supercomputer on Opterons; maybe for nuclear programme n 
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Photograph Jyotbeet Singh Each month Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 20th of this month.

Digit Caption

Oh no! I can’t find my pet
ant!

yield significant returns in
terms of user data stored on
the phones. Already,
hackers have breached the
security features of the
iPhone (they’ve unlocked it
from the AT&T network),
and have installed third-
party applications. Though
these hacks have been
rendered ineffective by
firmware upgrades,
determined attacks on the
basic platform would pose
actual, serious threats that
would need more than a
simple upgrade. Attacks
could involve the spread of
mobile worms, which could
render individual handsets
useless, or the creation of a
vast mobile botnet for
sending out spam mails and
SMSes. This scenario is now
a distinct possibility
because of the ubiquity of
the iPhone.

2008 could very well see
the release of security
products targeted at Macs.
Bad news for fanboys, but
reassuring for corporates
and businesses who are still
leery of trusting valuable
data to systems that do not
have security features.

WIKI-KILLER?

A Knol of
Wisdom

Of late, Google has been
diversifying from its
core search business,

getting into areas like
telecom and security. Now
it’s knowledge management
and distribution à la
Wikipedia that the Big G has
set its eyes on.

Google has announced
the launch of a new project
called Knol, which aims to
be a repository of the
world’s information. The
blueprint for Knol is to allow
experts to write definitive
articles in their field of
expertise. On the face of it,
this sounds like Wikipedia.
But there are some
differences—each topic or
page on the Knol, called “a
knol” (a unit of knowledge)
will be effectively owned by
the author, who will not
remain anonymous. There
might be multiple knols on
the same subject, and they
may only be edited by the

author or with the author’s
permission. This model
borrows from Squidoo, a
content management site
that lets authors own their
pages. Google will not act
the editor in any way, and
there will be nothing like an
official knol for each topic. It
aims only to provide the
tools and the server space.
Knol, currently in private
beta, is open to users by
invitation only.

Google will also host ads
on each knol. The upside is
that authors will get a
significant share of the
revenues (the actual
percentage is being worked
out). Industry watchers are,
however, divided on the
feasibility of another
knowledge repository, and
are also suspicious of
Google’s aims. It’s a known
fact that for many searches,
the relevant Wikipedia entry
comes at the top of the
results page. When users
click on that link, they go to
a site where Google cannot
put in any ads… This means
a potential loss of millions
of dollars in ad revenue.
Again, there is the danger

that driven by ad revenues,
there might be a
proliferation of knols on
commercially-viable topics
like microprocessor
architecture or fashion
design, and less about the
Peace of Westphalia and
Sumerian civilisation.

The most basic argument
is, however, that since
editing rights are locked,
knols might contain biased
viewpoints, or that they
might contain outdated
information. But there are
certain arguments in favour
of this new model. For one,
since authors will no longer
be anonymous, they might
keep their knols objective
and updated. Unlike
Wikipedia, where each page
can be modified by all and
sundry and it is often
difficult to separate the
wheat from the chaff, Knol
could result in pieces of
authoritative work.

But then again, knols
can be searched by search
engines, and there are fears
that Google might tweak
its algorithms so knols
feature at the top of search
results. However,

Last Month’s Winner!
Nobody!
Sorry, you couldn’t match up to
our crack team of caption-ers

n Windows 7, the successor of Vista, to support touch features n Microsoft offers free copies of Vista and Office 2007 in exchange for user data. n 

E-mail your caption with the
subject “Beat That”, and your
postal address, to
beatthat@thinkdigit.com
and win 
JavaScript, DOM 
Scriptinh and AJAX 
Projects
by Frank W. Zammetti

Published by
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competition is, in general,
good, and this proliferation
of free content will only
benefit the end user!

DATA RAYS

Playing With
Photons

With each
generation,
processors are

getting smaller and more
powerful, which you know
all too well; the current
emphasis is on multiple
cores, higher bus speeds,
and larger caches. However,
some basic principles of

processor design have
remained unchanged over
the years. One of these is
the mode of data transfer—
wires have always been used
for transferring data within
a single core and also
between cores. 

There are problems,
however. At the basic level,
transfer of data means the
flow of electrons, and this
produces heat—which is a
huge problem when it
comes to modern
processors. Electrons also
can’t travel faster than a
certain velocity. The second
factor has little bearing on
quad-core systems, but
when the number of cores
becomes something like 12

(Intel and AMD already
have plans for octa-core
processors in two to three
years), this architecture
will be inadequate.
Companies like IBM and
Intel have been pouring
millions of dollars into
research on new processor
fabrication designs and
allied technologies; one
result of these efforts is
IBM’s advances in
transferring data at the
core level using light.

IBM’s researchers have
improved upon the Mach-
Zehnder electro-optic
modulator, which is, at 200
micrometers long, more
than 100 times smaller
than similar devices. This
modulator converts electric
signals into light pulses. A
laser beam is kept focused
on the modulator, and
when the electric signal
carrying data falls on the
modulator, it gets
converted into light. This
light beam falls on the
other core’s modulator,
where an inverse process
converts light to electronic
signals. Since light travels
faster than electrons in a
wire, this means that data
flow would be faster,
resulting in the possibility
of higher clock speeds.
Since there is no heat
production when light
flows, this increased
performance won’t come
with higher heat emissions,
which is the bane of today’s
processors. Since cores are
separated by 200 to 400
micrometers, this optical
modulator seems possible
in theory.

In practice, researchers
say there is a lot of work to
be done before chips using

this technology reach store
shelves. Size is a big factor
to consider; it is very
difficult to manufacture
optical components at such
micro-scales. Besides, the
processor architecture
needs to be changed if this
is to be implemented.

DEEP WATERS

Standard
Trouble

Microsoft has several
times been accused
of unfair business

practices, and has been
rapped both by US and
European free trade
regulators for throttling
competition. All these years,
the company has been able
to shrug off the accusations
owing to the strong
performance of its products.
However, with the lower-
than-expected performance
of Vista and Google
breathing down its neck, it
looks like they’ve been on a
sticky wicket and are open
to mending their ways...

Pursuant to this new
“strategy,” Microsoft
recently announced it
would sign a deal with the
makers of open source
server software Samba,
which will enable Samba
software (which allows
Linux users to share file
and print services on
Windows machines)  to run
smoothly on Windows.
This deal was the result of
a 2004 EU ruling, backed
by another one in
September, which held the
software manufacturer
guilty of not sharing

Speculation has been rife in tech circles about an
upcoming “Gphone,” from Google. They went an
entirely different way though, releasing a software
stack for mobile phones, called Android.

Android is a combination of operating system, user
interface, and Java-based applications like e-mail
client, SMS, browser, maps, contacts, database
management, etc. Built on the Linux kernel 2.6,
Android development is open source and platform-
independent. Essentially, this means that software that

is developed will run on a wide variety of handsets.
The Open Handset Alliance, a conglomeration of 34

companies—handset manufacturers (Motorola, LG),
carriers (T-Mobile, Sprint), hardware companies (Intel,
NVIDIA, Qualcomm), and software companies (eBay,
Google)—is supporting the development of Android. 

Google has released the Android SDK for
developers, and has earmarked $10 million as prize
money for innovative applications. Phones working on
Android are expected to be shipped by the end of 2008.

IBM has 73,000
employees in
India, a 40%
increase from

2006.

UK gamers spent
£1.52 bn on
games (Rs

12,300 crore ) in
2007. 78 million
game titles were

sold; games
accounted for

79% of all
software

Mobile subscriptions in 2007
touch 3.3 billion—about 50%
of the world’s population

Cell phone users in China are
the biggest users of text
messaging services, with an
average of 967 messages per
person per year.

n Intel releases a fingertip-sized solid-state device that stores up to 16 GB n World of Warcraft gaming laptop introduced by Dell and Blizzard n 
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Enter

Intel Moorestown
What’s that?
The latest design architecture
from Intel, Moorestown will be
used in the Ultra Mobile PCs
(UMPCs) and Mobile Internet
Devices (MID) of the future.

Why are we talking about it?
The platform is touted as being
a “system on a chip”; it will
include a powerful 45nm
processor core and the graphics
and memory controllers on a
single die. It consists of two
parts: a flexible die design that
can include dual-core
processors if needed, and an I/O
chip that provides connectivity
to an inbuilt graphics
accelerator. It can also support
a DDR3 memory controller, PCI-
Express, USB, SATA, and WiMAX. 

Where is this headed?
The future of MIDs and UMPCs
depends heavily on platforms
that can handle computation-
heavy tasks while being energy-
efficient, since the trend is that
of tasks traditionally carried out
on a computer shifting to
mobile devices.

Who would be interested?
Everyone from HTC (high-end
phone designers and
manufacturers) to Palm to
Nokia. Those into operating
systems—like Microsoft and
Canonical (the developers of
Ubuntu)—are also looking at this
with great interest—they’d want
a slice of the pie, of course.

How will this affect us??
This is speculation, but it does
seem that everything you
currently do on your computer
will be possible on the mobile,
from browsing HTML Web sites
and watching HD movies to
using GPS. Moreover, the
devices will run at least 20
times longer than the current
generation of mobile phones,
according to Intel.

When can we start playing
with these devices?
Not anytime soon. The launch
date for the platform is
expected to be around the
middle of 2010.

details of protocols which
would enable servers made
by rivals to interoperate
seamlessly with Windows.
An appeals court ordered
the company to remedy
the situation by sharing
the relevant data. This
Microsoft delayed, and as a
result, the market share of
other companies shrunk to
nearly zero, while sales of
Microsoft servers (SQL
Server, Exchange Server)
surged. Samba was the
only open source
alternative in the market—
and it survived.

Now with much-needed
documentation, which it
acquired for €1 0,000
(Rs 5.7 lakh), Samba will be
able to work on Windows
without any glitches. The
documentation will be kept
confidential, though the
source code for the
applications that use these
protocols would be
released under the GPL.

In fact, Microsoft’s
seems to be abandoning its
strategy of running
roughshod over the
competition, and seems—
just seems—to be becoming
more reasonable. The new
IE8 has passed the Acid 2
test, which determines
whether browsers adhere
to the official W3C (World
Wide Web Consortium)
standards. This is good
news for millions of Web
developers, who have been
forced to make different
versions of the same Web
site for IE and non-IE
browsers. Besides, previous
iterations of Internet
Explorer had plenty of
security holes, and one way
of sweeping away the
detritus would be by
following accepted
standards. This
announcement was
probably related to Opera
filing a complaint against
Microsoft accusing it of
using non-standard
protocols that force Web
sites to follow suit, thus
putting other browsers at a
disadvantage.

Microsoft is sometimes
called the Evil Empire: it is

finally getting mellower?
The jury is still pondering
about this one...

MAKING A DIFFERENCE

Games For
The Good

The number of games
in the market that
feature violence and

gore, primarily to stand
out in the crowd and
attract fans, has been
steadily increasing. Some
are so disturbing that
censors have fought to
prevent their release: a
case in point is Manhunt 2’s
troubles with British
regulators. Efforts are on,
though, to harness the

potent visualisation and
interactivity of computer
games in other, more
socially beneficial ways. 

Games that simulate
terrorist attacks and
hostage crises have been
long used by law
enforcement agencies to
train personnel. There’s a
problem with these games,
though—they are so niche,
they don’t appeal to
mainstream gamers. To
remedy the situation, a
prestigious New York-based
Parsons The New School of
Design has recently
launched PETLab,
comprising its faculty and
students, to study how
playing games might push

players towards developing
a social conscience. The lab
will interact with game
designers, educators, and
other stakeholders to
design games like ~Ayiti:
The Cost of Life~, where
players need to manage the
day-to-day life of a family of
five in Haiti. In a typical
scenario, players might be
expected to decide on
whether to throw a bash or
buy healthy food. Such
games might also take
elements from city
simulation games like the
~SimCity~ series and teach
players how to do things
like reducing global
warming and curbing
wasteful food habits. 

Backed by a $4,50,000
(Rs 1.8 crore) grant from
the MacArthur foundation,

PETLab is in collaboration
with Games for Change, a
non-profit that supports
serious game designers,
and think.MTV.com, MTV’s
socially-oriented Web site.
It is also negotiating with
Microsoft to determine
whether the Xbox’s game
development tool could be
used to create games in
these genres.

The news that games
can heal has been much in
the news the past two years,
and no-one now doubts that
games can be used for more
than entertainment. These
new initiatives, though,
don’t sound entirely
convincing, but we won’t be
downright pessimistic. 

n Toshiba launches batteries that last 10 years with five minutes of charging n The NYSE replaces UNIX on its servers with Linux n 



I know not with what weapons World War III will be fought,
but World War IV will be fought with sticks and stones.

— Albert Einstein

Iremember that quote well; I’m one of the reasons the great Einstein was
proved wrong. But then, even Einstein couldn’t have imagined how fast
technology would invade our lives.
The quote was very popular during the Cold War, and even aided gov-

ernment-funded propaganda. Those were the days when most of us lived in
fear, with images of mushroom clouds in our nightmares. The rich and para-
noid built underground bunkers and stocked them with a year’s supply of
food. The rest of us would dart furtive glimpses at the sky at even the hint
of a siren. When the Cold War finally ended, World War III began…

The third instalment is actually the only real World War. The soldiers
are called “terrorists,” and the battlefield is your backyard. It continues
today; though governments have fought back and tried to minimise such
events, you probably still read about the odd incident halfway across the
globe, if not right in your city. To be honest, I cannot complain much
about it, because WWIII is what forced countries to go high-tech, get con-
nected and start depending on technology—it’s what lets me afford my

luxurious life.

Who Am I?
I can’t tell you my name for obvious reasons, but I can tell you that

World War IV has begun, and I’m just one of thousands of soldiers
fighting it. I’ve never held a real gun in my life, though I’ve fragged my
fair share of enemies in my favourite FPS game. I’m certainly no James
Bond either, and I have a fast-developing pot-belly—the kind beer-drink-
ing couch potatoes proudly sport. I have a regular day job, which

involves nothing more than sitting in front of a PC while I administer a
small company’s servers, so obviously, I bore easily. What I do have,

however, is something my government is willing to pay a premium for,
and it’s the reason I have my moolah locked safely away in a Swiss bank
vault. I drive a Maruti, but I can afford better. I live in an apartment—a
true bachelor’s pad—but no women ever visit. I guess they don’t like the
smell of rotting pizza, or my décor—if you can consider eight LCDs, four
PCs and spaghetti tangles of wires “décor.”
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able to thwart my “attack” in a little under two
hours if they’re efficient; six, even if they’re not—
ample time for us to plant our little e-bombs.

My measly 100 Mbps connection is hardly
strained while DDoS-ing the four government
sites, my friends have already gained access to the
railway servers. In under 45 minutes, they have
access to four major airports, and no-one’s the
wiser. We’re won’t crash any planes… we probably
could, though.

The Motherlode
My IRC chat client goes berserk. I get 40 messages
in under three seconds, causing my speakers to
spit out the “bing” alert multiple times in a quite
confused manner. “Hallelujah, Eureka,
wheeeeeeeeee,” screams a friend. “What?” I ask.
“Jackpot, baby, jackpot. We’ve hit the mother
lode!” he types back in all caps—quite intention-
ally. Not only do the Thirteen Ghosts have access to
the Rail Services and Airports, he’s also managed
to penetrate the traffic system, while his sister—
who, incidentally, is amongst the top 50 hackers
in the world—thinks she can get into the payment
gateway of the country’s largest government bank
in about two hours. Oh well, if bank admins are
dumb enough to use keyboard combinations for
their passwords (azsxdc, 1p2o3i, etc.) they deserve
to be robbed. She gained access with a simple
brute-force password cracker, putting to full use
the power of her Intel 80-core rig.

State Sponsorship
We have no doubt that the country’s hackers
will attempt to hit back at us or our countries.
We’re waiting. All of us have had substantial
jumps in our personal Net worth; vive la PayPal!

A few days later, my contact returns. His superiors are thrilled.
Besides our payments, he’s also offering to send me an iPod Pico 
for a job well done. “No thanks,” I type out, “I’d rather you not know
where to send it.” A few lols later, he leaves. Oh well, playtime’s over.
It’s back to work... 

editor@thinkdigit.com

I’m a geek of the highest order, and
yes, I will inherit the Earth. I trudge
through my work day, itching to get
home and start the real fun. At night, I
sit awake at my PCs, probing computers
across the world looking for backdoors.
Currently, I have a little over two million
drones in my botnet, but still I can’t seem
to make it to the Top 50 Hackers list. I’m
hoping that will change soon.

I have a meeting today, so I rush home,
kick off my shoes and log on. I find my way
to my IRC chat room and I see my contact
is already there. He’s been waiting impa-
tiently playing the trivia game on the
room’s bot. I know this because a mil-
lisecond after I log in, he messages me and
tells me. It’s straight to business; he informs
me that the Chinese have been attacking gov-
ernment sites with DDoS attacks and are gen-
erally being a pain. He’s willing to pay me to
return the favour. It’s not really big money,
but hey, it’s still some fun… The icing on the
cake is that I know I’m not going to be caught.
A license to kill—people’s inboxes, PCs and Net
pipes, that is.

I give him my PayPal account details and just
as I’m about to leave, he says, “Hang on. I just got
new authorisation.” I can smell the money, so I
wait patiently. In 95 seconds he’s back, telling me
his “company” has authorised him to pay a sig-
nificantly higher amount for information or a
backdoor into the Chinese government servers.
For a considerably lower bounty, I can hack their
Web sites and redirect them to, well, pretty much
anywhere I want. “Nice,” I mutter to myself, “I’ve
been eyeing the iPod Pico for some time now.”

Just Business
Now big government hacks may pay a lot, but I
can’t stop my bread-and-butter business. I pop open
a console window, create a batch file and send it
over the botnet. Over two million PCs worldwide
are connecting to popular sites in China, slowing
them down and preventing legitimate access. I’m
earning $50 per hour per site, and I can easily keep
these sites down for six hours before they ban most
of my botnet’s IPs. Of course, I’m not going to stop
there. In another IRC room, the list of connected
users reads like an FBI’s Most Wanted list. I
announce that I have a paying job, and in under 10
minutes I’ve recruited 14 soldiers like myself. With
a collective botnet strength of over 20 million, I
can keep the attack on for days—though I’m
sharing the spoils, I still get the lion’s share.

The smell of money wafts into the air as I
remember the other offer. I know just where to
find the right people for the job. Unfortunately,
these guys are way better than me, and expect a
lot more money. Still, 10 per cent of a lot is way
better than 100 per cent of a little. It will take a few
days to co-ordinate the whole thing, but we have
the luxury of time.

Playing Sniper
To begin with, one of my “friends” reports that
the Chinese government site is easily hackable: it
seems to have little or no security. It will be easy
to deface the site, but it will be just as easy for the

site admin to get it back to normal—unap-
pealing. A few days later, another friend, who
specialises in Trojans and backdoors for Linux
server machines, happily announces that he has
found his way through the first hack into the
Web server, and can now connect to the Chinese
railway system. A little more probing by our
team reveals that it’s quite possible to get into
some major airports too.

News spreads fast in our little online world,
especially when there’s money involved. My spe-
cialty has always been the networking. No, not
the WiMAX/LAN type; I’m talking (anti?) social
networking—I just bring like-minded people
together and unite them in a cause. I will help test
the backdoors, but after a few days, because we
can’t risk waking the sleepy admins whose sys-
tems we’re penetrating.

I report to my “company” contact and give him
all the details we have—14 popular sites can be
defaced, including China’s most popular directory
listing site and four government sites. Apart from
that we can gain access to some A-grade city
grids—air, rail and road services can be tampered
with. “Excellent,” he types, “give me a day to report
this.” He’s back in less than 12 hours with his
orders. Full-frontal assault, take no prisoners!

The Attack
D-day approaches. It’s close to the Chinese New
Year, which means loads of tourists and a strain
on the infrastructure—perfect! By now my little
army has grown to 13 people from four countries.
We sit around nervously in our IRC chatroom and
joke about what to call ourselves. “Thirteen
Ghosts,” someone suggests. It sticks—we like the
idea of being able to get in and out like ghosts.

The attack begins the next day. While the
geniuses start by gaining root access to the Web
servers, I run a script to start a DDoS attack. I’m
attacking some other government sites on the
same IP masks as the compromised server. I’m just
a smoke-screen, toying with useless servers to keep
any alert admins busy. These admins should be

Chinese tried to hack
Australian Government 
PCs too
The Chinese allegedly tried to hack
into highly classified government
computer networks in Australia 
and New Zealand as part of a
broader international operation 
to glean military secrets from
Western nations.

Yahoo! News,
September 12,  2007

Hacked: Email inboxes of
Indian missions in US and
China; NDA, DRDO officials too
Taking a dig at cyber security
preparedness levels, a hacker, who
claims to be based in Sweden,
posted online this evening the
passwords of 100 email accounts of
embassies and government offices
across the world, including 13
Indian accounts, containing
classified information and
correspondence... Indian

Ambassadors to China, US, Sweden,
Germany, Italy, Oman, Finland
besides officials of the National
Defence Academy (NDA) and
Defence Research and Development
Organisation (DRDO).

The Indian Express,
August 31, 2007

World on the brink of global
cyber warfare?
The latest annual security report
from McAfee has singled out China
as a particularly virulent source of
international cyber espionage, with
a number of Western nations said to
have experienced significant
episodes in the past year. However,
there is evidence to suggest that a
far more sinister online threat could
be around the corner from nations
other than China—state sponsored
cyber attacks on vital
infrastructure.

IT Wire,
December 2, 2007

Real Headlines 

There
are signs

that intelligence
agencies around
the world
are constantly
probing other
governments’
networks looking
for strengths and
weaknesses and
developing new
ways to gather
intelligence”

Peter Sommers
London School of
Economics

Breaking News
January 1, 2013, Beijing

Ahacker group that calls itself the Thirteen

Ghosts broke into Government sites this morn-

ing. Six of the big cities had flights grounded for

over six hours; rail systems are still not back

online and traffic lights went haywire, causing a

few hundred fender benders. The worst hit was

the National Bank, which was first DDoSed, then

hacked into. As a result, millions of dollars were

donated to charities across the globe and

detailed information about thousands of credit

cards was stolen. This is the worst cyber-attack

the world has ever witnessed, and a Government

spokesperson puts the estimated damage at a

little over $1 billion US. Luckily, no human casu-

alties have yet been reported due to the mayhem

that continues even now.



Day 1
Unpacked it… Satin black aluminium front, chromedsteel rear reminiscent of the first generation nanos. It’smuch shorter than previous nanos, and slightlyslimmer and lighter. Build quality is exemplary—typical Apple—and the contoured body is stylish. Thenano 3G supports video playback on its 2-inch display,with a resolution of 320 x 240.

Day 2
The click-wheel feels solid; iTunes is still the same—music needs to be dragged from its interface to thenano if you’re being selective, or you can sync the nano.Something new: the nano 3G shows up as a removabledrive even without iTunes (although iTunes is neededfor all multimedia files). After ejecting the nano, it stillcharges through USB. iTunes still won’t detect FLACfiles—sad.

Day 4
Apple’s default earbuds leave much to be desired ifyou’re discerning about quality. Swapping these withmy EP630 proves a serious step-up. I used our BoseIntra-Ear earbuds and was even more impressed. Thenano offers punchy bass that is low yet tight. Mids aresuperbly detailed and highs are well-represented—perfectly neutral-sounding.

Day 7
Paired this with my home setup—a tube amp coupledwith my Sennheiser HD650 cans—and played a fewfavourite tracks (320 kbps). All the depth, clarity anddetail was there; audiophiles who want portable source,consider this. I also tried the nano with the HD650s andno amp—there was an immediate loss in detail, thoughsurprisingly, the result wasn’t too bad, considering theoutput impedance of the nano is 40 ohms, while theHD650 is rated at 300!

Day 11
Copied a few photos and a video. The screen, while goodenough for photos (crisp and bright), isn’t all that greatfor movies. For one, the viewing angles aren’t good.

Besides, I like my videos on a bigger screen. Skip thenano 3G if you’re looking at a video player.
Day 14
Attempted a firmware flash—the application is nowpart of the iTunes setup. It’s quirky: the downloadcrossed 100 per cent, but never completed. ReinstallingiTunes with my Net connection active sets the problemright. You can revert to the previous firmware at theclick of a button.

Day 17
The nano allows me to download podcasts from theiTunes Store. Tried a few free audio and video podcasts.Even TV serials are available for purchase from iTunes,and this is where having a video player becomes a majorplus. You can also download books from their library—this is where the true power of iTunes is realised: rich andvaried multimedia content.

Day 23
Decided that video playback was not bad—just not muchof an experience on such a tiny screen. Album Art whileplaying MP3s is more fun, courtesy the larger screen—pity it couldn’t get larger.

Day 23
If you want to cart your entire collection withyou, don’t buy this— 4 / 8 GB is all you get. Ifyou want a good movie player, lookelsewhere. If you want something fancy,get the iPod Touch. If

you want something
really compact with
amazing music
quality, the nano 3G
at Rs 6,500
(4 GB) or Rs 8,500 (8
GB) is the only way
to go.

michael_browne@
thinkdigit.com

Michael Browne
We’re such busy people at Digit—so busy, we forget to stop munching, and neglect our health. I needed a workout buddy, and fast—a

PMP compact enough to pocket while jogging, plus good sound quality… Here’s an account of my first month with the iPod nano 3G.

Apple iPod nano Video

Digital Passion l 30 days with...

30
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he VRX Mach4 brings the sensation of real world
driving to your home, but without all the danger! The
Mach4 is a Quad-Xbox360 chained together to power

the three gigantic 37-inch Sharp 1080p screens. A Microsoft
Force Feedback Steering wheel is used to steer. If you're
wondering what happened to the fourth Xbox360, it's used to
power the smaller 7-inch screen that is your rear-view mirror.
There's a Sparco racing seat and a 1900-Watt vibration
system to ensure you feel every bit of unevenness on the
track. To make the whole experience of racing as authentic as
possible, there are 2 fans that will give you the sensation of
wind in your hair when you've broken your car's windshield.
Come to think of it, the only thing missing is a fly dispenser
mounted behind the fans. The price? £12,500 (Rs 10,50,000) -
much more sensible to buy a real car, isn't it?

T

Digital Passion l Droolmaal

he iPhone isn't the only Apple gadget to get cloned by companies from our side of the world. There have been talks of
ASUS apparently working alongside Apple on a "Mac-tablet" for some time now, but a company called Axiotron has
already beaten them to it. Yes, there is, in fact, an Apple tablet that isn't made by Apple. The Modbook, as it's called,
is based on the Macbook. A quick search on Google reveals 2 models of the Modbook - both between the price of

$2,279 (Rs 94,000) and $2,479 (Rs 1,02,000). This isn't some handicapped version of the Macbook, it's the whole shebang - a
Core 2 Duo processor, a 80 / 160 GB hard drive, a 13.3-inch touchscreen (obviously), a stylus powered by WACOM's Penabled
technology, WiFi, and even a in-built GPS! All this runs on the OS X Tiger operating system. It's not like they were running out
of space to stuff in more things either. They even give you the option to put in 4 GB of memory and up to 570 GB of disk

T

Digital Passion l Droolmaal

ome Theatre systems are generally all about
quality, power and detail, but LG thinks design
can't be ignored. Presenting the all new

HT762TT - it's got 5 speakers and a subwoofer that
total up to 700W of power that should be enough to
blow the windows off the walls. While it may all be
about aggressive power and chaos, its design is
elegant and soothing and blends in well with your
designer room. To take it beyond being just another
fancy speaker set, they have put in VSM (Virtual
Sound Matrix) which delivers a sensation of surround
sound like you would get from 10 satellite speakers
instead of 5. Plug in your USB devices to the system
and you can playback MP3s, WMAs, DivX videos or
even photos from your outings.

LG HT762TT

H

Ultrasone Edition9
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VRX Mach4

f there's anything more desirable than a set
of ultra-high quality headphones, we don't
really want to know. The Ultrasone limited

headphones that cost $1,500 (Rs 63,000) are touted
as the world's best, and many audiophiles would
agree! The 'phones use 40mm Titanium plated Mylar
drivers, and they can play frequencies from 8 to
35000 Hz - well beyond the human ear's capacity.
Ultrasone's S-Logic technology gives a great sound
stage performance to the Edition 9. To keep your
head pampered, exotic Ethiopian sheep leather has
been used on the earpads and headband. 

I

he VRX Mach4 brings the sensation of real world driving to
your home, but without all the danger! The Mach4 is a Quad-
Xbox360 chained together to power the three gigantic 37-inch
Sharp 1080p screens. A Microsoft Force Feedback Steering
wheel is used to steer. If you're wondering what happened to
the fourth Xbox360, it's used to power the smaller 7-inch
screen that is your rear-view mirror. There's a Sparco racing
seat and a 1900-Watt vibration system to ensure you feel
every bit of unevenness on the track. To make the whole
experience of racing as authentic as possible, there are 2 fans
that will give you the sensation of wind in your hair when
you've broken your car's windshield. Come to think of it, the
only thing missing is a fly dispenser mounted behind the fans.
The price? £12,500 (Rs 10,50,000) - much more sensible to
buy a real car, isn't it?

T

Axiotron ModBook

Droolmaal The good stuff   l Stuff to lust after  l Stuff for the well-moneyed
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Take a Crack 
and win
Dreamweaver CS3
by Joseph Lowery

Published by

Rules and Regulations
Readers are requested to

send in their answers by the
15th of the month of
publication.

Employees of Jasubhai
Digital Media and their
relatives are not permitted to
participate in this contest.

Readers are encouraged to
send their replies by e-mail.
Jasubhai Digital Media will not
entertain any unsolicited
communication.

Jasubhai Digital Media is
not responsible for any
damage to your system that
may be caused while you are
trying to solve the problem.

Solution To Last Month’s Challenge

1. Start the Registry Editor: Start > Run >
type regedit > [Enter]. Navigate to
HKEY_CURRENT_USER\Software\Microsoft
\Internet Explorer. If you do not see a key
called MenuExt, create one with that name.

2. Under MenuExt, create
another key and call it E-
mail Page. This is the text
for the custom context
menu item.

3. You also need to specify
under what conditions this
menu item is to be shown.
For example, you may want
to show it when you click
on anchor elements, or for
the main document and not
for text boxes, and so on.
This is specified by a value
called Contexts. Add a
DWORD value under E-
mail Page and call it
Contexts. Set the value for
this to 1, meaning that it is shown for the
default context menu. You can also use the
values below to change the conditions for
the menu:

Context Value
Default 0x1
Images 0x2
Controls 0x4
Tables 0x8
Text selection 0x10
Anchor 0x20

4. Now specify the action to be performed on
clicking this menu item. This is done by
specifying the location of a script, which can
be JavaScript or VBScript. Set the default
value of your context menu key to the
location of a HTML file; for example,
C:\Email.html

5. Type the following code in Notepad and
save the file as C:\Email.html:

<SCRIPT language=javascript defer>
// Declare variables

var oExtArgs =
external.menuArguments;

var sTitle =
oExtArgs.document.title;

var sUrl =
oExtArgs.location.href;

// Create IE object
var oIE = new

ActiveXObject('InternetExplorer.Appl
ication');

if(sTitle == '')(sTitle = 'No
Title');

// Escape title and URL
sTitle = escape(sTitle);
sUrl = escape(sUrl);

// Build mailto string
var sMail = 'mailto:' +

'?subject=' + sTitle + '&body=' +
sTitle + ': ' + sUrl;

// Load mailto string IE
oIE.Navigate(sMail);

</SCRIPT>
You should now see the extra menu item in
IE, and be able to e-mail the page using your
favourite mail client. 

THIS MONTH’S CHALLENGE

Win!

Gaurav Prasad
Chennai

LAST MONTH’S WINNER

How would you rearrange
the elements of Desktop
settings to show more of
the list of available
wallpapers?

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

Rearrange the
elements of your
Desktop Settings

Create A Context Menu Item To E-Mail An IE PageLAST MONTH’S CHALLENGE
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The result: e-mail pages from within IE itself!



37DIGIT JANUARY 200836 DIGIT JANUARY 2008

ZERO1 Awards 2007

A Game of Chess In the pages that follow, you will find products that can be considered the
cream of the crop, battling it out for supremacy, and more importantly,
the coveted Digit Zero1 Award

he technology market is perhaps the
goriest of them all. With companies
fighting tooth and nail to catch your
eye and releasing products on a
monthly basis, one thing’s for sure—
life’s never boring. Most of us don’t
even realise the amount of research
and development and planning that

goes into releasing a new model of even a hum-
ble flash drive, let alone the mammoth task of
developing and launching a new processor archi-
tecture, graphics card, motherboard, monitor,
hard drive, etc.

Someone here at Digit likened it to a battle of
chess grandmasters—there’s the opening move
(announcing the release dates of the product);
the countering of every attack (keeping an eye
on what your competition is doing); carefully
planning your future moves even before your
opponent makes his (market research, etc.); and
finally, as soon as you can, move in for the kill...
and checkmate!

Products are released with a full frontal
attack, moving like a castle; intelligently side-
stepping diagonally like a bishop; castling to
protect their kings when threatened; all in the
attempt to stymie the opponent and win the bat-
tle. All of this only lasts for few months, and then
the battle is reset as easily as a chessboard can

be, and a new generation of products battle it
out all over again.

We’d like to think of our annual Zero1 Awards
as the culmination of the year’s tournaments,
and the felicitation of the winners as the crown-
ing of a grandmaster—champion of the world!
Like in chess, you shouldn’t make the mistake of
thinking of the products we’ve tested in terms of
winners and losers. Whether the reigning cham-
pions prevail, or lose out to newer releases, you
can bet your life that companies will take the
necessary measures to come back and win what-
ever they may have lost this year.

For example, our processor segment sees
Intel outplay AMD, winning the game in very few
moves indeed. Their Core architecture will
remain their cash cow for some time on, and the
Penryn only promises more of the same. AMD,
meanwhile, countered with their true-quad
cores, and are defending pretty well. The graph-
ics card segment saw a similar story with NVIDIA
and ATI (AMD again), with NVIDIA winning this
round of the tournament.

In this, the first of our two part Zero1 cover-
age, we’ve divided products into 16 categories,
read on to find out which products were the
grandmasters of 2007. Keep a look out next
month as well, where we’ll cover the felicitation
ceremony and announce a few more awards.
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Right now, as much as 18 per cent of the
population owns at least one phone.
The emphasis is on multimedia phones

rather than budget phones; the first genera-
tion of cell phone adopters wants that extra.

With leading manufacturers like
Nokia, Sony Ericsson, Motorola,
and Samsung introducing a lot of

models in the “multimedia
device” category, the time to be

stuck with “just a phone” seems to
have come to an end.

Powerful cameras, lots of Flash
storage, great PMP abilities, and inbuilt

Wi-Fi and GPS make for some truly
amazing convergence. Allied technolo-

gies have improved as well, like the dis-
plays—nothing short of astounding.

MULTIMEDIA PHONES BETWEEN
RS 14,001 AND RS 20,000

The Reigning Champions
Nokia 6300; Samsung 
SGH-E840

Both our champions have seen
major price drops
since we test-
ed them.
The Nokia
6300 makes
a very sen-
sible buy
for the
price (Rs
8 , 4 0 0 ,
s t r e e t
p r i c e ) .
The SGH-
E840 (Rs
9,600) has

a beautiful
screen, and
is one gor-

geous phone—a beautiful slider mechanism,
the slickest we’ve seen. If you happen to have a
copy of our August 2007 issue, you’ll see the
price difference between then and now...

The Contenders
Sony Ericsson K790i; Nokia N73

A lot has changed since August 2007
when we conducted our shootout and
adjudicated in joint favour of the
Nokia 6300 and Samsung SGH-E840.
For one, the Gold winner in our Up to
Rs 20,000 multimedia category has

seen a serious price drop. The excel-
lent K790i has fallen to Rs 12,800

from Rs 16,222. An excellent
screen, amazing music qual-

ity, and a brilliant 3.2 MP
camera make the K790i

an absolutely superb buy. The Nokia N73 is
another worthy candidate, priced at Rs 12,750:
it has a superb screen (240 x 320, 2.4 inches),
great camera on par with the K790i, and all
the flexibility that Symbian S60 provides. The
N73ME won Gold as well; although we didn’t
test the non-music edition, the features
remain the same apart from the dedicated
music button.

The Award
Sony Ericsson
K790i; Nokia N73
We find our two new
contenders battling so
hard for the crown
that in the end, we’ve
decided to award a
joint Zero1 award
to Sony
Ericsson’s
K790i and
Nokia’s N73.
Both offer
tremendous
value for money
now after serious price

cuts—a very good entry point to the world of
multimedia phones, and something you won’t
tire of very soon.

MULTIMEDIA
PHONES ABOVE
RS 20,000
The Reigning
Champion
Nokia N73 Music
Edition
The Nokia N73 Music
Edition was one fabulous
20,000-rupee-plus phone—
till it became cheaper! It’s
even better value for
money now, but there are

ZERO1 Awards 2007

higher-end multimedia phones available that
have fallen into the price void it’s created.

The Contenders
Nokia N95; Nokia N95 8 GB; Sony
Ericsson K850i
After a serious price
drop, the N95 (street
price Rs 24,550) is
still around and
going strong. The
only issue we had
with this device was
poor battery life.
The N95 8GB reme-
dies this with a new
1200 mAh battery, a
bigger screen (2.8-
inch vs. 2.6-inch). In
fact, the only reason
the N95 lost out was
due to its astronomi-
cal pricing at the
time of our compar-
ison test (Rs 40,249). It’s even got GPS and Wi-
Fi—total connectivity. The new Sony Ericsson
K850i is another beauty—a very feature-rich
phone with a great camera.

The Award
Nokia N95
Nokia’s N95 emerges the Zero1 winner. It was
overshadowed by its cheaper-by-half sibling—

the N73ME—simply because
of the price and the lat-
ter’s stellar battery life.
With great signal quality,
a 3.5mm jack, and GPS
and Wi-Fi, the N95 is a

fully-loaded pock-
et computer,
which is exactly
the way Nokia
advertises it. If
you’ve got Rs
25,000 to blow
on a multimedia
phone, it’d be a
shame if you
spent your
money 
anywhere else.

BUSINESS PHONES

The Reigning Champion
Nokia E50; Nokia E90 Communicator;
Sony Ericsson P990i
Nokia’s E50, E90 Communicator, and the Sony
Ericsson P990i were our Gold winners—three
very deserving candidates in three very differ-
ent price brackets. The Nokia E50 is compact,
Symbian based (read feature-rich), and offers
an affordable entry point to the Business
series. The SE P990i offers a touchscreen,
QWERTY and number keypad, Wi-Fi, and a
good 2.0 megapixel camera, apart from docu-

CELL PHONESCELL PHONES

ment creation and editing software. Very 
feature-rich, the only minus being that 
it’s heavy. And when we think of
the businessperson, we think
Communicator. 

The Contender
Nokia E51
Nokia’s E51 upsets the happy
position of the E50. It’s got
everything—a 16 million colour
display, good battery life, a
strong metal body, sleek lines,
Wi-Fi, and best of all, a great
keypad. We haven’t really
seen anything more from
other vendors, and certainly
nothing threatening in the
way of a high-end PDA.

The Award
Nokia’s E90 Communicator—our Zero1 win-
ner for this, the Business Phones category—
retains its hold on the lofty high-end PDA

market. With an
excellent QWERTY
and regular keypad
and a host of fea-
tures, it is still the
most-sought-after

b u s i n e s s p e r -
son’s compan-
ion in the
high-end PDA
category. At Rs
34,500, the
E90 is one
d e s i r a b l e
phone!

N o k i a ’ s
E51 becomes

the new entry-
level business
phone of
choice. All the

features of its predecessor and a bagful more—
a better screen, keypad, and much better build.
Highly recommend for the price (Rs 12,000
approximate street price).

ZERO1 Awards 2007

Nokia 6300

Nokia N73

Sony Erricson K790iSamsung SGH-E840

Sony Ericsson P990i Nokia E50

Sony Ericsson K850i
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Digital Cameras have helped the layman take
up photography; they’ve made the learning
curve a lot less steep. Their price and avail-

ability have made them very popular, and it’s
only getting better. Decent entry-level cameras

can be had for as little Rs 7,000 to 8,000.
The dropping prices of memory
cards has also helped.

Most of the technology has
stayed more or less the same as com-

pared to the previous generation; fea-
tures like larger number of focus

points in a scene and image stabilisa-
tion have become standard. 

“Ultrazoom” or “pseudo-SLR” cam-
eras refer to those that resembled D-SLRs

in shape while being much smaller and
cheaper. The zoom levels and the megapixel

ratings have been the most prominent
changes here. A few models launched by a few

brands (Sony and Canon, for example) now
fill the gap between point-and-shoot and

Ultrazoom models.

POINT-AND-SHOOT
CAMERAS

The Reigning Champion
Canon PowerShot A570 IS
The winner from our last digital camera test—back
in October 2007—was the Canon PowerShot A570
IS—a brilliant camera with a whole load of features
and a highly competitive MRP of Rs 17, 500. The mar-
ket price now is much lower, and the camera seems
to be available in the grey market at the Rs 9,000 to
10,000 mark. It has a 7.1 MP sensor with 4x optical
zoom. One highlight was lovely, natural colours,
not unlike most of the Canons in the category.

The Contender
Canon PowerShot A650 IS
Canon has kept updating their cameras; the
result of this is the A650 IS—an updated A640—
which lacked image stabilisation. The A650 IS is
a 12.1 megapixel camera (really a lot!) and gets
into D-SLR territory in terms of resolution. In
addition, the A710 IS has been replaced by the
new A720 IS. The upgrades here aren’t as sub-
stantial as with the A650 IS.

The Award
Canon PowerShot A650 IS

The 12.1MP sensor apart, the optical
zoom has been bumped all the way up
to 6X from 4X—yet another great
upgrade. This one as good as the A720
and the A710 in terms of zoom, but
has a considerably higher megapixel

rating. The $400 price means
around Rs 16,000. The market

price will be lower than that,
and the grey market
price even lower. If

you’re able to get the A650 IS for under 
Rs 12,000, it’s a must-buy!

ULTRAZOOM CAMERAS

The Reigning Champion
Sony Cyber-shot DSC-H7
We tested the Canon S3 IS in 2006, and we got to
try the Sony DSC-H7 in our most recent compar-
ison test. The latter is the Reigning Champion.

The Contenders
Canon PowerShot S5 IS; Sony DSC-H9;
Olympus SP-550UZ
The Canon S5 IS is known for its realistic colours
and overall good quality. The Olympus SP-550UZ
has the largest optical zoom of the lot—18x—but
is a 7MP camera as compared to the rest, which
are at around 8MP. The Sony DSC-H9 is very simi-
lar to the DSC-H7, with the exact same megapix-
el rating and optical zoom, but it has a larger, 
3-inch screen.

The sensor and the image resolution you get
are very similar to those of point-and-shoot cam-
eras. Until last year, 12x of optical zoom was the
norm for all manufacturers in this range. This
year, however, Sony upped it a notch to 15x with
the DSC-H7 and H9.

The Award
Canon PowerShot S5 IS

The Zero1 in this category goes to the Canon
PowerShot S5 IS, a brilliant camera for its price—
in the grey market, it’s around Rs 15,000. It’s
indeed a bit costlier than a typical point-and-
shoot, but you get something like a point-and-
shoot with features you’d find on D-SLRs. It’s a
great first-step camera for anyone who would
like to start using a D-SLR but needs something
affordable to train with.

DIGITAL CAMERAS
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This was clearly the year of the graphics
card. 2007 saw the penetration of DX10
graphics cards into just about every seg-

ment, and the partial phasing out of DX9
cards. Though DX10 games are lagging behind
the hardware, with poor optimisation and
such, the desire to be future-proof is the driv-
ing force behind what’s happening. We also
saw the increased importance of HTPCs and
gaming PCs last year; such PCs depend heavi-
ly on the graphics card, and this is another
reason to have seen a large crop of DX10 cards
coming into the market.

HIGH-END GRAPHICS CARDS
The Reigning Champion
Galaxy 8800 Ultra
The Galaxy 8800 Ultra, based on the NVIDIA
GeForce 8800 Ultra—currently the fastest GPU
in the world—was easily the fastest-performing
graphics card in our tests. With 768 MB of
GDDR3 memory, this card just chomps up any
game! Even at 8x Antialiasing and Anisotropic
Filtering, the Galaxy didn’t break the prover-
bial sweat. It comes with a stock NVIDIA
heatsink that appears to do the job well. It
makes for an ideal companion for a powerful
gaming rig. And it goes without saying that
this card will easily power any HTPC (an
overkill if there ever was one!), although its
audience is the hardcore gamer who will
spend the Rs 30,000 it commands.

The Contender
XFX 8800GTS Alpha Dog Edition
Another brute of a card, the new 65nm
process enables NVIDIA to bump up clock
speeds on the same formidable 128 shader
units, so much so that the 8800GTS comes
close to the 8800GTX, its elder brother.

The Award
Galaxy 8800 Ultra
The Galaxy 8800 Ultra is the biggest, the
fastest, and the costliest card out there. If you

have the dough (Rs 60,000 odd) then SLI two
of these… and tell us how Crysis looks!

MID-RANGE GRAPHICS CARDS

The Reigning Champion
ASUS EN8600GT
The mid-range category is the bread and but-
ter for vendors, characterised by high sales
and good profit margins. This is also where
the most buying happens. The ASUS
EN8600GT outperformed all the other
8600GT cards in our tests, and even demol-
ished the 8600GTS cards. This overclocked
marvel (540 stock vs. 625 EN8600GT) stayed
cool throughout the tests. It is a good buy for
the mid-range segment for a decent gaming
machine, and a superb powerhouse for any
HTPC, or someone who wants a combination
of both.

The Contenders
ATI Radeon HD3850
ATI’s RV670, better known as the Radeon
HD3850, enters the fray: a severely cut-down
(as far as memory bandwidth goes) version of
the older and much hotter HD2900 pro. Built
around a new 55nm process, the HD3850 still
features the 320 shader units and even more
processing power due to higher clocks. The
best part is that at Rs 12,000 or thereabouts,
the HD3850 makes one fantastic option for a
decent mid-range card.

The Award
ASUS EN8600GT
While we’re yet to see the new mid-range
series from NVIDIA and ATI, the whole point

of a mid-range buy is the price point of 
Rs 8,000, beyond which we don’t see anyone
other than the discerning gamer spending.
For its mix of price, performance, and low
power consumption, the ASUS EN8600GT still
hasn’t got a worthy competitor to displace it
of its lofty perch as our Zero1 award winner.

GRAPHICS CARDS
ZERO1 Awards 2007

GRAPHICS CARDS
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In the past year, nothing significant has
happened in this category in terms of the
technology; the trend of prices dropping

did continue, though. Then, IDE drives went
out, to be completely replaced by the faster

SATA interface. Perpendicular
recording, introduced last year,

is becoming mainstream—320
GB drives built upon this
technology are priced really

well. We expect things to stay
the way they are for at least a

couple of years, before Flash-based
hard drives start the process of phas-

ing out magnetic storage media-but
that remains to be seen. Also, some
drives that cater to AV specialists have
been unveiled along with so-called
“green” hard drives that claim to con-
sume lower power-we shall see a lot of
this next year.

Things were similar with external
drives. The interface has remained

the same—USB, and FireWire,
while capacities have

increased. In this case as
well, drives based on per-

pendicular recording are
increasingly being used, espe-

cially in the backup category. Micro
hard drive based external drives were
nowhere to be seen, and this indicates the
waning interest in that category, which was
last featured in 2006. In the coming year, we
expect to see drives featuring the new eSATA
interface sporting 3 Gbps speeds and thus,
great performance. Networking is in vogue,
we therefore expect that more and more of
the drives will feature an interface such as
RJ-45 or even Wi-Fi, because such drives don’t
need a PC to be able to serve as a file server.

INTERNAL SATA
The Reigning Champion
Western Digital Caviar SE16
WD3200AAKS
This 7200 rpm drive hits the sweet spot
for internal hard drives, with a gener-
ous capacity of 320 GB and excellent

performance, along with a superb
paise per MB of just 1.47. Sporting

the SATA II interface, it has a large
16 MB buffer—great especially

when you’re transferring large
files of loading large game

levels.

The Contender
Western Digital

Caviar SE16
WD5000AAKS
This drive differs
from the Reigning

Champion only in terms of capacity; the per-
formance is very similar, but it loses out on the
price front: it costs Rs 7,500, placing it a little off
the sweet spot.

The Award
Western Digital Caviar SE16
WD3200AAKS
The Western Digital Caviar SE16 WD3200AAKS
excelled in all our tests, synthetic and real-
world. It posted an excellent 66.8 MBps
and 64.5 MBps in the read and write tests
in HDTach, with a low CPU usage of just 2
per cent and a low random access time of
12.7 ms. It scored 154 MBps in
H2Bench—again a good score. It
was the top scorer in PCMark 05.
The drive also scores well in real-

world file transfers—less than a minute to copy
a 4 GB file to and from the drive, while trans-
ferring it between partitions on the drive took
just over 2.5 minutes. Priced at a really afford-
able Rs 4,500, this drive gets the Zero1 award
in this category.

BACKUP EXTERNAL HARD DRIVES

The Reigning Champion
Western Digital My Book Essential
The Western Digital My Book Essential looks
like a reference book, and sports a rugged
build. This 500 GB drive has 16 MB of buffer.
The design allows you to stack drives one on
top of the other to increase capacity. It weighs
1.32 kg, meaning it’s easy to carry around. 

The Contender
Maxtor OneTouch III Turbo Edition
This 1 TB drive is built very well, and has a
backup button that works in conjunction with
the excellent EMC Retrospect software (bun-

dled). The drive supports the speedy FireWire
800 interface in addition to USB 2.0. This was
the fastest performer in this category, but is
priced at Rs 36,200—which goes against it if
you’re looking for a winner.

The Award
Western Digital My Book Essential
Our Zero1 award winner in this category, the
Western Digital My Book Essential top-scored
in almost every test we threw at it. The aver-
age read speed is 34.2 MBps, while write speed
is 23.9 MBps. It took just 40 seconds to write a
1 GB file to the drive, while reading it from

the drive took an amazingly low 35 seconds.
Copying 1 GB of assorted data to and fro takes
just 1.5 minutes, which means it’s one of the
fastest drives. It comes with a USB 2.0 data
cable as well as a power adapter. The bundled
WD Diagnostics utility helps you troubleshoot
any problems you might encounter. The price
is just Rs 8,300.

HARD DRIVES
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PORTABLE EXTERNAL HARD
DRIVES
The Reigning Champion
Western Digital Passport Portable
(Black)
This drive is just a little bigger than a pass-
port, and it is quite light at 231 grams. The
body is of a strong black polymer with a
piano black finish on the top and a rub-
berised finish at the bottom that provides the
grip needed to prevent sliding off a surface.
The 8 MB buffer is sufficient for sustained
data transfers over USB 2.0. 

The Contender
Iomega Portable Hard Drive
This 80 GB Iomega drive is very sleek, and was
the lightest drive in this category. The casing
has an extra power socket for when the drive is
unable to draw enough from the USB connec-

tor. Though it is just a 4200 rpm drive, we
found the performance commendable—almost
as good as that of the reigning champion. It
comes with EMC Retrospect to take care of
your backup needs. The pricing is very sensible.

The Award
Western Digital Passport Portable
(Black)
This drive has a read speed of 33 MBps, while
the write speed is 23 MB/s. Writing a 1 GB
file to the drive takes just 42 seconds, while
reading it back is even faster at 36 seconds;
This makes it a top scorer in this category,

but in addition, its performance is compara-
ble even to that of some of the faster backup
external drives. WD provides a USB 2.0 cable.
The bundled WD Sync software is good for
all kinds of backup, meaning you won’t have
to spend extra on a third-party application.
The price is good, too—Rs 6,500.
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Inkjet MFDs are very popular today, especial-
ly because of ever-falling prices. Nothing of
significance happened in this field in 2007,

but certain technological advancements such
as faster printing technology using a head that

does not need to move are in the
pipeline, and are expected to go

mainstream this year.

HOME INKJET MFDS
The Reigning Champion

Canon PIXMA MP160
An entry-level inkjet MFD based on 4-car-

tridge thermal inkjet printing technology.
Having four separate cartridges is advanta-
geous because if one of the cartridges gets
drained, you can replace just that, as
opposed to having to replace a combined
colour cartridge. This MFD has a 7-segment
LCD display that shows the selected num-

ber of copies to be printed.

The Contender
HP Photosmart C3188
All-in-One
An inkjet photo MFD based

on 2-cartridge thermal inkjet
printing technology, this one has

an input tray capacity of 100 sheets—
good for most SoHo purposes. The scanner’s
optical resolution is 1200 x 2400 dpi—the best
in the category. Being a proper photo MFD, it
has buttons to Reprint photos as well as proof
sheets. Interestingly, it features memory card
slots but not PictBridge. Photo print quality
was excellent, second only to that of the
Reigning Champion. This MFD was neck-and-
neck with the champion—even the price is the
same—but it lost out a little on performance.

The Award
Canon PIXMA MP160 
The Canon PIXMA MP160 prints really fast—
it printed the normal-quality text docu-
ment in 9.3 seconds flat. It was also the
fastest at printing our combi-document at
Normal quality. It printed exceptionally
well even at the highest speeds. The edges
of the text were crisp, and the ink did

not blot the paper even at high quality.
The copy quality was the best in the

category, and this MFD scored the highest even
in our scanner test. Though priced a little on
the higher side, at Rs 5,999, its exceptionally
good performance fetches the Canon PIXMA
MP160 the Zero1 award in this category.

OFFICE INKJET MFDS
The Reigning Champion
HP Photosmart C4188 All-in-One
Good looks, good prints, and great build quali-
ty—good enough to bear the rigours of office
use. Based on thermal inkjet printing technolo-
gy, it uses two cartridges. This photo printer has
memory slots for SD, MS, MS Pro, SM, MMC, and
xD, and it also supports PictBridge. There is also
a Reprint function  and a special side tray to
store 4 x 6 photo papers. The C4188 has the
Photo Fix function, which lets you apply effects
to images read from memory cards so you can
improve print quality. 

The Contenders
Canon PIXMA MP460
Now this MFD exhibited the best performance
in every department. It was clearly the fastest
in printing, and without a doubt had the best
photo print quality despite the fast speeds. It
produced clear prints in true-to-original
colours. It was fast at the text and combi-doc-
uments as well. The copy quality was so good,
it was hard for us to distinguish between the
original and its copy! A swivel colour LCD lets
you not only view the photo from a memory
card or camera connected to the PictBridge
port, but also crop and resize it. However, this
MFD costs almost 2000 rupees more than the
Reigning Champion.

The Award
HP Photosmart C4188 All-in-One
The HP Photosmart C4188 All-in-One (Rs 7,999)
featured high-resolution scanning at 1200 x
2400 dpi, which means it picks up even text in

fine print from hardcopies. It was the fastest in
black text printing at Normal quality. It was
also a clear winner in the photo prints, repro-
ducing natural colours. This is a clear winner of
a Zero1 award.
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Laser MFDs are good for any business, but
especially for a growing one. They are best
used when the workload involves high-vol-

ume, high-speed printing, and one that needs
to be very cost-effective. They are more expen-
sive than inkjets, but the extra cash is quickly
recovered as you print more and more, owing
to the low printing cost.

BUDGET (UP TO RS 16,000)
The Reigning Champion
Brother DCP-7010
This is a compact MFD with a footprint of just
43.2 x 39.5 cm2 (which is quite small). The
DCP-7010 is a mono laser printer, scanner, and
copier. It has a hardware print resolution of
2400 x 600 dpi, which is quite high for an
entry-level product. Scanner resolution is 600
x 2400 at 24-bit resolution, and it supports a
maximum paper size of A4. Along with the
USB interface, there is also the older parallel
interface for working with legacy devices. 

The Contender
HP LaserJet M1005 MFP
This entry-level machine from HP rivals the
DCP-7010 in all respects, and surpasses it in
some. The performance is traditional HP: good
speeds and excellent print quality. The scan-
ner works reliably and has support for resolu-
tions for all purposes. At Rs 12,999, it is priced
at a premium, but given the availability of con-
sumables and other value-added services, it’s
well worth the money.

The Award
Brother DCP-7010
The Brother DCP-7010 wins our Zero1 award.
Print quality was average for text in Draft
mode, but improved a lot in Best mode. The
scanner reproduced colours fairly well; in fact,
it’s good enough for photographs. The bun-
dled MFL-Pro suite—a control centre to take
care of jobs such as scanning, faxing, and
more—is good, and also bundled is PaperPort
9.0SE (OCR software). The DCP-7010 is decently
priced (Rs 11,150); the toner cartridge costs 

Rs 2,150, meaning the cost per print is 86
paise. We’d still recommend this MFD because
of portability, speed, and overall performance. 

SOHO (RS 16,001—RS 30,000)
The Reigning Champion
Brother MFC-7420
With a rather small footprint of just 43.2 x
39.5 cm2, it’s easy to set up this device just
about anywhere. It has fax functionality and
an ADF tray that holds 35 sheets. It is built fair-
ly well, except the flaps don’t seem sturdy. The
input tray has a capacity of 250, sufficient for
most SoHos, while the output tray holds 100
sheets—again, not bad. The fax has a memory
of 500 pages, so you’ll probably never miss a
fax. This unit features the USB as well as the
parallel port interfaces, and although it does
not come with an Ethernet port, you have the
option of separately purchasing an Ethernet
Print Server. 

The Contenders
Canon imageCLASS MF4122
The MF4122 has a small footprint and is built
very well. It has an input tray capacity of 250
sheets—pretty good. There is also a multipur-
pose tray that holds one sheet. It is amazing
that even though it doesn’t cost too much, it
features duplex printing. A Toner Gauge but-
ton lets you monitor the amount of toner
remaining. Warm-up time was just 7.4 sec-
onds, the fastest we’ve ever recorded for a laser
MFD. Print quality was good, and so was copy-
ing speed and quality. It comes with OmniPage
SE OCR and Presto! PageManager. 

The Award
Brother MFC-7420

The software bundled with the Brother MFC-
7420—our Zero1 award winner—comprises the
MFL-Pro suite with PaperPort 9.0SE OCR, and also
a utility to set up the unit over a network. The
MFC-7420 has a toner duty cycle of 3,500, making
for an economical cost per page of 61 paise. 
Rs 18,000 for this model is justified because of
the fax, ADF, and sheet-fed scanner.

LASER MFDSLASER MFDS
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Like most other categories, notebooks
experienced serious price drops last year.
A few months after our notebook test, we

were surprised to see the specifications of
notebooks from major players like Dell and HP
being upped—instead of dropping prices, we
were seeing better CPUs, more memory, and
bigger drives on identically-priced models. We
also saw the intorduction of the latest series
of DX10 graphics chipsets into the latest mod-
els. For Windows Vista, 2 GB of RAM is consid-
ered mandatory, and its good to see vendors
giving us more memory, considering that was
our number one gripe with most of the 1 GB
laptops anyways.

PERFORMANCE LAPTOPS
The Reigning Champion
HP DV6226tx

Our winner, the HP DV6226tx, was a winning
combination of on-paper specs, features,
ergonomics, style, and functionality. A Core 2
Duo processor (T5200) and 1 GB of memory, a

GeForce 7400GO graphics solution, and
inbuilt speakers by Altec Lansing meant

the DV6226tx was an attractive bundle.
At Rs 56,990, it wasn’t pricey either—
Gold belonged here.

The Contender
Dell XPS 1530
Dell’s XPS 1530 is a superb laptop.

Available for as low as Rs 55,000 (and up
to Rs 85,000 if configured with all the

bells and whistles), the XPS 1530 is stylish,
fast, and suitably elegant. The best part is,

Dell allows customisation of the processor,
memory, graphics solution, and hard drive,

among other variables. Our XPS 1530 came
configured with a Core 2 Duo T7300, 2

GB of RAM, and an 8600GT graphics
solution, along with a 160 GB 7200
rpm hard drive and a 9-cell bat-
tery that was good for 3 hours. All

this for Rs 68,000—a real contender
for the prize!

The Award
Dell XPS 1530; HP DV6226tx
The XPS 1530 oozes style, finish, and build
quality, and blazing performance at an excel-
lent price point to boot. The only issue we can
see with Dell is the availability and presence

in our markets. HP has a solid presence in
India, with service outlets everywhere, and

you can pick an HP notebook off a shelf,
while with Dell, you need to order
online, and there are delivery times
among other inconveniences involved.

Unfortunately HP hasn’t really
upgraded the specs of the DV6xxx

series so its one for the Dell.
So we’re at an impasse... we

have a better, faster product that needs a bet-
ter dealer network to become a truly great
and hassle-free deal. We’re awarding a joint
winner here—no runners up; Dell’s XPS 1530
and HP’s DV6226tx share our Zero 1 award.

Two excellent products—one brilliant product
from a brand that needs more market pres-
ence in India, and the other a good product
that could use a few upgrades under the hood
from a tried and tested brand and a majot
player in the Indian market.

VALUE LAPTOPS UP TO RS 45,000

The Reigning Champion
Compaq Presario v3225AU
The value market for laptops mostly consists
of students and executives who either can’t
really afford to spend more, or simply won’t
because they don’t really need all that per-
formance. This doesn’t make the entry-level
category any less exciting, since manufactur-
ers have less of a budget to play around with—
and this ensures they try really hard to match
value with performance. This is by far the
most fiercely-competed market segment. 
The Compaq Presario v3225AU exemplifies
value with a nice balance of performance 
and looks.
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The Contenders
Dell Inspiron 1520
Dell’s Inspiron 1520 rears its head to strike at
the v3225AU. It’s got a faster processor and
more memory, and is infinitely more config-
urable. The only minus is that it’s not ready off
the shelf like Compaq is. Of course, it’s costlier
too, but that’s due to the faster components.
Another minus for the Dell would be its bland
exteriors—there’s nothing bland about the

Compaq Presario v3225AU.

The Award
Compaq Presario v3225AU
We feel a terrific package for the value audience
should have strong roots in, well, value. The
Compaq v3225AU brings strong value to the
entry-level segment. It sports the high-gloss fin-
ish and the kind of design that HP has

brought to their entire line-up. The Zero1 for this
year’s Value Laptop segment belongs to the
Compaq v3225AU.

ULTRA-PORTABLE LAPTOPS

The Reigning Champion
Sony Vaio SZ483N/C
Ultra-compacts are rare beasts—and even more
rarely sought-after because of the high price
associated with fitting high-performance com-
ponents into a cramped space. Sony’s
SZ483N/C was an excellent performer, built
from a carbon fibre like material, which made
the laptop extremely light, and a white LED
display that made viewing anything a pleas-
ure, not to mention slimming down what was
already a very compact laptop. It was power-
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ful, too, with a Core 2 Duo T7400 and a
GeForce 7400GO with 2 GB of RAM. The fact
that you can switch between an Intel X3000
and the NVIDIA graphics solution for battery
life or power usage is another plus.

The Contender
Sony Vaio VGN-SZ58GN/C; Dell XPS 1300
The Sony SZ483N/C has been replaced by a
more powerful model, priced identically. That
one features a lightning fast T7700 Core 2 Duo
processor and a GeForce 8400GS, and is called
the Vaio VGN-SZ58GN/C.

Dell’s new XPS 1330 is a serious contender
to the throne for the most compact yet power-
ful package. It sports a T7500 and 2 GB of RAM,
a GeForce 8400GS graphics card, and a 160 GB,
7200 rpm drive. Serious horsepower for some-
thing with a 13.3 inch screen, and enough
juice for even moderate gaming! Of course, the
portability is further enhanced with the option
of a crisp, WLED display that is even slimmer.

Although the XPS 1330 is a good looking
piece of hardware, the Vaio SZ483N/C is
absolutely gorgeous—and you have to see it in
the skin to believe that a laptop could look so
absolutely up-market.

The Award
Sony Vaio VGN-SZ58GN/C
The Sony Vaio VGN-SZ58GN/C is more than a
match for the XPS 1330. Also, the build and
look that Sony’s Vaio branding sports is

something that Dell’s XPS series can only
dream of. We’re awarding our Zero1 to the
Sony Vaio VGN-SZ58GN/C.

Dell XPS 1530

HP DV6226tx
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Laser printers have evolved over the past
few years; they are more compact and
manageable, and less expensive. The abil-

ity to produce fast, smudge-free prints has
always been their selling point over inkjets. In
2007, we saw laser printers have achieve a level
of efficiency that lets them output paper at a
speed very close to the claimed speeds.

Once confined only to offices, thanks to
the ever-dropping prices, the laser printer has
come a long way towards finally gaining
acceptance from SoHos and even at homes.
The advantages that they have over inkjets
are apparent—they are fast, they produce
clean and sharp prints, they require little
maintenance and are generally more rugged.

Also, their cost per page is remarkably
lower than inkjets. With even some
colour laser printers appearing in com-

pact sizes, there is really not much to hold
you back from getting one of these rather

than an inkjet and this is what we predict
is the shape of things to come.

PERSONAL LASER
PRINTERS

The Reigning Champion
HP LaserJet 1020
The vertical profile design of this
printer means it occupies less

desk space. It weighs just 5 kg—
light. It has a 234 MHz processor

and just 2 MB RAM, though that did
not seem to slow it down much. The

retractable input paper trays fold back
into the body and can hold up to 150

sheets, sufficient for any SoHo. There
is also a manual feeding tray for

the occasional quick printout.
The printer cartridge is easily
accessible by popping open
the printer's top panel. The

control panel is very easy to
use. The printer supports USB 2.0, and

the cable is provided. Print speed is around
14 ppm, just 1 less than the claimed 15. 

The Contender
Xerox 3117
The Xerox 3117 is an entry-level desktop

laser printer coming at a great price. Like
the HP 1020, it too is very compact and

has a vertical profile design. The
build quality of this creamy-white
printer is simply superb. It achieves
a printing speed of 15 ppm, just 2
short of the claimed 17. The print
quality was good in the text as

well as graphics and there was
no smudging anywhere.

Though it is no printer

extraordinaire, the incredibly low price of just
Rs 4,500 makes it the cheapest on this planet!

The Award
HP LaserJet 1020
The HP LaserJet 1020 takes just 9 seconds to
print a normal text document. Text print qual-
ity was marginally better than that of most
other printers. It was the best printer in the

photo document printing test, reproducing
greater details in the dark areas, something
the competition couldn’t manage. Finer details
and highlights were reproduced perfectly, too. 

Good printing speeds, impressive print
quality, and decent pricing go into taking this
printer ahead of the rest; in addition, the
unmatched warranty, easy availability of con-
sumables, as well as good service and afford-
able toner prices fetch this printer the Zero1
award in this category.

LASER PRINTERS

ZERO1 Awards 2007 ZERO1 Awards 2007

LASER PRINTERS

DIGIT JANUARY 200850

LCDs have evolved from an emerging
upstart to a mature technology. We’re
seeing panel costs falling, courtesy

cheaper and better TN panels entering the
market. The costlier PVA and S-IPS panels are
also becoming cheaper, albeit at a snail’s
pace. We’ve seen 17-inch monitors being
phased out in lieu of 19-inch panels at the
same prices. 22-inch monitors are threaten-
ing the status quo.

19-INCH MONITORS
The Reigning Champion
AOC 197S
The AOC 197S bagged our Best Buy Gold award
for its sterling value with decent perform-
ance. Although based on a TN panel the 197S
impressed with decent colour rendition in
DisplayMate, and good overall contrast.
Although its not the equal of an S-IPS panel
or an MVA panel as far as both these parame-
ters go it also costs a fraction for what these
panels cost.

The Contender
HP W1907; Dell E198WFP
The HP W1907 was another brilliant monitor—
very good colour and contrast for a TN panel.
The Dell E198WFP is yet another beauty—a good
looking widescreen, and one of the best colour
renditions we’ve seen for a “mere” TN panel. In
fact, this monitor is very suited for image edit-
ing professionals and multimedia aficionados
alike. Aesthetically the E198WFP has a beauti-
ful stand, and a very narrow bezel—ideal for a
dual monitor setup.

The Award
Dell E198WFP
Dell’s E198WFP really cleans up here—colour
brilliance is not really associated with TN pan-
els, but this one proves an exception in more
ways than one. Definitely Zero1 material—
which is why we’re awarding it. HP’s W1907 is
also an excellent monitor but it just isn’t the
price league of the Dell—besides being a great
performer it’s a great steal at the price as well.

22-INCH MONITORS

The Reigning Champion
None currently!
We’ve included a 22-inch category for our
readers just because 22-inchers now seem to
be de facto for mid-range consumers. In fact,
based on the popularity of this category,
we’ve decided to include it as a new category
in our tests.

The Contenders
ViewSonic VX2235WM; ViewSonic
VX2255WM; Dell E228WFP; BenQ
FP222W; Acer AL2216W; Samsung
226BW
Many and varied: ViewSonic’s VX2235wm and
VX2255wm, Dell’s E228WFP, BenQ’s FP222W,
Acer’s AL2216W, Samsung’s 226BW. All these
are TN panel-based LCDs.

The Award
Dell E228WFP
It was a closely-fought battle. Dell’s
E228WFP is an excellent panel with great
colour and contrast once it’s properly cali-
brated. The only issue we see is availability.
BenQ’s FP222W is another excellent multi-
media performer with nearly as good colour
rendition as the E228WFP, the only minus is
its a little bulky. The VX2235WM is good, but
we didn’t like it’s performance in some of
the colour tests, and the bezel is too large.

We had a good time thrashing these moni-
tors for all we were worth—Dell’s E228WFP is
available for as low as Rs 16,000, and it’s a
brilliant buy—great colours and great con-
trast at a great price. It edges out the two
ViewSonics and the BenQ FP222W for the
Zero1 Award.

LCD MONITORSLCD MONITORS



T he last couple of years have seen the release
of a multitude of chipsets from Intel,
NVIDIA, AMD, and SiS. Each of these have

their advantages, so there’s a myriad of options
to choose from when it comes to motherboards. 

NVIDIA 680I/650I CHIPSET BOARDS

The Reigning Champion
ASUS Striker Extreme
The NVIDIA 680i has been around for quite some
time, and was a path-breaking chipset at its
launch. Thanks to the future-proofing by NVIDIA,
it’s still got the power to take on some of the
newer chipsets. The ASUS Striker Extreme, which
belongs to the “Republic of Gamers” franchise, is
based on the 680i, and has a lot of copper heat-
pipes and heatsinks to take care of the cooling
needs of the Northbridge and Southbridge. There
is support for multiple graphics cards in SLI con-
figuration, and along with support for 8-channel
HD Audio, this board is good for gamers.

The Contender
ASUS P5N32-E SLI
This board has one of the best-looking cooling
solutions, and the layout is excellent. There are
heat-pipes and heatsinks for the Northbridge as

well as the Southbridge; this makes it run
cooler than other boards in its category.

It’s actually very similar to the ASUS
Striker Extreme in terms of most
features and performance, with
certain exceptions, notably the

absence of solid-state capacitors,
which are important for a board’s

longevity, and a few fancy things like
LED buttons right on the board for

power On/Off, reset, and CMOS reset. 

The Award
ASUS Striker Extreme
The ASUS Striker Extreme posted excellent scores
in every benchmark, and top-scored in almost

every gaming benchmark. It has a good bun-
dle of games (including GRAW), and acces-

sories such as cooling fans and USB brack-
ets are also provided. Priced somewhat
high (Rs 21,400), this is the Zero1
award winner in this category.

INTEL P965 CHIPSET BOARDS
The Reigning Champion
ASUS P5B Premium Vista Edition
The P965 chipset is pretty old, but it’s a well-
known secret that the chipset unofficially sup-
ports the 1333 MHz FSB through BIOS updates,
and thus has support for the new Penryn—
which breathes new life into this seemingly
fading chipset. The ASUS P5B Premium Vista
Edition is based on the P965; it is a very feature-
rich and fast board, though it costs quite a bit
(Rs 14,750). It supports up to seven SATA hard
drives and an additional one via the E-SATA
port. There is also support for legacy PCI cards
(three slots). It has all-solid-state capacitors,
which add to its stability and increase its life.

The Contenders
MSI P965 Platinum
A board that’s been around for quite some time,
the P965 Platinum supports up to six SATA
devices and one E-SATA. The BIOS supports over-
clocking with fine adjustments, making it a good
choice for enthusiasts. Being a dated board, it
was natural for it to be a bit behind in terms of
features as compared to the Reigning Champion,
but it is priced well, and performance is superior.

The Award
ASUS P5B Premium Vista Edition
The ASUS P5B Premium Vista Edition is emi-
nently overclockable. Performance across the
range of our tests was one of the best in its cat-
egory. The bundle is handsome: an IR remote
receiver (to control several functions, includ-
ing the ability to hibernate, power down, and
even play music), an array microphone, and a
tiny LCD screen that allows you to view pop-
ups such as RSS feeds (it will even sync with
Web sites when your PC is on). You have a clear
Zero1 winner in this ageing but not toothless
category.

INTEL INTEGRATED SOLUTIONS
The Reigning Champion
Gigabyte GA-G33-DS3R
Integrated graphics platforms are of high impor-
tance in India because of cost considerations.
The Gigabyte GA-G33-DS3R motherboard, based

on the Intel G33 chipset, has a very good layout,
is very well-built, and looks attractive. It employs
Realtek’s latest ALC889A codec-based HD-compli-
ant sound solution.

The Contender
Gigabyte GA-G33M-S2H
The GA-G33M-S2H, though also from Gigabyte, is
clearly built for a different target audience.
Priced at an unbeatable Rs 5,950, this board has
an HDMI port that lets you hook up a compliant
display or TV. With the ALC889A-based HD audio
solution, this board screams that it is one of the
best solutions for an HTPC. 

The Award
Gigabyte GA-G33-DS3R
The Gigabyte GA-G33-DS3R is an enthusiast’s
solution with greater overclockability, solid-
state capacitors, and an ATX form factor. In
addition to six internal SATA devices, it sup-
ports two E-SATA devices too. It supports an
FSB of 1333 MHz, thus extending support to
the latest Intel processors. If you decide 
that the integrated graphics is inadequate,
you can opt for any PCI-Express graphics card,
thanks to the x16 port. (PCI slots also figure.)
This motherboard is priced at Rs 9,500 and is
worth every penny, which makes it our Zero1
award winner.

AMD INTEGRATED SOLUTIONS

The Reigning Champion
Gigabyte GA-MA69G-S3H
Integrated graphics platforms are of high
importance in The AMD platform is still strong,
delivering good performance at good value. The
Gigabyte GA-MA69G-S3H has a nice layout,
which makes installation of add-on cards very
easy. There are three PCI slots. It supports the
latest AMD processors with the AM2 socket, and
an FSB of 1600/2000 MHz. Up to four SATA
devices are supported, and there’s even an E-
SATA bracket.

The Contender
Zebronics ZEB-N61M2
The onboard graphics on this board can han-
dle low to medium gaming, and the 8-channel
audio solution is decent, too. This is one of the
oldest boards in the category, so it loses out 
on new features, but it more than made up
with good performance and an unmatched
price of Rs 2,150.

The Award
Gigabyte GA-MA69G-S3H
The Gigabyte GA-MA69G-S3H delivers solid per-
formance, ahead of much of its competition,
especially in benchmarks such as
PCMark 2005. The integrated
Radeon x1250 deliv-
ers decent per-
formance in
gaming, and has
support for HD video
playback, which is well-
complemented by the 8-
channel HD audio onboard.
Add to this the DVI-to-HDMI
connector bundled along, and you have a board
that makes an excellent choice for an HTPC. 

INTEL P35 CHIPSET
The Reigning Champion
ASUS P5K Premium
The P35 is a relatively new chipset from Intel,
and supports the newest breed of processor
architecture—the 45 nm Penryn. The Asus P5K
Premium has an excellent layout and excep-
tionally good build quality. The use of high-
quality components, such as solid-state capaci-
tors, adds to the board’s stability and longevi-
ty. Good support for overclocking is another
feature, and this makes it an enthusiast’s
delight. It supports up to 8 GB of DDR2 memo-
ry at 1066 MHz, more than enough to take care
of your needs for years. 

The Contender
ASUS P5K3 Deluxe WiFi-AP; Gigabyte GA-
P35-DS3R
Both the Asus P5K3 Deluxe WiFi-AP and the
Gigabyte GA-P35-DS3R are well-laid-out, high-
end motherboards with good build quality.
Both support the latest Intel processors and also
DDR3 memory at 1333 MHz, meaning they’re
quite future-proof. While the Gigabyte board
supports up to eight SATA devices and one E-
SATA, the ASUS has Wi-Fi onboard, along with
support for CrossFire. As far as performance
goes, these were almost neck-and-neck, and a lit-
tle behind the Reigning Champion. At the final
tally, these stood too close to each other, and it
was only fair to award both of them second
place in this category.

The Award
ASUS P5K Premium
The ASUS P5K Premium—the Zero1
winner—delivered knockout
performances in
whatever tests were
thrown its way; it was
the top scorer in its cate-
gory. With CrossFire, HD
audio, dual Gigabit, and even
Wi-Fi onboard, this board is a
gamer’s delight. Though it is a bit
expensive at Rs 15,870, it is well
worth the price considering the performance
and the features you get.

MOTHERBOARDS
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In 2006, it was MP3 players that we tested
under this genre. 2007 saw things change.
There was video playability prominently fea-

tured on almost every device, barring a few odd
ones. In addition, there were features such as cal-
endar, syncing with the PC e-mail client, etc.
added to the spec-sheet. The devices were there-
fore referred to as Personal Media Players (PMPs).

UP TO RS 5,000
The Reigning Champion
SanDisk Sansa c240
The “Lil Monsta”, as it’s called, looks unassum-
ing, is sleek like a USB stick, and has top-class
build quality. There is 1 GB of internal memory,
though this can be augmented by means of a
MicroSD card. The Li-Ion battery lasted us 13.5
hours, which is pretty good considering the fact
that it has an LCD screen rather than the power-
efficient OLED.

The Contender
Transcend T.sonic 840
This is a brand-new MP3 player, the replacement
for the T.sonic 630 models that followed the 610.
The major upgrade has been that the 1.8-inch
screen does a resolution of 176 x 220. This means
you can now use this device to read books as well.
You can find the 4 GB version of this player for
just under Rs 5,000.

The Award
Transcend T.sonic 840

The Transcend T.sonic 840 is bril-
liant value for its price, and dis-

places the Sansa c240 as the Zero1
winner. A fresh new design, the

large number of features, and loads
of memory make it a very good buy

for almost anyone. There’s even a 2 GB
version for Rs 600 to 700 lesser.

RS 5,001 TO RS 10,000

The Reigning Champion
SanDisk Sansa e250
This one has it all: FM radio, voice record-

ing, video playback, photo viewing, cus-

tomisable equaliser, and expansion—you name
it! It looks good, too, with the best-built, scratch-
proof titanium alloy back. There is support for
custom playlists and equalisers, and it can read
media stored inside folders.

The Contenders
Apple iPod nano 8 GB (third generation)
The new iPod nano 8 GB has improved on the
shortcomings of the older nano. This one has
a 2-inch screen for video. It’s wide, but it’s still
tiny, and more importantly, it’s light.
Dropping memory prices means that now, an
8 GB MP3 player is around Rs 8,500. The Sansa
needs to put out something special if it is to
keep its top spot!

The Award
Apple iPod nano 8 GB (third generation)
Improvements and upgrades have made the
nano better than
ever. The iPod nano 8
GB (third generation)
wins the Zero1 award
in this, the mid-range
PMP category. When
the older nano (2
GB) was
around, it was
priced around
Rs 8,150. This
one makes
much more
sense. Users
already using a Nano
might not find this worth the buy, but for those
looking for something under Rs 10,000—there’s
nothing as good as this. It’s a lot about the
styling and good pricing.

ABOVE RS 10,000

The Reigning Champion
Cowon D2
A great looker, this PMP has a rather large
touchscreen—a brilliant 16 million colour dis-
play. Although it is made of plastic, the build
quality is very good. The touchscreen is the
only interface, and therefore there aren’t
many buttons—a stylus is provided to aid in
navigating the slick icon-based interface; not
that it’s required—you can even use your fin-
gertips. It supports a wide range of audio for-
mats, but there is native support for only two
video formats—AVI and MPEG. This issue, how-
ever, is taken care of by the bundled converter
software. If the 4 GB capacity falls short, there
is the option to add in an SD card. 

The Contender
Apple iPod Touch
There’s no better contender for the Cowon D2
than the latest and most talked-of gadget from
Apple—the iPod Touch. It’s similar to the iPhone,
except, of course, there’s no phone. The Touch

PORTABLE MEDIA PLAYERS
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PORTABLE MEDIA PLAYERS tag indicates a touchscreen, and unlike the ones
you find on some phones, this one uses multi-
ple touches to allow you to flip through albums,
scroll, and resize. This is clearly a threat to the
dominance of the Cowon D2.

The Award
Apple iPod Touch
The iPod Touch comes in two flavours—8
GB and 16 GB. It’s possible to find the 8 GB
model for around Rs 14,000 in Indian
markets—an absolute killer price. Audio,

video, photos, Web
browsing, you
name it—the Touch
has it. Think about
it—you can even
use it to watch
YouTube videos!
It’d be unfair to
not award it the
Zero1 in this cate-
gory; people love
it, and we do, too.
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Alot has changed from the Pentium and
Athlon series of yore. Intel’s Core 2 Duo
(C2D) is a breed apart and the reigning

champions of the number crunching game.
AMD has lost the race for now, and with their
Phenoms failing to deliver, there’s nothing to
stop Intel’s juggernaut. It’s only in the value seg-
ment that we see AMD fitting nicely; some AMD
processors offer the best bang for the buck.   

THE BEST DESKTOP PROCESSOR

The Reigning Champion
Intel QX6850
The QX6850 is Intel’s flagship processor—
which we’d tested in our annual comparison—
and it performs admirably. Though it’s a
quasi-quad-core, its performance in multi-
threaded application is breathtaking. With 8
MB of L2 cache and 1333 MHz FSB, the QX6850
running at 3 GHz just zips through most
applications. Retailing at Rs 45,000, the
QX6850 is very expensive, but with there
being absolutely no competition, you should
expect to cough up that sort of money!

The Contender
Intel QX9650 (Penryn)
Within a month of our processor shootout, Intel
unleashed quite something else—the QX9650,
the first 45-nanometre silicon piece. Running at
3 GHz, with a 1333 MHz FSB, it has a 6 MB cache
per die—a huge 12 MB in all. Built on a 45nm
process, the QX9650 is much more power-effi-
cient as compared to its older sibling. The addi-
tion of 47 new instructions under SSE4 gives a
big boost to multimedia applications. Overall, we
saw a nice 7 to 10 per cent boost in performance
across our tests. Retailing at Rs 50,000, the QX-
9650 is definitely a step in the right direction.

The Award
Intel QX9650
If money is no bar, Intel’s Core 2 Extreme
QX9650 is definitely the processor to go for, and
given the performance advantage, we have no
hesitation in awarding it our coveted Zero1
award for the best Desktop processor. 

PROCESSORSPROCESSORS

A PROCESSOR FOR EVERYONE

The Reigning champion
Intel Core 2 Quad Q6600
The Intel Q6600 is in its own class; no processor
can hold a candle to its excellent performance /
price ratio; it is sweetly priced at Rs 11,500. The
newer AMD Phenom processors have had a hard
time trying to beat the Q6600...

The Contenders
AMD Phenom 9600 and 9700
Based on pricing and clock speed, the Phenom
9600 and 9700 are the real contenders to the
Intel Core 2 Quad Q6600. However, availability
and compatibility with existing hardware will
be an issue for the new
Phenoms. Further, the
Q6600 offers better per-
formance than both the
new AMD processors.

The Award
Intel Q6600 
For now, it’s a one-sided
game; the Q6600 is the
clear winner. It rules
supreme and is the
processor to buy to build
a gaming or multimedia
PC. It gets our Zero1
award for its performance
as well as pricing. 
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Watching a movie, giving a presenta-
tion, or simply huge-screen gaming—
everything is possible on a projector

today, which is now within the reach of the
general consumer. We did see changes in this
category as compared to last year. 2006 was
dominated by SVGA projectors (capable of 800
x 600), whereas this time round, the picture
was different, with XGA projectors (capable of
1024 x 768) being the dominant breed. We’ve
also seen the entry of native HD (720p) projec-
tors for the home theatre audience. Falling
prices add to the attraction of a projector, and
a large LCD or Plasma screen just cannot cap-
ture the same cinematic experience.

XGA PROJECTORS
The Reigning Champion
Acer PD726W
The Acer PD726W was perhaps the best-look-
ing of the projectors we tested last year. A
sober black-and-silver colour tone and rugged
build quality make it really appealing.
Connectivity options are endless, with
Component, S-Video, RCA, D-Sub, DVI, and
even HDMI thrown in—and there’s network
connectivity via RJ45 and Wi-Fi. It is also pos-
sible to interface with the device through RS-
232 and USB (both USB A and B type connects
are provided in the package). The menu inter-
face is easy. It allows you to specify an IP
address to which a message can be automati-

cally sent in case something
goes wrong.

The Contender
NEC NP1000
NEC’s NP1000 showed signs of
excellence, with an ANSI bright-

ness of 3400 lumens and an actu-
al static contrast ratio of 800:1. The

NP 1000 is very good for home and
professional use alike. It has got five
bayonet lenses inside that can vary
from 30 to 500 inches, offering an

amazing viewing experience when
placed at a distance of 2.5 to 68.5
feet from the screen. It offers both
vertical and horizontal lens shift,

allowing nearly limitless projec-
tor placement. This projector

also offers integrated high speed wireless LAN
IEEE 802.11b/g via an optional wireless card. It
has presentation, broadcast, data conferenc-
ing and training mode, that gives the user, the
flexibility for just about any wireless applica-
tion. Remote diagnostics features enable the
monitoring of the status and adjustment of
different functions of the projectors remotely
over a network, making it perfect for any cor-
poration. The NP1000 features Eco-mode tech-
nology, that increases the lamp-life by at least
50 per cent. To add to this, the cooling fan con-
tinues to run for some time even after the
power is disconnected and the in-built sensors
protect the lamp and projector from overheat-
ing. There are also some security features such
as logo lock, password protection cabinet con-
trol lock which let you prevent anyone from
changing the its settings. Its price of Rs
1,20,000 does put it into the high-end bracket
as far as affordability goes.

The Award
Acer PD726W
The Acer PD726W has a very good brightness
rating spec—3700 lumens. Coupled with a high
contrast ratio (2500:1), the PD726W is very
much a multimedia aficionado’s dream. When
we did the 256-shade intensity screen calibra-
tion, we encountered smooth transitions
between the shades. It performed very well in
the presentation tests; text reproduction was

sharp. While halos did appear around
extremely light colours, they would disappear
by tuning the brightness and contrast. This is
a great movie projector with sharp image ren-
dition and great contrast, and a great projec-
tor for big-screen gaming and movies alike.
Without a shadow of doubt, this is the only
projector that can win Zero1—absolutely no
hesitation whatsoever!

PROJECTORS
ZERO1 Awards 2007 ZERO1 Awards 2007

PROJECTORS

PC sound has matured over the past decade
to such an extent that it gives hi-fi sets a
run for their money. This has become pos-

sible due to advancements in PC sound cards,
and more so because the PC speakers of today
are much better than those of a few years ago.

2.1 sets are considered entry-level, though
the more expensive 2.1 sets are audiophile-
class. 5.1 sets are better for multi-channel sce-
narios such as games and DVD movies.

2.1 SPEAKER SETS
The Reigning Champion
Altec Lansing ATP3
These sleek black speakers will look good on
any desktop. They are also built tough. There
are controls for Bass, Treble, and Volume. The
large, 6.5-inch woofer produces rich bass, and
each of the satellites has two 1.1-inch tweeters
and a 3-inch driver. The woofer is 18 W RMS,
while the satellites are 12 W (combined)—more
than what might be expected of a 2.1 set. The
power adapter is built into the speakers. 

The Contender
Altec Lansing FX4021
As with the ATP3, build quality is rugged. There
are two 5.25-inch drivers in isobaric configura-
tion to provide double the amount of bass. The
satellites have 40 mm and 18 mm drivers to
handle a higher range of frequencies. It comes
with metal stands that add to the aesthetic
appeal. There’s a wired as well as a wireless
remote control. Overall performance was good,
and the bass stood out. This set is priced a little
on the higher side—Rs 7,500.

The Award
Altec Lansing ATP3
The Altec Lansing ATP3 is strong in all areas of
the audio spectrum, meaning both Western
and Indian music will sound good. Whether it’s

games or movies, these speakers will not disap-
point. Even with a relatively high price tag of Rs
3,400, these speakers are too good not to be
awarded the Zero1 in the 2.1 category!

5.1 SPEAKER SETS

The Reigning Champion
Artis S6600R / FM
The Artis S6600R/FM set is unique: it has not
only FM radio, but also AM—an inexpensive,
very useful add-on. Though they sport a
chrome finish, the speakers aren’t gaudy.
There is a discrete amplifier box with all the
controls. The full-featured wireless remote
lets you control everything including the
radio and individual channel volumes. In
addition to the 5.1-channel input, there is also
a stereo auxiliary input to let you connect
stereo audio sources.

The Contenders
Artis X10 Mini
Built very well, the Artis X10 Mini (Rs 12,000)
comes with nice, sturdy steel stands for rear
speakers to elevate them to the ear-level of the
listener. The satellites have veils with grilles
behind, giving the drivers some extra protec-
tion. The subwoofer is made of wood; wood
grains are visible on the exterior, giving it a
classy look. The provided cables are colour-
coded, and are of exceptionally good quality.
The strong bass never drowned out the treble,
and we could hear every bit of detail even with
the bass at full throttle. Cranking up the vol-
ume and bass levels did not seem to do any
damage to the sound quality.

The Award
Artis S6600R / FM
As far as audio quality is concerned, the Artis
S6600R / FM is strong throughout the spec-
trum—treble in particular. In our gaming and
DVD movie tests, it reproduced directional
sound with great accuracy and clarity. The Artis
S6600R / FM is an all-in-one package at a very
good price of Rs 8,500; it wins the Zero1 award
in the 5.1 category.

SPEAKER SETSSPEAKER SETS
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The launch of Vista this year saw the
2007 saw Windows Media Center—which
depends on compliant TV-Tuners to turn

your PC into an entertainment centre—reach
everyone, rather than just people who bought
Media Center PCs. We tested TV-Tuners in
three categories: Internal PCI, External USB,
and External Set-top, the first being the most
popular as far as Desktop PCs are concerned.
We also saw the first digital TV-Tuners mak-
ing an appearance, though we didn’t test
them; the availability of digital terrestrial
broadcasts is very limited. We will probably
see more of these next year; digital broadcast
is expected to grow.

INTERNAL PCI TV-TUNER CARDS
The Reigning Champion
Leadtek WinFast PVR2000
This  was one of a kind amongst the internal
PCI TV-Tuners. It was the only one to feature an
MPEG-2 decoder chip (which offloads the CPU
from the task of encoding video while captur-
ing). This TV-Tuner is Windows MCE and Vista
MC ready. It sports the Conexant CX23882-39
chip, which is known to deliver superior pic-
ture quality owing to the 10-bit ADC. It sup-
ports the PAL and NTSC TV standards with
stereo audio. The full-function remote gives
you complete control over the TV card, thanks
to the superb WinFast PVR software.

The Contender
Leadtek Winfast TV2000
XP Global
This model is just a few steps
behind the PVR2000 in terms of
features, and is therefore priced
lower (Rs 2,500). Features

include FM radio,
Picture-in-Picture,

and a

remote control that can control the Media
Player in Windows. In our tests, its perform-
ance was as good as that of the PVR2000.

The Award
Leadtek WinFast PVR2000
The Zero1 award winner in this category, the
Leadtek WinFast PVR2000 managed to detect-

ed weak TV channels during our tests. The
driver installation is simple, and the PVR inter-
face is very easy to understand and use.
Picture quality was top-notch. It comes with a
good software bundle, which makes it even
more worthwhile to spend that Rs 5,500 on
this card.

EXTERNAL USB TV-TUNERS
The Reigning Champion
Leadtek WinFast PalmTop TV
Now here’s an external USB TV-Tuner that
looks good enough to adorn your desktop.
This was the only external TV-Tuner to fea-
ture an MPEG-2 encoder. It has out-of-the-
box support for Windows MCE and is Vista
MC ready.

The Contenders
Compro VideoMate Action Pro
This one is, without a doubt, the most
rugged of external TV-Tuners, with a
strong metallic casing. It was one of the

TV-TUNERS
ZERO1 Awards 2007 ZERO1 Awards 2007

TV-TUNERS

only three tuners to have a Composite port,
which lets you hook up a camcorder so you
can transfer analogue video recordings and
get them converted into digital video. It
comes bundled with all the necessary cables.
In this category, it detected the highest num-
ber of cable TV channels, and didn’t even
require fine-tuning. The video quality was as
good as that of the WinFast PalmTop TV.

The Award
Leadtek WinFast PalmTop TV
Only the lack of certain features cost the
Compro VideoMate Action Pro the Zero1
award. As for the Leadtek WinFast PalmTop TV,
which is our winner, the included PVR software

has all the capabilities you might
expect. The remote can be used to
control everything. The tuner comes

with a rich bundle of software, which includes
WinFast PVR, CyberLink PowerDVD, Orb,
Ulead’s Cool 3D, DVD MovieFactory 3SE, and
VideoStudio 9 SE DVD. And finally, the image
quality was the best we’ve seen thus far with an
external USB TV-Tuner.

EXTERNAL SET TOP TV-TUNERS
The Reigning Champion
AVerMedia AVerTV Box7
AVerMedia has been the dominant player for
the past many years as far as external set-top
TV-Tuners are concerned, and it has remained
that way. The AVerTV Box7 is way ahead of 

the competition in terms of performance and
its advanced features. It is the most rugged 
of the lot; it comes with a stand to keep 
it upright.

The Contender
Tech-Com SSD-TV-722
This TV-Tuner has most of the features you
would expect, and is reasonably priced at Rs
1,750. Useful features include Picture-in-
Picture, which can be controlled via the

remote. The Tech-Com SSD-TV-722 comes with
an MMI (MultiMedia Interface) cable for video
and audio inputs from external sources such
as DVD players. It supports a healthy viewing
resolution of 1280 x 1024. It detected 84 out of
90 channels—not bad—and image quality was
quite decent too.

The Award
AVerMedia AVerTV Box7
The Zero1 in this category must go to the
AVerMedia AVerTV Box7; it was well ahead of
the competition, detecting 88 channels out of
90. None of its competitors came close to it as
far as image quality goes, even though some

featured similar resolutions.
It supports a resolution of up
to 1280 x 1024. It has all

types of connectors, enabling you
to connect any AV source—even
your set-top box. It’s priced a wee bit on the
higher side, but this is as close to TV as you
can get on a monitor!
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W e all crave freedom: from wired tele-
phones, wired keyboards, and even
wired networks. The Wi-Fi wave

reached Indian shores in a big way last year;
we reviewed Wi-Fi routers (which enable wire-
less networking at home) and also Wi-Fi ADSL
routers (which let you share your Internet
connection wirelessly).

ROUTERS
The Reigning Champion
ASUS WL-530G
This device is small enough to be stuffed inside
a trouser pocket. It’s not small on features
though—DHCP, NAT, VPN-pass through, and all
the security features are there. Though not the
best we have seen so far, you can make your
way around ASUS’ software after fiddling
around for just a little while. Due to its tiny
footprint, we’d recommend it to the hotspot
browser on the move.

The Contender
LinkSys WRT54G
This router sports twin antennas. It has four
ports with bridging, and supports 802.11 b/g. In
terms of security, there is support for NAT and

SP1 along with IP blocking and Wireless
Isolation and encryption. It outpaced

much of the competition in the Zone
1 tests. Though its signal quali-

ty is slightly inferior, where
this one scores is in
pricing: just Rs 3,634.

The Award
ASUS WL-530G

With unmatched speeds
in our tests, the ASUS WL-

530G is suitable for setting
up a home or SoHo wireless office where its

data throughput capabilities will be put to
good use. It exhibited superior performance

in the video streaming test as well—thus
you won’t have to

sit near your PC if you have one of these. Priced
at Rs 4,400, the WL-530G offers excellent value
for money. Grab the WL-530G—it is the fastest Wi-
Fi router out there, and our Zero1 winner.

ACCESS POINTS
The Reigning Champion
LinkSys WAP54G
This one is the AP equivalent of the WRT54G
router. It is wall-mountable, and a kit to imple-
ment that is provided. It sports two antennas,
so we expected it to have stronger signal
strength, and this was indeed the case. An addi-
tional feature is bridging capabilities. The
firmware interface is identical to that of the
WRT54G, apart from the lack of routing func-
tions. Security features such as NAT and SP1 are
present, along with almost every other
advanced feature such as encryption, wireless
isolation, etc.

The Contenders
Senao ECB 3220
The wall-mountable Senao ECB 3220 functions
as a wireless bridge and also as an Access Point.
In keeping with its primary function (bridge), it
showed very good signal strength. It was a
steady performer and didn’t lose reception in
any of the tests—not even while moving
between Zones; something unique, because all
the other devices in the test, with the exception
of the ASUS Wl-600G, lost reception while the
laptop was being moved between zones, thus
reaffirming that the ECB 3220 has a very strong
signal. Being an AP, it carries a rather expensive
price tag of Rs 8,280, but because of its powerful
signal, office users will find it useful as a bridge
between two wireless networks.

The Award
LinkSys WAP54G
The LinkSys WAP54G demolished the com-
petition in our data transfer tests. The per-
formance, coupled with the attractive
price tag of $80 (Rs 3,200) makes it a great
buy. The remote Web interface is easy
to use, and security
features are well-inte-
grated in this Access
Point—making it a
deserving winner of
our Zero1 award.

WI-FI COMPONENTS
ZERO1 Awards 2007
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Asfaq Tapia

I
f you travel a lot, your mobile and laptop
are quite likely your most important pos-
sessions. In this article, we present software
you can’t do without when on the road.
Actually, even if you aren’t on the road, this

stuff is still cool to have!

VITO AudioNotes
One of the coolest pieces of software out there for
your phone, VITO AudioNotes allows you to record
audio (in WAV or MP3 format) from your phone’s
microphone. What this means is that you don’t
have to scramble for pen and paper whenever
someone dictates something to you. What’s more,
it can record incoming and outgoing calls auto-
matically—perfect for those sting operations! 

At its highest recording quality of 96 Kbps, a
10-second WAV file takes up approximately 1 MB
of space, while an MP3 of similar length takes
up 135 KB—very nifty. While recording notes, you
can also adjust the sensitivity of the mic with
the Mic. Auto Gain option. The automatic call
record function does just that—on a Windows
Mobile device, selecting this option will record
all calls even when the program is not running
in the background.

Once recorded, the calls and notes can be
saved on either the phone memory or the
memory card. Another interesting function of
the software is that it allows you to append
new recordings to previously-recorded notes or
calls; for example, if you have a recording of an
outgoing call, you can append your own sum-
mary of the call to the end of it and save it all
as one recording.

Platform: Symbian S60, Windows Mobile
Buy from: http://tinyurl.com/2ghob7 
Price: $19.95 (Rs 800)

OfficeSuite 4
OfficeSuite works on any Symbian Series 60
phone and allows you to make and edit Word,
Excel, or PowerPoint documents right on the
phone. Though you won’t be able to make Pivot
Tables or define custom style sheets, it should get
the job done for a file that has to be sent urgently.

When you make a new document, it will allow
you to save it on the phone or on external
memory. Office-
Suite gives you
nearly all the
f o r m a t t i n g
tools you get
with MS Office,
including the
red underlines
for misspelled
words. When
you make a
workbook, you
can hide, freeze,
or insert rows
and columns,
and you can use
functions too.

Shrikrishna Patkar

Presenting: the
most useful
mobile software
we can think of!

Grab These Apps!

The Excel app in OfficeSuite 4
looks pretty much like MS Excel

Digital Tools l Jumpstart
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AI RoboForm
This interestingly-named software is a password
manager and automatic form filler with some
serious artificial intelligence. Why is it in this list,
you ask? Simple: you don’t want to be carrying
slips of paper with passwords written all over
them while travelling; AI RoboForm is a much
better alternative.

After installing the program, you’ll be asked
to enter your details on an exhaustive Web form,
which is stored on the computer. There on, it’s
all smooth sailing. When you need to fill out a
form on the Web—when registering on a Web
site, for example—just click “Fill Forms” and all
the fields will be automatically filled with the
necessary information.

The real beauty of the software is that it is
encrypts all your pass-
words with 3-DES tech-
nology, so there is no way
your passwords will be
compromised. The soft-
ware works even on AJAX-
based pop-up login
windows (like those on
Facebook).  It can also gen-
erate random, secure pass-
words for use on Web sites,
which it automatically
saves for later use. There is
also an option to print all
the passwords stored with
AI RoboForm, but that
defeats the purpose of
using the software! You
can also password-protect

your identity in AI RoboForm to prevent others
from logging into your account on Web sites.

Find AI RoboForm on this month’s CD.
Platform: Windows (All)
Get from: www.roboform.com

Free SMTP Server
Picture this: you’re on the move, and you need to
send an important e-mail to a client. Your office
mail server is down, or taking excessively long to
send e-mails. Haven’t many of us been through
this situation? Fret not; you can now use software
for exactly this situation.

Free SMTP Server creates an SMTP server right
on your PC. It can be used with any mail client—
all you need to do is change the outgoing SMTP
server to localhost in the mail client.

When it’s launched, the program will auto-
matically detect the DNS server and port number
through which to send e-mail. If you want the
mail to go through a specific DNS server address
or port, you can configure that, too. Be aware that
that some ISPs close the SMTP port 25, forcing you
to use only their SMTP server, so make sure the
port is unblocked before using the program. The
only drawback of the software is that if any other
service is already using the specified SMTP port,
it gives you an error instead of adding the request
to the queue.

Free SMTP Server has no frills, but that’s what
makes it so fast and efficient.

Platform: Windows (All)
Get From: http://tinyurl.com/yrzl37

When using the PowerPoint application, you
can switch from slide view to slideshow view or
outline view. Most of the animation functions
and shapes are also available.

The software won’t save or read Office 2007
format files, nor will it auto-save your files every
few minutes, but it does the job better than any
other Office clone for mobile phones.

Platform: Symbian S60
Buy from: http://tinyurl.com/2broyc
Price: $49.99 (Rs 2,000) 

Virtual Network Computing
Let’s face it—in spite of having all the cool tools to
help you when you’re on the road, there’s
nothing better than accessing your computer at
the end of the day. Ultr@VNC is a virtual network
computing (VNC) program that allows you to do
just that from absolutely anywhere. 

The Ultr@VNC software consists of two parts—
VNC Server and VNC Viewer. You need to install
VNC Server on the host computer (at home, for
example), and use VNC Viewer to browse the con-
tents of the host machine over the Internet.

The greatest advantage of using Ultr@VNC is
that it has an option called JavaViewer, which
allows you to access a remote host even without
having the VNC Viewer installed. All you have to
do is use a Web browser with Java installed and
connect to http://[ip_address]: 5800, where
ip_address is your home PC’s IP address. You can
get Ultr@VNC free off our November 2007 CD.

Mozilla Thunderbird
Thunderbird is an open source e-mail client that
rivals Outlook in terms of features and perform-
ance. It supports the POP3, IMAP, and LDAP pro-
tocols. With the release of the Beta 1 of
Thunderbird 2.0, it has become increasingly clear
that most of the functions available in Outlook
will be available in Thunderbird too. 

When released, the client will eventually sup-
port tabs to open multiple e-mails from your
inbox at once. Just like Gmail, Thunderbird can
also sort e-mails in a threaded view. You can con-
figure multiple e-mail accounts to retrieve mail
from. It supports the creation of multiple folders,
among other things. Another new feature is the
ability to tag e-mails with keywords so they can be
searched for easily. 

Platform: Windows (All) / Mac / Linux
Get From: http://www.mozilla.com/en-US/thun-
derbird/ 

The options menu in AI RoboForm

The Thunderbird e-mail program with mails sorted in folders



MojoPac
The biggest problem while using a computer
that’s not yours is that you don’t know if it’s
infected, or if your activities are being logged. Of
course, there are ways to find out, but you’d
rather be doing something more important with
your time.

Enter stage left, MojoPac. The idea behind
the software is simple: it installs itself on any
portable media device, from MP3 players to USB
sticks, and creates a virtual environment for you
to install and run applications. While most vir-
tualisation software require you to purchase a
separate licence for Windows to install on your
portable media, MojoPac uses essential files
from the machine that it is connected to—the
host machine—to run a protected environment.

When in this virtualised mode, MojoPac
places a toolbar at the top of the Desktop, which
allows you to switch back to the host when
required. The computing tasks you carry out in
the virtualised mode stay there, and no traces of
those are replicated on the host machine. All the
software we installed in the virtualised mode

ran perfectly. There are reports, however, of Web-
cams not working properly with the software.

There are a few things we don’t really like,
though. In the virtualised mode, you don’t have
access to the drives on the host machine, and
any file transfer you want to do between your
MojoPac USB stick to the host machine has to be
done outside of MojoPac. The software works
fine with USB 2.0 devices, but on older devices it

can get sluggish; and finally, MojoPac runs only
on Windows XP host machines.

In spite of its few drawbacks, MojoPac is a
wonderful tool for professionals on the move who
don’t carry a laptop.

Platform: Windows XP only
Get From: www.mojopac.com
Price: Free (Freedom Edition), $ 49.99 (Rs 2000)
(Deluxe Edition)

Blacklist
Have you ever been nagged by pesky telemar-
keters who won’t take No for an answer? Or how
about those times when you want some peace
and quiet and your phone just won’t stop ringing?
Epocware Handy’s Blacklist could be your saviour.

True to its name, the application blocks
callers from calling you. When you run Blacklist
for the first time, a dialog box appears, which
allows you to block callers. From here, you can
choose if you want to block numbers from recent
calls, private numbers, unknown numbers, and
your contact list; if you want to enter the number
manually, you have that option too. The Settings
menu allows you to automatically add rejected
numbers to the blacklist and keep a log of all
blocked numbers for up to 60 days.

Unlike other monitoring software, Blacklist
starts automatically with your phone. The only
downside of the application that we found was
that it did not display an alert every time it
blocked a number, so you’d never know until you
checked the logs.

Platform: Symbian S60
Buy from: http://tinyurl.com/33kd33
Price: $19.95 (Rs 785)

Handy Zip
E-mail attachments are normally sent as zipped
files, and unfortunately, there are very few
phones that natively support zipped files. Every

mobile professional
who checks e-mail on
the phone dreads these,
but if you have Handy
Zip, you’ll be fine.

This little applica-
tion allows you to
access and create
zipped archives on the
phone. When you start
the application, it
searches for any zipped
archives on the phone
and displays them. Just
click on the relevant
archive to go into it.

When you want to create an archive, go to
Select > New Archive. Then, browse to the
file or folder you want to archive and select it.

The application allows you to choose between
five levels of compression—from None to Max-
imum. You can also choose to archive sub-folders
and sort archives by name or size in ascending or
descending order.

Platform: Symbian S60
Buy from: http://tinyurl.com/38ptue
Price: $12.95 (Rs 510) 

asfaq_tapia@thinkdigit.com

Changing the DNS server settings in Free SMTP Server

Now easily access and even
create Zip archives on your
mobile—with Handy Zip!

MojoPac in action

MojoPac is a
wonderful tool
for professionals
on the move
who don’t carry
a laptop

Digital Tools l Lead Feature
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Digital Tools l Flash Drive Test

Michael Browne

W
hile nobody will dispute the
accuracy of the above state-
ment it’s equally true that
storage hasn’t followed this
trend in recent years. Sure

we’ve had bigger, faster hard drives, and even
greater capacities on optical media, as paral-
lel recording gave way to perpendicular
recording and CDs gave way to DVDs and
dual-layer DVDs.

Flash memory has always been considered
a dark horse. It promised to be a great ride
for pioneers of the technology, but the risks
were equally big. Every technology needs a
catalyst to speed up its development into a
mature product. Flash has two things work-
ing in its favour now—the need for a depend-
able portable medium to carry data, and the
fact that magnetic recording (HDDs) have
come close to their limits both as far as speed
and capacity go.

Today, examples of Flash storage can be
seen from the solid-state hard drives that
have begun to appear in laptops to the hum-
ble subjects in this test. Greater size and
speed in addition to the ever diminishing
price makes flash drives perhaps one of the
best buys this year. We were shocked when
the prices of 4 GB flash memory plummeted
to around Rs 1,500—just a year ago the prices
were more than double that. Higher capaci-
ties (16 GB and above) are still pricey enough
to intimidate all but the most persistent
buyer, but that’s sure to change, just wait and
watch. Perhaps more surprising was the

increments in speed of read / write opera-
tions—sadly, we don’t get to take coffee
breaks between tests any more.

We scoured the market and chose 34 drives
from amongst the masses—each contender
was chosen on the basis of it offering some-
thing unique—whether in terms of value, or
performance, or appeal.

SKINNY BYTES—1 GB 
Features
Out of the five drives we tested in this
section, we really liked the rugged build
of the Corsair Voyager 1 GB. Built with a
high-quality rubber / silicone compound,
the Voyager easily resists damage when
dropped. Despite the soft body, it doesn’t
feel flimsy to hold or use. Transcend’s
JetFlash 168 was another beauty. One
side of the surface has a silver metallic
sticker with beautiful embossing. The
quality of the plastic used is good. Other
than the Moser Baer 1 GB—which had a
swivel type design and a quality metal
outer sheath—the other two drives were
pretty ordinary.

Corsair had some sort of a security appli-
cation installed on each of their Voyager
series drives—but this didn’t prove to be really
secure—a format removed the application
entirely! Not good for someone who wants to
protect data.

Performance
The Moser Baer 1 GB proved to be speedy over-
all. Although the Transcend JetFlash 168
shocked us in the 100 MB assorted file test
with 4.11 MBps—an unheard of speed for a ran-
dom write operation—so much so that we ran
the benchmark again to be sure. In fact these
two fought it out fiercely, but Moser Baer’s
offering won the race in the end. 

Shrikrishna Patkar

IG
YTE

Flash is bigger, faster, and
cheaper than ever before.
Ride the wave at its cusp—
you’ve got 34 of them to
choose from

Nothing is permanent 
but change.

—Heraclitus

We used Windows XP Professional with SP2. All testing was
done on a secondary partition to avoid hard drive
bottlenecks. We turned off functions like System Restore,
and also kept a permanent swap file on a separate 1.5 GB
primary partition.

Features:
Points were awarded for security features (encryption,
password locking etc), we even tested the security feature
(if present) to ascertain its strength
Software features include any firmware on the drive and

the bundle. We awarded extra points for backup and
recovery and sync suites bundled
An LED is a must to know when a read/write operation is
being performed
Accessories being the life breath of any personal device
were awarded points for simply being part of the bundle.
We looked for extras like belt chains and hooks, lanyard
rings, and neck straps
Other features included something noteworthy in a
particular product that made it unique

Performance:
HD Tach tests and reports on five parameters. We’ve
listed all five but only taken three (the read/write scores)
into contention for our calculations.
SiSoft Sandra 2007 tests the read / write performance of
a flash drive. We gave more bias to the write scores.
Our file transfer tests consisted of two parts—one was a
100 MB file transfer test, the other was a maximum size
transfer test. We ran both sequential (one large file) and
random (lots of different files of varying size) tests.

How We Tested

JANUARY 2008

MoserBaer 1 GB
Small n fast!

Processor
Motherboard
RAM
HDD
Graphics Card

Pentium 4 520 (3.2 GHz)
Gigabyte P965 DQ6
Kingston DDR2 800 MHz 512x2
Hitachi T7K 250GB SATA 2
NVIDIA GeForce 7600GS

Test Machine Specification

B
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The Transcend JetFlash V30 turned out to
be the proverbial tortoise, as did the Corsair
Voyager 1GB, while the Toshiba 1 GB neatly
separated these two from the hares.

Conclusion
A 1 GB drive is only recommended when you
absolutely cannot afford to spend any more.
We say this because two and four GB drives are
faster—larger density flash modules tend to
have better data transfer rates—and offer more
value for money. If you are specifically shop-
ping for a 1 GB  drive our Digit Best Buy Gold
winner—the Moser Baer 1 GB—is your best bet.

SLIGHTLY OVERWEIGHT—2 GB
Features
One glance at Umax’s Apus Zoom had us hum-
ming Roxette’s She’s got the look—a jet black
drive with two silver-chrome strips on each
side, it’s pretty, but didn’t feel sturdy enough.
The SanDisk Cruzer Titanium was another
attraction—solid metal body (as the name sug-
gests) and a dark gun-grey colour. The regular
Cruzer drive is identical looking except that
the material used is high quality plastic rather
than metal. Corsair’s rugged Voyager series
made another appearance with in 2 GB avatar.
Buffalo’s Turbo USB 2.0 is a cool looking trans-
parent drive—though there’s nothing in terms
of moving parts to make any sense of the trans-
parency. It’s a pity that Buffalo didn’t add an
activity LED.

We also had a bulky Kingston DataTraveler
Reader which cunningly incorporates a mem-
ory card reader into the regular pen drive.
This is a good option if you need both a USB
drive and a memory card reader. It’s not built
very well though. Transcend’s JetFlash V10, on
the other hand, is built solidly, but is unin-
spiring to look at.

Buffalo’s 2GB offering uses a technology
called Turbo USB, which requires a small down-
load from their Web site. This software once
installed on the PC claims to help speed up

transfers and seems to be some sort of buffer-
ing software. Another software called Buffalo
Secure Lock Ware which is a security package
can be downloaded and installed. We couldn’t
see the reason why such software couldn’t be
bundled on a disk, or in the drive itself. They
are still “bundled software” if you think about
it, and all Buffalo’s drives feature them.

Performance
Corsair’s Voyager 2 GB did a complete turn-
around of our initial impressions with the 1
GB model—it was fast, so much so that it near-
ly overtook the speed demon that was the
Transcend JetFlash V10. Both the SanDisk
drives just tagged behind the leaders and
strangely did very well with large write opera-
tions involving multiple small files—better
than the two overall leaders. Funnily the sce-
nario changes when we look at the small 100
MB file transfer tests, where the Cruzers lag
behind, although by a small margin.

The Moser Baer 2 GB was a ubiquitous per-
former—fast, but amid faster drives, unlike its
smaller sibling. The attractive Kingston
DataTraveler 2 GB was abysmally slow.

Conclusion
Whether you’re looking at speed or something
tough enough to withstand a few drops from
your pocket look no further than our Digit Best
Buy Gold winner—Corsair’s Voyager 2 GB. It
even comes with an attractive transparent USB
extension cable so you won’t have to get dusty
fiddling around the rear of your cabinet if you
don’t have front USB ports. Best of all, it costs
a measly Rs 900!

The SanDisk U3-based brothers, the Cruzer
Titanium and the Cruzer, also make very good
buys for someone wanting a fast drive. These
make sense, because if you’re planning on trans-
ferring close to 2 GB of data regularly, it’s point-
less to choose something slow. Transcend’s
JetFlash V10 2 GB (Rs 800) was also fast, similar
to the V10 1 GB in the previous group.

Transcend clearly uses much faster Flash
chips in their V10 series as compared to their
V30 series—which seem the slowest of the
Transcend drives. In fact the Transcend
JetFlash V30 is such a slowcoach that only one
drive in this category was slower—this dubious
honour belonging to the Umax Apus Zoom 2
GB—unless you plan quick naps between large
write operations you’ll stay well away.
Toshiba’s U3 offering was also well below the
standard of what is considered fast—and if you
want a U3 based drive we can’t recommend
this after the brilliant SanDisk Cruzers.

CERTIFIED FAT—4 GB
Features
The 4 GB segment is where all the fun starts,
mainly because just six months ago these
drives were double the price they are today.
There is also a lot more data you can carry
around—photos, movies, and music. The math
is simple too—double the price of a 2 GB gives
you double the storage space.

One drive stands out in this category—the
Sandisk Extreme Ducati Edition. The D word
causes the motorcycling enthusiasts amongst
us to get weak-kneed and dry mouthed with
anticipation. This drive features a solid metal
upper body (painted Ducati-red) with a quality
plastic bottom. The USB interface safely tucks
away and the LED indicator is made to look like
the tail-light of a super bike. The drive also fea-
tures SanDisk’s famous Extreme Flash memory,
which obviously made us want to test it first.

Also in this category were Kingston’s Data
Traveler Mini and Data Traveler Mini Fun are
really tiny drives. The Traveler Mini has a very
neat retracting system which completely tucks
away the USB interface beneath its tiny exteri-
or. The Mini Fun is designed to look funky—and
is a bright red. Note that besides their diminu-
tive size these are full fledged USB drives—
Kingston hasn’t cut corners on functionality.

Toshiba’s TransMemory 4 GB has one of the
curviest forms—straight body curved inwards
at either end. A very attractive dark grey plas-
tic body does justice to a beautiful footprint.

Tech-Com’s 4 GB offering came with
DiskPro on the firmware. This software
appears as a discrete floppy drive. Double
clicking this drive will bring up a screen that
will query for a password to protect access to
the drive. You can also set a hint question.
What’s best about this is that the drive cannot
be formatted without providing the password
(a contrast to the poor security suite on the

Corsair Voyager drives). Tech-Com also provid-
ed good accessories—a long USB extension
cable and a neat lanyard.

Performance 
Ducatis are known for their performance,
aren’t they? True to its heritage, the SanDisk
Extreme Ducati Edition blows everything in
this comparison to smithereens—it was
puzzingly slow in the 100 MB assorted write,
though still faster than the other drives and
that was it—no more complaints! With a ran-
dom write speed of 13.34 MBps for 4 GB of
assorted files and an equally amazing 18.06
MBps for sequential write, this drive is two
and sometimes three times faster than most
other drives.

The only other two contenders barely close
enough to choke on the exhaust fumes of the
SanDisk Extreme Ducati Edition, were the
JetFlash V10 4 GB from Transcend and the
Corsair Voyager 4 GB. The stragglers consisted
of the Imation Nano 4 GB, the Tech-Com 4 GB,
Toshiba TransMemory 4 GB, and the Kingston
Data Traveler 100.

Conclusion
If our hearts ruled our heads we’d award the
SanDisk Extreme Ducati Edition with gold and
forget about this category. However its not the
wisest choice and not everyone will want to
spend three times more for double the speed.
That established, Digit’s Best Buy Gold goes to

JANUARY 2008

Corsair Voyager 2 GB
The most rugged data
lugger

JANUARY 2008

Transcend JetFlash V10 4 GB
When performance and price
collide

The Blue Whale—Corsair Voyager 16 GB

The only really large drive we were able to get our hands on was a Corsair
Voyager featuring a massive 16 GB. Although their catalogue shows that the

32 GB variant is a market reality, availability is a different story. This drive
features the same ruggedness that the Voyager series are famous for, and shares
even the same colour. In fact, if not for the tiny 16 GB imprint on the translucent
rubber that covers the activity LED, you wouldn’t be able to tell it apart from
their other versions—it looks just like the 2 GB version shown above.

It was a pity to see such a large drive thrashed in our random write tests,
though. Although this particular test brings most drives to their knees, we were
hoping for a different result here. Alas, with assorted write speeds of 1 and 2.35
MBps the Voyager 16 GB isn’t as fast as its target audience would want it to be.
If you want a 16 GB drive, you’re probably a movie buff or an enthusiast, looking
to transport dual-layer ISOs or rather large games on this drive, which might
end up being a painful wait.

Overall, this drive is a benchmark for the size we’d like to see become de
facto next year. But there’s not much going for the Voyager besides its size
and of course its price—Rs 6,990. Imagine lugging your MP3s to office and
back. Got a bigger music collection than that? Wait for the 32 GB version, and
pray that it’s much faster.
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BRAND 
MODEL

Price (Exclusive Of Taxes)
Comments

Grand Totals (Out Of 100)
Features
Performance 
Features
Storage Capacity (Claimed)
Storage Capacity (Actual)
Security
Software Features
Visual Indicators (LED, etc.)
Other Accessories Provided
Other Features
Build Quality (Scale Of 10)
Quality Of Materials Used
Sturdiness Of The Overall Package
Cap Locking Mechanism
Performance
HD-Tach 3 (8 MB Write Tests)
Random Access Time
Average Read Speed
Average Write Speed
Read Burst Speed
CPU Utilisation (%)
SiSoft Sandra 2007 (64MB File Test)
Read
Write
File Transfer Test
Write—100 MB (Sequential)
Read—100 MB (Sequential)
Write—100 MB (Assorted)
Read—100 MB (Assorted)
Write—1 GB (Sequential)
Read—1 GB (Sequential)
Write—1 GB (Assorted Files)
Read—1 GB (Assorted Files)

Scoreboard                      1 GB
Moser Baer

1 GB

480
+ Fast, looks good

– None in particular 

42.75
13.09
29.66

1 GB
960 MB
N
0
N
NA
NA

6.5
6.5
7

0.5 ms
28.5
4.6
23.6
0.04

18.53
4.63

7.57
26.74
1.08
13.19
6.23
33.68
6.21
28.04

Corsair
Voyager 1 GB

550
+ Rugged

– Slow performer 

40.00
20.86
19.14

1 GB
967 MB
NA
6
Y
USB Extension cable

7.5
7.75
7

0.9 ms
16.7 MBps
7.35 MBps
17 MBps
0

16.38 MBps
4.36 MBps

4.19 MBps
16.19 MBps
0.78 MBps
13.71 MBps
4.15 MBps
14.93 MBps
2.71 MBps
11.84 MBps

Toshiba
1 GB

470
+ Attractive Looker

– Mediocre performer 

37.66
13.44
24.22

1 GB
960 MB
N
0
N
NA
NA

6.5
6.5
7.5

0.4 ms
18.7
7.5
18.8
0.05

17.47
7.46

7.88
20.41
0.93
14.95
7.85
13.24
4.07
16.18

Transcend
JetFlash V30 1 GB

550
+ Attractive

– Very Slow 

29.21
15.26
13.95

1 GB
969 MB
N
0
Y
lanyard cable
NA

5.5
5.5
7

0.6 ms
18.2
6.8
19.2
0.03

18.23
4.53

5.75
10.83
0.29
8.89
1.44
5.00
1.25
3.73

Transcend
JetFlash 168

700
+ Attractive, reasonably fast

– None in particular 

41.28
14.77
26.51

1 GB
998 MB
N
5
N
lanyard cable
NA

6
6.5
6

8.7 ms
12.4
8.6
14.4
0

14.19
6.47

8.23
13.62
4.11
14.58
8.40
12.73
5.25
13.74

Buffalo 
Turbo USB 2GB

970
+ Looks good

– Turbo mode not effective 

37.30
13.09
24.21

2 GB
1.88 GB
N
0
N
NA
NA

6.5
6.5
7

0.6 ms
21.2
6.1
22.3
0.06

21.36
4.61

4.28
47.17
0.74
13.23
4.24
19.61
3.30
17.50

Corsair
Voyager 2 GB

900
+ Rugged and Fast

– None in particular 

51.77
20.86
30.91

2 GB
1.88 GB
N
6
Y
USB Extension cable

7.5
7.75
7

0.9 ms
29.6
11.2
31
0

29.49
6.55

7.76
31.15
1.11
12.99
7.51
27.68
4.03
21.49

Kingston
DataTraveler

2850
+ Well built

– Very slow 

27.72
12.25
15.47

2 GB
1.86 GB
NA
0
N
NA
NA

6
6.25
6.5

1 ms
12.8
6.5
13.7
0

11.12
5.73

4.29
10.09
0.30
7.45
5.90
13.78
2.08
9.29

Kingston
DataTraveler Reader

2GB

2500
+ Feature Rich

– Slow 

33.16
13.65
19.51

2 GB
1.95 GB
NA
0
N
NA
Card Reader

6
6.5
6.5

0.7 ms
12.6
7.6
12.9
0.04

13.84
6.84

6.46
12.79
0.61
11.68
6.18
12.43
4.19
11.58

JANUARY 2008 2 GB
Moser Baer

2 GB

735
+ Fast performer

– Flimsy design 

41.65
13.09
28.56

2 GB
1.88 GB
N
0
N
NA
NA

6.5
6.5
7

0.5 ms
30.4
4.5
25
0.03

18.56
4.36

4.02
19.19
0.62
10.66
7.05
37.48
6.34
30.36

SanDisk
Cruzer Titanium U3 2GB

1590
+ Extremely Well Built

– Heavy 

50.56
24.71
25.85

2 GB
1.9 GB
Y
8
Y
NA
NA

8
7.5
6.5

0.4 ms
20.6
8.4
21
0.09

19.12
7.33

7.26
19.61
1.50
8.75
7.60
18.57
6.30
16.61

JANUARY 2008

Flash Forward

We’ve seen flash emerging from a niche product to something that is properly
mainstream. But as of now this applies to thumb drives only. On the bigger

scene flash memory has pervaded more than just your pocket. It has seen usage
as a storage medium, particularly in notebooks, where power consumption is a
necessary evil. The fact that flash has no moving parts and consumes a fraction of
the power of its magnetic siblings, is an attractive enough reason for vendors to
use it, despite the fact that anything more than 16 GB of flash is very expensive.

As the drive for convergence leads to better PDAs, multimedia phones,
PMPs and their ilk, with more features and customisability, the demand for
storage as a medium will increase by leaps and bounds. Flash has been waiting
in the wings for a while now—a nascent period that saw a growth of no more
than 10 per cent.

We’re still going to prefer 500 GB hard drives for awhile, and it’ll take
some time for extremely high density flash modules to enter the consumer
space. However, when it comes to portable storage, the invasion of flash has
already begun…

Trancend’s JetFlash V10 4 GB. An excellent
product—its fast, reasonably rugged and a
steal at just Rs 1,600. The only other worthy
alternative is the Corsair Voyager 4 GB (Rs
1,550). It’s the third-fastest drive in the com-
parison and has a decent bundle (similar to
the other Voyager drives). 

Once again, Toshiba’s much acclaimed
TransMemory drives failed to impress. We were
surprised at the lacklustre performance of the
Buffalo 4 GB drive and even with Turbo USB
enabled we didn’t notice a big improvement.
In fact this was the case in the 2GB category as
well, sure a difference of 2-3 percent with
Turbo USB enabled may seem significant, but
its not a big deal and not really noticeable in
reality—more over its a far cry from the
claimed 16 percent performance hike. 

OBESE INDULGENCES—8 GB
Features
With the ability to store 8 gigabytes of data,
you can actually extract entire DVDs to such
drives. Kingston’s DataTraveler Secure was a
hulk of a drive—heavy, and claimed to be
waterproof (up to four feet under-water);
something we didn’t test. Buffalo’s Turbo USB
was identical to the other Buffalo drives, and
that’s a good thing. The 8 GB Cruzer from
SanDisk was built identically to the other
Cruzer drives—exemplary. The other attrac-
tive looking drive was the Transcend JetFlash
V30 which used a shiny black, translucent
body to convey all the appeal it needed to. It’s
rather compact too, and was the smallest of
the 8 GB drives.

JANUARY 2008

Transcend V60 8 GB
One stop data shop!
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SanDisk
Cruzer U3 2 GB

1690
+ Well built

– None in particular 

49.94
23.73
26.21

2 GB
1.9 GB
Y
8
Y
NA
NA

7
7
6.5

0.5 ms
20.5
8.3
21.4
0.06

19.24
7.72

7.74
20.28
1.53
8.90
7.75
18.21
6.37
16.59

Toshiba
TransMemory 2GB

860
+ Attractive looks

– Very Slow 

42.10
24.08
18.02

2 GB
1.85 GB
Y
8
Y
NA
NA

6.5
7
7.5

4.3 ms
13.2
4.3
13.9
0

12.32
3.42

4.79
14.31
0.79
18.05
3.80
12.27
3.24
11.08

Transcend
JetFlash V30 2 GB

900
+ Compact, good looks

– Slow 

31.81
15.26
16.55

2 GB
1.9 GB
N
0
Y
lanyard cable
NA

5.5
5.5
7

0.6 ms
18.8
7.1
20.2
0.02

18.56
4.39

5.76
10.96
0.31
9.79
2.97
10.12
2.37
7.13

Transcend
JetFlash V10 2 GB

800
+ Fast, well built

– Bland looks 

49.39
17.01
32.38

2 GB
998 MB
N
5
Y
lanyard cable
NA

5
5.5
7

1.1 ms
27.6
10.2
29.5
0.06

29.35
7.72

9.16
30.86
1.57
12.11
7.80
27.34
5.27
23.52

Umax
Apus Zoom

1138
+ Great Looks

– Very Slow 

25.96
13.51
12.45

2 GB
1.9 GB
N
0
N
Lanyard ring
NA

7
6.75
6

0.8 ms
19.65
4.23
21.43
0.05

17.24
4.26

1.81
2.16
0.46
1.28
4.37
8.30
2.40
3.15

Buffalo
Turbo USB 4GB

2,000
+ Attractive looks

– Turbo USB over hyped 

36.90
13.09
23.81

4 GB
3.74 GB
NA
0
N
NA
NA

6.5
6.5
7

0.6 ms
20.8
5.4
21.3
0.07

20.75
4.36

4.32
49.02
0.75
12.63
4.20
19.71
3.25
17.18

Corsair
Voyager 4GB

1,550
+ Rugged, fast

– None in particular 

47.96
20.86
27.10

4 GB
3.78 GB
NA
6
Y
USB Extension cable

7.5
7.75
7

0.7 ms
22.2
11
22.8
0

21.85
7.64

7.56
24.69
1.00
12.69
7.41
20.75
4.36
18.40

Imation
Nano 4GB

1,800
+ Cute looking

– Slow 

27.93
11.20
16.73

4 GB
3.82 GB
NA
0
N
NA
NA

5
5
7

11.8 ms
11.3
4.8
11.8
0.04

9.8
5.4

5.37
11.21
0.87
11.06
4.98
10.96
3.52
10.30

Kingston
4GB DataTraveler 100

2,272
+ Good build quality

– Slow performer 

33.56
15.72
17.84

4 GB
3.84 GB
NA
0
Y
NA
NA

6.25
6.5
7

1.8 ms
13.9
5.5
14
0.04

13.1
4.3

3.92
15.92
0.96
13.07
3.96
12.75
2.94
12.32

Kingston
DataTraveler Mini

2,850
+ Very Compact

– USB Mechanism tacky

36.29
12.74
23.55

4 GB
3.84 GB
NA
0
N
NA
NA

6.5
6.5
6.5

0 ms
20.6
6.7
21.4
0.1

19.5
6.17

5.79
26.11
0.59
12.92
5.88
19.53
3.88
16.34

Kingston
DataTraveler Mini Fun

2,850
+ Cute looking, compact

– Mediocre build quality 

35.82
12.39
23.43

4 GB
3.84 GB
NA
0
N
NA
NA

6
6.5
6.5

1 ms
20.6
6.6
21.4
0.1

19.3
6.36

5.73
20.33
0.66
13.05
5.88
19.86
3.85
17.35

2 GB 4 GB
BRAND 
MODEL

Price (Exclusive Of taxes)
Comments

Grand Totals (Out Of 100)
Features
Performance 
Features
Storage Capacity (Claimed)
Storage Capacity (Actual)
Security
Software Features
Visual Indicators (LED, etc.)
Other Accessories Provided
Other Features
Build Quality (So 10)
Quality Of Materials used
Sturdiness Of The Overall Package
Cap Locking Mechanism
Performance
HD-Tach 3 (8 MB Write Tests)
Random Access Time
Average Read Speed
Average Write Speed
Read Burst Speed
CPU Utilisation (%)
SiSoft Sandra 2007 (64MB File Test)
Read
Write
File Transfer Test
Write—100 MB (Sequential)
Read—100 MB (Sequential)
Write—100 MB (Assorted)
Read—100 MB (Assorted)
Write—1 GB (Sequential)
Read—1 GB (Sequential)
Write—1 GB (Assorted Files)
Read—1 GB (Assorted Files)
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Value for money Index Price Index The Data Traveler Secure has full 256-bit
AES (Rijndael) encryption. This makes the
Secure the perfect choice for someone who’s
really serious about data protection. Not only
can you limit access to the data on the drive
but any data placed in the secure folder auto-
matically gets encrypted.

SanDisk’s Cruzer also allows password
encryption, which is standard with the U3
interface—and we’d like U3 if it wasn’t for the
annoying pop-ups, in fact all U3 based drives
are reasonably secure—something of a plus—
but the interface leaves a lot to be desired.

Performance
With absolutely nothing to choose from
between the speeds of the Buffalo and Kingston
drives we knew we had our two performance
winners nailed down. The Kingston drive does

better at assorted writes—worth remembering
if you intend to copy lots to files to the drive. If
your need patterns dictate a lot of reading
from the USB drive then the Buffalo would be
better. The Transcend JetFlash V60 is the near-
est competitor to these two speed demons, but
still loses by a small margin. Transcend’s own
JetFlash V30 brings up the rear.

Conclusion
If you are a security nut, and more concerned
about who’s viewing your personal stuff then
go with the Kingston DataTraveler Secure—no
more worries except the price: Rs 11,111. If
that’s a little too much to cough up, you
should look at the U3-based SanDisk Cruzer—
for Rs 7,990, you get decent speed, and great
build quality. You’ll also get security as all
the Cruzer drives come with the U3 inter-
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SanDisk
Extreme Ducati Edition

6,790
+ Fast, gorgeous looker

– Costly extravagence 

63.28
19.43
43.85

4 GB
3.8 GB
NA
0
Y
Neckstring
NA

8.5
8.25
7.75

0.6 ms
26.1
17.8
26.9
0.06

24.82
16.48

18.25
27.93
1.93
13.62
18.06
23.93
13.34
20.21

Tech-Com
4GB

1,350
+ Decent security features

– Slow

37.19
20.62
16.58

4 GB
3.83 GB
USB Disk Pro (Software)
5
N
USB extension cable, lanyard

NA

6
6
7.25

2.7 ms
11
5.1
11.2
0.03

12.3
4

5.13
10.66
0.93
10.91
5.25
10.37
3.49
10.00

Toshiba
TransMemory 4GB

1,680
+ Secure U3 interface

– Very Slow 

39.11
24.08
15.03

4 GB
3.72 GB
Y
8
Y
NA
NA

6.5
7
7.5

4.5 ms
13.7
4.5
13.9
0

12.01
3.27

3.82
11.83
0.64
7.88
3.23
12.77
2.75
11.27

Transcend
JF V10 4 GB

1,600
+ Speedy performer

– Lack-lustre design 

49.12
17.01
32.11

4 GB
3.81 GB
N
5
Y
lanyard cable
NA

5
5.5
7

1.1 ms
29
10
29.2
0.07

29.49
7.64

8.42
28.99
1.50
11.45
8.15
28.32
5.32
23.16

Transcend
JetFlash V30 4 GB

1,600
+ Attractive Looker

– Mediocre performer 

39.91
15.26
24.65

4 GB
3.8 GB
N
0
Y
lanyard cable
NA

5.5
5.5
7

0.6 ms
18.7
6.8
19.4
0.04

16.81
5.63

5.65
37.31
1.45
11.92
4.55
24.73
3.87
16.62

Transcend
Jetflash V60 4 GB

1,700
+ Well built

– Slow performer 

35.41
14.49
20.92

4 GB
3.8 GB
N
5
N
lanyard cable
NA

6
6
6

0.7 ms
13
8
13.3
0.05

14.19
6.55

6.50
13.44
1.48
11.90
6.40
12.70
4.24
11.99

Buffalo
Turbo USB 8GB

5,220
+ Looks Good, Fast

– Costly

45.42
13.09
32.33

8 GB
7.49 GB
NA
0
N
NA
NA

6.5
6.5
7

1.5 ms
30.7
12
32.8
0.1

27.83
10.53

7.95
33.00
1.01
9.80
7.74
29.12
4.72
23.60

Kingston
DataTraveler Secure

11,111
+ Great Security features

– Very Expensive

53.47
21.25
32.23

8 GB
7.6 GB
Y (256 bit AES Enctyption)
6
N
NA
NA

8
7.5
6.75

0.5 ms
24.9
10.8
26.2
0.06

23.42
9.4

7.51
25.51
2.68
10.56
9.47
23.32
6.85
20.17

SanDisk
Cruzer U3 8 GB

7,990
+ Solidly built

– None in particular

50.60
23.73
26.87

48 GB
7.63
Y
8
Y
NA
NA

7
7
6.5

0.7 ms
27
8.2
30.9
0

24.64
7.25

6.92
17.54
1.69
8.26
7.32
17.59
5.09
17.27

Transcend
JetFlash V60 8GB

3,100
+ Great value for money

– None in particular

42.08
14.49
27.59

8 GB
7.65 GB
N
5
N
lanyard cable
NA

6
6
6

0.6 ms
21.9
9.6
22.8
0.02

21.1
8.83

8.13
23.98
1.09
9.89
10.05
21.78
4.20
19.29

Transcend
JetFlash V30 8 GB

4,500
+ Looks cool

– Slow

35.71
15.26
20.45

8 GB
7.61 GB
N
0
Y
lanyard cable
NA

5.5
5.5
7

0.7 ms
14.5
8.4
15.9
2 5

13.24
7.35

6.67
15.22
1.35
9.51
5.98
14.74
2.69
13.49

Corsair
Voyager 16 GB

6,950
+ Rugged, lots of space

– Slightly slow

48.05
20.86
27.19

16 GB
15.1 GB
NA
6
Y
USB Extension cable

7.5
7.75
7

2.8 ms
33.6
12.35
35
0

33.86
6.55

8.10
37.74
1.00
9.61
3.93
15.57
2.35
12.69

4 GB 8 GB
BRAND 
MODEL

Price (Exclusive Of Taxes)
Comments

Grand Totals (Out Of 100)
Features
Performance 
Features
Storage Capacity (Claimed)
Storage Capacity (Actual)
Security
Software Features
Visual Indicators (LED, etc.)
Other Accessories Provided
Other Features
Build Quality (Scale Of 10)
Quality Of Materials Used
Sturdiness Of The Overall Package
Cap Locking Mechanism
Performance
HD-Tach 3 (8 MB Write Tests)
Random Access Time
Average Read Speed
Average Write Speed
Read Burst Speed
CPU Utilisation (%)
SiSoft Sandra 2007 (64MB File Test)
Read
Write
File Transfer Test
Write—100 MB (Sequential)
Read—100 MB (Sequential)
Write—100 MB (Assorted)
Read—100 MB (Assorted)
Write—1 GB (Sequential)
Read—1 GB (Sequential)
Write—1 GB (Assorted Files)
Read—1 GB (Assorted Files)

Web siteCompany E-mailBrand

Contact Sheet Flash Drive

Transcend

Kingston
SanDisk
Umax
Tech-com
Toshiba
Corsair
Buffalo
Moser Baer
Imation

Mediaman Infotech Pvt Ltd 
Supertron Electronics Ltd
Kingston Technology India
Rashi Peripherals Pvt Ltd
Neoteric Infomatique Pvt Ltd
SHREE Sagarmatha Distributors Pvt Ltd 
Abacus Peripherals Pvt Ltd
Tirupati Enterprises
Buffalo Technology
Moser Baer India Ltd
Imation India Pvt Ltd

www.mediamangroup.com 

www.supertronindia.com
www.kingston.com/india
www.rptechindia.com
www.neoteric.co.in 
www.techcomindia.com
www.abacusperipherals.com 
www.tirupati.net
www.buffalotech.com
www.moserbaer.comwww.imation.co.in

022-23828100 
022-23881397 / 1924
NA
022-67090909
022-39828600
011-26428541 / 42 
022-40914600 
9339207519
011-41538059
011-40594500
41519880 / 81

face, which has security features in-built.
If you’re really looking for something

cheap try the Transcend JetFlash V60 8 GB (Rs
3,100). Buffalo’s Turbo USB is another decent
offering for Rs 5,220, and is a good mix of
performance and price. However much we
like performance, a mix of value is impor-
tant. As far as the delicate balance goes,
nothing sets a better example than the
Transcend JetFlash V60 8GB which shames its
V30 brethren by a good margin. Our Best Buy
Gold goes to the Transcend JetFlash V60—
good for carrying around volumes of data,
and you won’t really feel the pinch. 

michael_browne@thinkdigit.com
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If you are an executive in
the market for a suitable
cell phone, Nokia’s E

series offers the best bang
for the buck. The Nokia E51
is the latest from the vener-
able E series, and an apt suc-
cessor to the hugely popular
E50 model, which it will
eventually replace. The E51
brings in new features at a
price that’s hard to beat. 

The keypad is com-
pletely revised, with dedi-
cated keys for Contacts,
Calendar,
E-mail and Home. The soft
menu keys, however, are too
small for comfort. The rest
of the keypad is a delight—
good tactile feedback, and
key spacing is immaculate.
The rubberised keys for
volume up / down, push-to-
talk and power are hard to
operate, though.

The E51 feels peppy—it
uses the same processor as

on the flagship N95. With
130 MB of memory on board,
you can do a lot of multi-
tasking without the phone
getting sluggish, and the
memory can be expanded to
4 GB via the microSD slot (a
512 MB card comes bundled).
The E51 runs on Symbian OS
Series 60, and crams in lot of
features besides the stan-
dard set. Most of these will
go down well with execu-
tives—for example, the
Advance call manager lets
you manage incoming and
outgoing calls efficiently. In
addition, WorldMate, an
application for frequent
fliers, comes bundled. The E51 is a 3G, quad-

band phone with HSDPA,
Wi-Fi (802.11g), Bluetooth,
Micro USB and an infrared
port. There’s a switch to turn
Bluetooth on and off on the
main keypad. Multimedia
features include a good MP3
player, a 2MP camera with

still and video shooting, and
FM radio.

Signal reception is good,
as is voice clarity. Internet
browsing speeds are faster
than with the E50 or E61,
thanks to the revised Web
browser. The camera is above
average, but loses perform-
ance in low-light conditions.
The speakerphone is clear,
with little or no echo on the
recipient’s side. We got
around three days of battery
life with nominal usage and
a terrific seven days of
standby time.

The Nokia E51 retails at
Rs 14,699; it is, we think, a
must-buy.

Specifications
Weight: 100 gm; Dimensions:
114 x 46 x 12 mm; Quad-band;
2MP camera; Video recording;
xHTML browser; Push-to-talk;
micro USB, infrared.

With Apple launching a
whole new range of

iPods recently, including
the iPod Touch, can
Creative afford to be far
behind? Not one to be
caught shuffling around
(pun intended), Creative
has launched the Zen
Stone Plus series.

With a player so tiny,
we’d expected the Zen
Stone to felt flimsy, but
surprisingly it didn’t.
There’s a small circular
blue OLED screen—nothing
special—and a Play button
surrounded by a circular
button that houses four
controls—track shuffle and
volume up / down. There’s
a tiny button on the top of
the player that has
controls for the Menu and
play / pause functions. 

Available in 2 GB only,
the Zen Stone features FM
radio and supports up to 32
presets, inbuilt audio
recording, and a stopwatch
function—not bad for such a
small device. Unlike iPods,
there are no drivers
required to connect it to
your PC—just drag and drop,
which is a huge relief. 

Music quality is a
mixed bag with the Stone.
Firstly, if you’re even
remotely interested in
good sound, throw away
the bundled earplugs. Once
we replaced them with our
Creative EP630
headphones, everything
was so much clearer. Then
we tried the Bose Intra
Ear—our reference for
PMPs—and things seemed
even better. Punchy, tight
bass, superb vocal tones,
and a decent extended
high-end makes the Zen
Stone very suitable for

rock, pop, jazz and reggae.
If you listen to lot of
classical music, you’ll need
much better headphones to
bring out the recessed
highs. Bottom-line: the Zen
Stone is only limited by its
default earplugs—and most
PMPs are.

Don’t let this stop you
buying it—if you want
something tiny, sturdy, and
easy to use, the Zen Stone
will suit you. If you want
good sound, invest in a pair
of decent in-ear earplugs. 

Specifications
Capacity: 2 GB; Battery life:
9.5 hrs; Display: 64 x 64 blue
OLED; Weight: 21 gm;
Audio support: MP3, WMA,
Audible, WAV

T his one comes as an
overclocker’s delight.
The ASUS Maximus

Formula is based on Intel’s
new X38 chipset, sporting an
ICH9R Southbridge. This is a
limited edition, and features
hand-picked components for
extreme overclockability.

There is support for
Penryn and 1600 MHz FSB,
and dual x16 slots that
officially support CrossFire.
Incidentally, the PCI-E slots
support the new PCI-E 2.0
standard too—more future-
proofing for you. ASUS drops
in their fusion block system
as well—basically a heat-pipe
solution that integrates a
water block on the
Northbridge chipset for
proper cooling. The entire
board has a very intricate
heat-pipe system that
remained cool no matter
how hard we thrashed it.

Some nifty little
additions will appeal to
overclockers: the CMOS,

Power and Reset buttons,
and colour-coded LEDs on
the PCB that will display the
status (whether overvolted or
not) of components
including CPU, memory,
Northbridge, and FSB.
There’s also an inbuilt sensor
that will warn you if GPU
temperatures exceed a set
threshold—a boon for users
with the latest thermal
monsters from NVIDIA and
ATI. ASUS has also
incorporated a 2-phase
memory voltage termination
for better voltage regulation
even while overclocking—this
should filter noise and RF
interference for better
performance under stress.
The BIOS is full of

overclocking options and
tweaks—newbies and
enthusiasts alike will feel
at home. 

The Maximus Formula SE
also has a more-than-
sufficient number of SATA,
and USB ports.

With a PC Mark 2005
score of 10,572, the Maximus
Formula isn’t bottlenecking
the QX6850 (3.0 GHz) in any
way. With a graphics score of
18,299 in 3D Mark 2005
(using an 8800GTX), this
board is definitely free of the
early hiccups that plague
most platforms. We did get
our E6550 (2.33 GHz) to run
along happily at 3.15 GHz
(the FSB being overclocked
from a default 333 MHz to

450 MHz)—a very good result. 
Rs 16,800 may seem high,

but it’s plenty of board for
that much. ASUS includes a
rich bundle too. Highly
recommended for those
looking at a high-end, stable
platform in general, or
CrossFire in particular.

Specifications
Intel X38 chipset; ICH9R
Southbridge; DDR2 1200 MHz
and 1600 MHz FSB support;
6 x rear USB ports; 6 x SATA
2.0 ports

ASUS Maximus Formula  
CrossFire Compadre

Contact: Nokia India Pvt Ltd
E-mail: ext-manoj.goel@nokia.com
Web site: www.nokia.co.in
Price: Rs 14,699

CoolerMaster is a big
name in the Desktop
chassis and PSU

market, and there’s
nothing small about the
Real Power M1000, either.
CoolerMaster goes modular
with this model, which
cuts down on cable clutter.
A 135 mm fan dominates
the underside of the unit
and cools well.

With the dedicated
circuitry that active PFC
features, this PSU is rated
at 99 per cent—you can be
assured of maximum
efficiency of power
distribution, a good thing
for those high-end PCs with
costly components. 

We fired up a Core 2
Quad QX6850 on an ASUS
P5N32-E SLI and

overclocked it to 3.6 GHz,
powered the 2 GB of 1066
MHz memory at 2.2 V,
two 8800GTX in SLI, two
WD Raptors in RAID 0
plus a third 500 GB hard
drive, and an X-Fi Elite Pro
along with a couple of
DVD-Writers.

The M1000 handled
everything with no fuss—it
remained cool to the
touch, supplying 3.31 V to
the 3.3 V rail, 4.97 V to the
5 V line and 11.987 V to the
12 V line—perfectly

acceptable and well within
the boundaries of what’s
considered really good.

If you’re looking for
power for the kind of PC
that gets geeks drooling,
you should know that such
power supplies don’t come
cheap! But if the safety of
your components matters
and you can shell out Rs
15,600, then you can’t get
anything better.

Specifications
Power (continuous): 1000
watts; Efficiency: >85%; Input
voltage 90-264V (auto); Peak
power to each rail: 3.3V: 40
amps, 5V: 40 amps, combined
12V rails: 110 amps

CoolerMaster Real Power M1000 
Never Run Out Of Juice

Contact: CoolerMaster Co. Ltd.
Phone: +91-9833870302
E-mail: tanmay_l@coolermaster.com
Web site: www.coolermaster.com
Price: Rs 15,600

We test the latest hardware
and software products 
available in the market

Features
Performance
Bundle
Value for Money
Overall 

RATINGS

Contact: Asustek Computer Inc  
Phone: 022-67668800
E-mail: media_india@asus.com
Web site: http://in.asus.com
Price: Rs 16,800

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Feature  
Performance
Build Quality
Value for Money
Overall 

RATINGS

Features
Performance  
Build Quality
Value for Money
Overall 

RATINGS

Creative Zen Stone Plus 2GB
A Pebbleful Of Music!

Nokia E51 
A Classic Reborn

BazaarBazaar

Contact: IDLDPL
Phone: 011-46096400
E-mail: contactus@idldpl.com
Web site: http://in.creative.com
Price: Rs 4,399
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Good camcorders and
digital cameras at

reasonable prices are
common these days, and
that means that budding
film and art students are on
the lookout for good video
compiling and editing
software to go with them.
Pinnacle comes into the
picture here with Pinnacle
Studio Ultimate Events Pro
Deluxe 11.

The package is huge, and
comes with a PCI FireWire
expansion card for your PC.
There’s also a chroma cloth
to make keying and mask
creation a lot easier. The
installation is fairly simple—
first install Studio Plus and
then the upgrade to
Ultimate.

The Ultimate version
gives you three main
plugins—proDAD Vitascene,
BIAS SoundSoap and
StageTools MovingPicture. It
also gives you the ability to
work with 5.1 audio streams.

The bundle features a
huge collection of transition
effects for scenes, and there
are also loads of sounds

provided in appropriate
categories. Each of the
components—sound, video,
and text—are placed in
different timelines, so
handling all of them is very

simple. There’s support for
online video hosts like
Yahoo! Video and Studio
Online.

The package comes with
a fat, highly-detailed user
manual, which even has tips
on how to get your hard
drive prepared for the large
amounts of data required

during video editing by
tweaking and optimising
transfer rates.

At first, Pinnacle Studio
Pro Deluxe 11 seems like a
very sophisticated package,
but its abundance of
features is presented in a
very friendly interface—you
don’t have to be a trained
professional to use them. At
Rs 17,900 for the internal
PCI package, the decision to
buy it is a little difficult, but
if you’re a student getting
into the film industry or
running a small business,
it’s a must-have.

Specifications
Included in Ultimate: BIAS
SoundSoap, proDAD VitaScene,
StageTools MovingPicture;
Supports Dolby 5.1 encoding
and HD video; Package
contents: Green Screen,
microphone, PCI FireWire
interface card, manual

Take one look at the
Samsung ML-1630, and

you’ll be forced to think: is
this really a printer?
Samsung has paid great
attention to the aesthetics of
this mono laser printer by
giving it a glossy, piano-black
finish and no sharp edges.
Just 12.2 cm tall, it’s smaller
than many inkjets out there.

The control panel is
rather simple—there are two
touch-sensitive buttons for
Power and Cancel. The
visual indicators become
visible during operation in
the form of a blue LED
display that displays the
total number of pages
printed. The input tray is
hidden, and can be opened
using a mechanical button.
It holds 100 sheets, but the
output tray holds just 30.

The printer has issues
handling paper—almost
every time we printed, the
first page emerged crumpled.
For a multi-page document,
it took 17 seconds for the
first page and around 4 for
every page thereafter. In our
standard test print, it could
print at 6.5 pages per
minute. Print quality is
decent—sharp edges, proper
gray tones and small point
sizes were all printed well.

The printer features
only the USB interface.
Nothing comes bundled

except for the standard
drivers and a manual. It
comes with a toner
cartridge that’s good for
1,000 pages, but a
replacement cartridge (for
2000 sheets) is the standard
one used with this printer.
Backed with a one-year
warranty, the Samsung ML-
1630 is priced at Rs 11,490—
too high a price for top-
notch aesthetics with sub-
par performance.

Specifications
Resolution: 1200 x 600 dpi
(hardware); Input tray: 100
sheets; Output tray: 30 sheets;
Buffer: 8 MB; Dimensions: 33
(W) x 37.6 (D) x 12.2 (H) cm;
Weight: 6.3 kg

Pinnacle Studio Ultimate Events Pro Deluxe 11
Your Own Personal Video Studio

Contact: Samsung India Electronics
Pvt Ltd
Phone: +91-11-41511234
E-mail: anupam.k@samsung.com
Web site: www.samsung.com/in
Price: Rs 11,490

Features  
Performance
Ease of Use
Value for Money
Overall 

RATINGS

Features 
Performance
Ease of Use
Value for Money
Overall 

RATINGS

Samsung ML-1630
Beauty Is Skin-deep

Contact: Pinnacle Systems
Phone: 9811904809
E-mail: adey.extern@
pinnaclesys.com
Web site: www.pinnaclesys.com
Price: Rs 17,900 (Internal PCI),
Rs 19,900 (External PCI)
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The DCP-135C is the
newest addition to the

inkjet digital copier stable of
Brother Inc. It is built
ruggedly enough to
withstand the rigours of
office work. It’s just 15 cm
tall, and the power
connector is located to the
left, making it easy to place
against a wall. This is a four-
cartridge inkjet solution—
more economical, and the
cartridge bay is placed at the
front right for easy access.

There is no power button,
so you have to use the soft-
power switch. The interface
is USB 2.0; the USB cable has
to be channelled through a
narrow canal into the
interior of the device—which
helps prevent accidental
disconnections. The buttons
are well-placed, but there can
be some confusion—the OK
button does not apply a
setting unlike most other
MFDs (!), so one needs to read
the manual. The one-line
LCD relays information
about status and settings.
The input tray holds 100
sheets while the output tray
holds 50. 

Print quality is decent—
there were no smudges, but
the borders were not always
crisp. Fine print was legible
even at the smallest point

size. Colours in the photo
print were a little washed
out, but not too much—no
smudging here either.
Normal text printing is slow:
27 seconds for a page, while
combination documents
print relatively faster at 33
seconds for a page. Printing
an A4-size photo takes just
under 270 seconds (4.5
minutes)—quite average. The
scanner recognised colours
accurately, and picked up
minute details. It scans really
fast—a 300-dpi A4 colour
photo took just 49 seconds.

Bundled with the MFD is
the ScanSoft PaperPort—a
good document
management and OCR
software. ControlCentre 3 is
a control panel that puts all
the functions of this MFD at
your disposal in a single
place. This is an enticing buy
at Rs 5,400.

Specifications
Printer: Resolution: 1200 x
6000 dpi (effective); Input tray:
100 sheets, Output tray: 50
sheets; Buffer: 16 MB; Printing
technology: 4-cartridge inkjet;
Scanner: Flatbed type;
Resolution: 600 x 2400 dpi
(optical); Media size: A4; Bit
depth (output): 24; Dimensions:
39.8 (W) x 36 (D) x 15 (H) cm;
Weight: 7.1 kg

Features  
Performance
Ease of use
Value for Money
Overall 

RATINGS

Brother DCP-135C
Appealing Overall

Contact: Brother International
(India) Pvt Ltd
Phone: 1800-222-422
E-mail: info@brother.in
Web site: www.brother.in
Price: Rs 5,400

1/2 Page Ad

This watch, which looks
like an elegant (but not

gaudy) analogue watch, has
an MP3 player built in. The
finish is scratch-resistant
galvanised steel-grey and
black plastic. We were
pleasantly surprised to find
that it isn’t cheap trash (it’s

made in China!)—it’s rather
ruggedly built.

The rubber strap looks
stiff and uncomfortable, but
once you wear it, it is not
that bad. The watch looks
rather large. The strap
makes it look like an alien
contraption, thanks to the
embedded USB connector
which is to be pulled off to
connect it to the PC. The
dial is eerie, with hands and
hour marks that emit a
calm green glow in the
dark. Indicator LEDs below
the hour marks glow when
the MP3 player is turned on,
and make the watch look
even more surreal.

The device gets instantly
recognised as a removable
drive, so you can also use it

to carry your data. Transfer
speeds are slow—it takes 110
seconds to transfer 100 MB,
so it takes around 9
minutes to fill it up. Getting
used to the controls is a
little frustrating at the
start, but you can quickly
get the hang of it. The
absence of any sort of
display is sorely missed, but
things are made a little
uncomplicated by the LEDs.

MP3 playback is above
par, and the bundled
earphones do an excellent
job of complementing the
player. There are four very
effective preset equaliser
settings. The fade-in and
fade-out effects are there by
default, though these often
clip a couple of seconds of
the start of the first song
being played. The earphones
are rather large, and may be
uncomfortable for some—
and thanks to the 2.5 mm
jack, you can’t connect your
favourite headphones,
either. It also has a voice
recorder with an inbuilt
microphone, which made
us feel like Johnny Sokko
commanding the Giant

Robot—it adds plenty of
nerd value.

MP3 playback lasts a
little over 5 hours, which is
fair—and the watch and
player have separate
batteries, so you can tell
time even after the music
stops. 512 MB is just OK for
an MP3 player, but may
seem less if you have a
voracious appetite for
audio; there is also a 1 GB
version available. Bundled
along is a longer cable to
connect it to the USB port
and software that lets you
upgrade its firmware. It
costs Rs 4,125—a bit high,
since there is no video or
even FM Radio.

Specifications
Capacity: 512 MB; Audio: MP3
(32 Kbps - 320 Kbps), WMA (5
Kbps - 256 Kbps); Voice
recording: ADPCM; Interface:
USB Full Speed 12 Mbps

Aigo U Watch MP3 UW-F020 512 MB
An MP3 Watch For Geeks

Contact: Bridge One Technologies
Phone: +91-40-23550794
E-mail: m.barathwaj@gmail.com
Web site: www.aigo.com
Price: Rs 4,125

Features  
Performance 
Ease of Use
Value for Money
Overall 

RATINGS

One of the first things
you’ll notice about

System Mechanic is the
facelift. The new interface
has a nice red theme with
bits of Vista-like treatment.

Cosmetic details aside,
System Mechanic 7 is now
in charge of more than just
Registry cleaning. It now
does everything from
checking your system
for security holes to
maintaining disk drives
as well.

ActiveCare is a feature
that allows you to select
which components System
Mechanic should
automatically handle. With
that set up, you won’t need
to do anything manually—
cleaning up the Registry,
for example.

Newcomers won’t have
to worry with any of the
advanced features. System

Mechanic scans your entire
system and then lets you
decide to fix all the issues it
finds. You can also
manually run each cleaning
task individually. If you do
make some massive changes
to the Registry during the
cleanup, the History feature
has you covered—it lets you
jump back to previous
settings by undoing
changes to the Registry.

There’s a process
manager that displays all
running applications—you
can choose to shut down
applications like you would
in the Windows Task

Manager; only here, you
can also stop them from
running again. This is
useful when you’ve found
what could possibly be a
worm or virus on
your drive.

The program is fairly
light: it only takes up 30
MB of RAM.

System Mechanic 7.5 has
come a long way, and there
have been a lot of new
features added. The price

tag of $49.95 (Rs 2,000) is
still a little too steep,
though, considering there
are free Registry cleaners
like CCleaner available for
download.

Specifications
Microsoft Vista / XP / 2000
compatible; Use on up to
three PCs 

System Mechanic 7.5.3
Solid Maintenance For Your PC

Features  
Performance 
Ease of Use
Value for Money
Overall 

RATINGS

Web site: www.iolo.com
Price: $49.95 (Rs 2,000)
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Dumping a cupboard-full of documents, audio cassettes,
video tapes and even photo albums on a hard drive or
DVD might sound easy, but is actually a complex

process. Operating systems use logical data structures for stor-
ing, organising and keeping track of files on a partition or on
an optical disc, called a filesystem.

The basic function of a filesystem is to make efficient use of
disk space for data storage, ease basic file opera-
tions (read, write, copy and delete) and catalogue
files for faster retrieval. 

A disk partition is like a compartment in a
train, while the filesystem is the seating arrange-
ment fixed within the compartments. Before
using any partition on a disk, a logical filesystem
needs to be initialised on it. Let’s have a look at
how a typical filesystem works.

How Filesystems Work
The space in a hard drive is divided into units
called sectors, usually of 512 bytes. The filesys-
tem groups the sectors together after creating
a sector index; the group is called a cluster or an
allocation unit. It’s difficult for the filesystem
to deal with data on a sector-by-sector basis, so
when the filesystem needs to access a sector

for a read-write operation, it will first define the cluster
number of that sector. Then from that cluster, it will use the
sector index to access that particular sector.

Each logical volume (hard drive) has a table—called the
File Allocation Table (FAT)—that carries all the information
about the sectors and the files stored on those sectors. 

Types Of Filesystems
Disk-based filesystems
These would be found on hard disks, CD-ROMs and DVDs.
Files are stored in a sequence of bytes on fixed-sized blocks
called sectors; these filesystems feature random-access file
reads and writes, and also file fragmentation across the disk.

Some disk-based filesystems also have journalling and ver-
sioning. In a Journalling filesystem like XFS on the Silicon
Graphics platform, changes in files are logged first in a spe-
cially-allocated area called a Journal before they’re actually
written on the main filesystem. Versioning filesystems like
OpenVMS allow for the existence of several versions of the
same file, and take periodic backups.

Popular disk-based filesystems include:

Windows: New Technology File System (NTFS), File Allocation
Table (FAT, FAT16, FAT32), and many more; Linux:
ext, ext2, ext2fs, NSS, ReiserFS and several others
based on Linux and Unix variants
Mac OS X: Hierarchical filesystem (HFS+), HFS,
Macintosh filesystem (MFS), Xsan

Disk-based filesystems can be further classi-
fied into:
Solid-state media filesystems: These are
designed for storing files on devices that rely on
Flash memory as their storage. Such filesystems
require special handling, because data blocks
wear out if information is repetitively written
and rewritten on the drive. Besides, the blocks
have to be erased explicitly before any data is
written on them. The Journaling Flash filesystem
(JFFS) and Yet Another Flash filesystem (YAFFS),
are popular solid-state filesystems.
Record-oriented filesystems: The basic purpose
of such filesystems is to store files in the form
of records to be compatible with older operat-

ing systems that are used exclusively on mainframes and
minicomputers.
Shared-disk filesystem: These are also known as SAN (Stor-
age Area Network) filesystems or Cluster filesystem. As the
name suggests, they are used on huge blocks of storage which
are directly accessible to computers via a network connection.

Network Filesystems
Network filesystems (or distributed filesystems) support the
sharing of files, printers and other computing resources over
a network. The performance of such filesystems is measured
by the time it requires to satisfy the service requests by dif-
ferent computers connected on the network. 

Such filesystems are found on file-servers and provide
access to files by acting as clients for remote access protocols
like NFS (Network filesystem) or SMB (Server Message). NFS
and SMB are popular examples of network filesystems.

Several network filesystems prevail today: 9P, Apple Fil-
ing Protocol (AFP), NetWare Core Protocol (NCP), Coda, Dis-
tributed File System (DFS) and Google File System (GFS), to
name a few.

Filesystems are critical for storage media to run properly
with the operating system. Regular maintenance and protec-
tion from malware is not only advisable, it’s necessary. 

samir_makwana@thinkdigit.com

You know FAT is a filesystem, that NTFS is a better filesystem, etc. But what is a filesystem?
How do they work?

How files are distributed in a FAT filesystem
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BURNING SOFTWARE

CDBurnerXP

We burn CDs and DVDs all the
time, and Nero’s all-too-well-
known suite isn’t the only

option. CDBurnerXp is a free alternative

to Nero, if you don’t want to cough up
for Nero’s features.

Using The Dropbox
The dropbox feature allows you to

browse through your Windows folders
and dump the items you want to burn.
This way, you don’t need to browse
using the CDBurnerXP interface. To use
the feature, click the Show Dropbox
button on the toolbar or go to View >
Show Dropbox. Drag and drop files
onto the box that appears at the top left

of the screen. The dropbox shows the
size of the compilation and the current
path where the folders are being
dumped. Right-click on it and click
Select Folder To Drop Into. This
way you can choose which folder the
files get dumped. To get back to the
default interface, click the Close
button on the dropbox.

Set Media Size Manually
Optical disc burning software

generally detects the media inserted in
the drive and determines the amount of
data that can go on it, but you won’t get
accurate information if you’re piling up
for a future burn with no disc in the
drive. To tell the software the type and
capacity of the media, right-click on the

bar for data being burnt and click
Select media size. Choose the type
of the media you’ll be using. The
changes will be seen immediately in the
main program as well as in the dropbox.

Printing CD Covers
CDBurnerXP might be a fraction of

the size of Nero, but it’s still got basic
features like printing CD covers. Once
you have all your data in place for
burning, go to File > Print cover
and select the type of cover. Enter the
name of your disc, and if you want to,
choose an image for the cover. Select
Preview to see how it’ll turn out. If
you’re happy with it, press Print.

File Filter
The file filter feature allows you to

filter out file types that you don’t want
to burn. For example, if you want to
burn all the PDFs in a folder and none
of the Excel or Word documents, you
will find the feature useful. Click on
Edit > File Filter. Enter the file
formats that you want to filter with a
semicolon to separate them. For
example, *.pdf;*.doc;*.xls will
only display the PDF, DOC, and XLS
formats.

Disc Labelling Data Options
Most of the time, all the CDs and

DVDs you burn end up with the same
old senseless label—DISC or DISC1.
CDBurnerXP can change this. Go to
File > Options > Data Options
tab. Under Default Disc Label,
enter DVD $day $month $year. There
are other variables like $time, $user
and $date that you can use as well.
Click OK and then restart the program
for the changes to take effect.

The dropbox makes it easier to compile data
for a burn

Set the type of media so you know in advance
how much space there is
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CDBurnerXP houses a basic cover printing
feature!

Let CDBurnerXP automatically label discs for youHarsho Mohan Chattoraj
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ShowTime interface and clicking on
Options. Click on DNC. Turn it on if
it’s off.

Dynamic Range Control
Dynamic Range Control is not just

another fancy name for a feature in
Nero ShowTime. It is basically
normalisation of the volume of the
audio stream—so if you’re listening to
music files of different volume levels,
you won’t have to jump to the PC every
time a loud file plays. Right-click on the
ShowTime interface, select Options
and go to Audio > DRC.

(Pseudo) Surround Sound On
Headphones!

Nero ShowTime is great for watching
high-definition videos, and with these,
you’re bound to get multi-channel audio
as well. Now not all of us have fancy
surround sound speaker setups. Nero
can simulate surround sound and give
satisfactory results on stereo speakers
and headphones as well! Right-click on
the ShowTime interface and select
Options. Under Audio, uncheck the
box for Use Windows Settings. From
the dropdown, select the type of setup
you have—if you select 2 speakers, use
Nero Virtual Speaker from the
Output mode. If you have headphones,

check Nero Headphone. 

Customise Fonts
Nero uses an On-screen

Display (OSD) to display
information of the video or
movie being played. By default,
a set of fonts and colours are
assigned to it, but you can
select a better set of fonts and
colours if you wish. Go to
Options and click on OSD
Settings under General.
Make sure Enable is checked,
and then click on Set Font to
change the font type for the
OSD. In the previous menu,
you will also find the option
for setting a colour and a

position where you want the OSD to
show up.

Similar fonts are used to display
subtitles for movies. There, too, you can
set which fonts should be used to
display them. In the Options window,
click on External Subtitles; check
the box against Enable External
Subtitles and click the Set Font
button to set a different font style.

Video Quality
High-definition playback isn’t very

easy for all hardware unless there’s
hardware decoding support from your
graphics card or if you have a fairly new
dual-core processor. Nero has an
automatic quality setting that downsizes
the quality of the video if your system
doesn’t perform too well. You can find
this option under Video Quality
under Options > Video. The setting
should be set to Auto-adjust. If you
know your system performs fine, then
you would want the best quality—push
the slider to Maximum Quality and vice
versa if your system isn’t performing as
well as you’d like.

Nero’s Image Mounting tool
Nero comes with software called

ImageDrive which you’ll find under
Nero Toolkit in the Start Menu. It allows
you to mount .NRG and .ISO images as a
virtual drives so you can load some of
your backed-up discs without having to
put them in the drive. When you first
run it, it installs the drivers which
create a virtual drive. Once that’s done,
click on the Enable drive checkbox
for the first drive. If you want a second
drive, you can check that box as well. A
new tab called First Drive will
appear. Click on it and point to the
image you want to mount. Now when
you go to My Computer or Explorer, you
will find a new drive in the list. Clicking
on it will reveal all the files and folders
from the image.

Nero DiscSpeed
DVDs have had a comparatively

notorious reputation when it comes to
reliability, so it’s very important to use
good media and check the data on it.
Nero DiscSpeed, under Nero Toolkit,
allows you to check for disc quality.
Select the Disc Quality tab and insert
a burnt disc into the drive. Make sure
you have the DVD drive selected from the
drop-down menu at the top and click
Start. The software gauges the quality
of the burnt disc. A final score will be
shown in the Quality score field on the
right. On Internet forums, you’ll find a
lot of such media scan posts. Run this
test on different kinds of media you’ve
burnt so you know which media works
best with your drive.

Burning Audio CDs 
If you’re burning data CDs all the

time and you want to burn an Audio
CD, you’ll notice no option to create a
new Audio CD—the only way is to close
CDBurnerXP and restart it; only this
time, make sure you choose the Create
Audio CD button. Now you can drag
and drop audio files like you would
data files.

If you want to burn an audio CD
without spaces between tracks, use the
dropdown menu for Burn disc with
DAO when in Audio CD burning mode.

Creating A Bootable Disc
Creating bootable discs may be

needed while trying to create LiveCDs or
booting into them for OS installations.
Go to Disc > Boot options and
mark the checkbox against Make Disc
Bootable. Click the button to select the
image and choose the type of emulation
from the dropdown menu. You can also

create an image from a floppy drive by
clicking on Create Floppy Drive.

Working With Disc Images
CDBurnerXP has features that allow

you to create or burn disc images. If you
have images that were created on Nero,
for example, you can convert them to ISO
by going to File > Convert ISO
Image. Select the source file—which can
be either a BIN or an NRG file—and then
select a location to create the image in.
Click the Convert to ISO button.

Discs can be replicated in the same
manner. If you don’t want to burn them
right away, you can have the image
created from the disc dumped on the
hard drive. Go to File > Copy ISO
disc. Select the source drive and instead
of the destination drive being the optical
disc drive, select the hard drive. Now a
new field will appear. Here you can
choose the path and a name for the ISO
to be dumped.

NERO 8

Nero isn’t just about the Burning
ROM software—it’s also about all
the extras that come with it. You

can find the installer for the trial
version of Nero 8 on the November DVD. 

Move The Cache Folder
Nero uses a location on the hard

drive when it needs to cache files before
burning them. If you’re running short
on space in your main partition, you
would want to change it to one with
more free space. Go to File >
Options > Cache and click on
Browse to choose a new location.

Sounds For Events
Nero has support for sounds but

they are disabled by default. Go to File
> Options > Sounds tab to set
sounds for events. The sounds that come
with Nero are in the default locations,
but you can select the ones you want by
clicking the Browse button. 

Nero BurnRights
Nero BurnRights is an application

that comes with Nero; it allows you to
define which users on your system can
burn CDs and DVDs. Go to Start >
All Programs > Nero 8 > Nero
Toolkit > Nero BurnRights. Select
the type of users that you want to give
permission to and click OK.

Do Not Eject The Drive
Every CD burnt is immediately

ejected from the drive by default in
Nero. To keep the CD or DVD in the
drive once it’s done, go to File >
Options > Expert Features. Check
the box against Do not eject the
disc after the burn is
complete and click OK.

Retro Nero
We all miss the Nero

Burning ROM from the past
years when it was a compact
little CD / DVD burning
software and not a complete
suite with modules we never
use. It’s reached a point where
there are tiny, hacked, illegal
releases of Nero Burning ROM

made available on the Internet which
take a fraction of the space of the entire
suite. If you have the nasty habit of
blindly clicking “Next” during the Nero
8 installation, you’ll most probably have
skipped the screen where you choose
the Custom installation mode. Uninstall
your current copy of Nero if you have it
installed. Start the installation till you
reach the window where you can choose
between Typical and Custom
installation. Select the Custom
install option and click Next. You’ll
soon see a window with the list of all
the Nero components selected. Click on
each one of them and select This
Feature Will Not Be Available.
Do the same for everything other than
Nero Burning ROM and continue with

the installation. At the end, you’ll have
completed your own clean compact Nero
Burning ROM installation the way it
used to be.

Searching For Specific
Formats

Trying to search for a few selected
filetypes you need to burn can be a
nightmare in an unassorted folder. To
look for a particular file using
wildcards, right-click on the folder in
the left pane of the browser window.
Click on Select pattern. Enter
wildcards with semicolons as seperators
and click OK. For example, entering
*Digit*;*.PDF as the pattern will
select all files with “Digit” in their
names and PDFs as well.

Encode Audio Files
Nero Burning ROM comes with an

in-built audio encoder: go to Extras >
Encode Files, click on Add and

select the files you want to encode.
Using the drop-down menu for Output
file format, select which format you
want to encode to and click on the
Settings button to set parameters for
the encoder. Finally, click on the
Browse button to select where you
want to store the encoded files once
encoded. Click Go to start encoding!

Better Compatibility
One of the issues with media and

the way they are burned is that is that
they’re not always compatible on all
DVD players. There are a few things that
can be done to solve this: one of them is
to set the high-compatibility mode on
for your drive. Click on the Choose
Recorder button to the right of the
drop-down menu for selecting the drive.
Select your drive and click on Options.
Check the box against DVD High
Compatibility Mode. This will make
sure that at least a gigabyte of data is
written on the media even if you don’t
have that much data. 

Another thing you can do is to use
the Book Type settings—this is basically
is to tell the drive that you have
inserted a DVD-ROM (for example) not a
DVD-RW or any other kind of DVD. This
way, there are better chances of the
drive reading your media. Use the drop-
down menu for Book Type settings in
the drive properties window and select
DVD-ROM, as it generally gives better
compatibility.

NERO SHOWTIME
Dynamic Noise Control
If you’re playing CDs or DVDs, you

would know that your drives run
continuously like your hard drives do.
The noise from spinning up and down
of the drives can be distracting. Nero’s
developers have implemented a feature
called dynamic noise control that helps
reduce this sound. You can find this
option by right clicking on the Nero

Remember to restart CDBurnerXP if you want
to burn an audio CD. It’s a bit annoying, but
there you go

Easter Egg! 

Nero Burning ROM still has the Easter Egg
which you can find in most of its earlier ver-
sions. Go to Help > About to see the
credits. Double-click in this window and
you’ll see the credits text flowing with dif-
ferent kind of effects. If you hold down [Ctrl]
and [Shift] together and then double-click,
the effects and scrolling will speed up.

A basic audio encoder is built into Nero Burning ROM

Embedding a boot image onto a disc is simple
to do

Dynamic Noise Control can help lower drive noise with
certain drives 

Watching movies with surround sound on
headphones is worth trying
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GOOGLE SERVICES

Google’s all but taken over our
online lives now—can you imagine
doing anything without it?

PICASA
Download Albums From Picasa
Web Albums

Photos that you see on Picasa Web
Albums can be downloaded directly to
the Picasa program without having to
manually save each photo from within
your browser. When on an album page,
look for a link on the left side that says
Download Album; confirm the
download, and once it’s complete, you
can view all the downloaded albums by
clicking on the Downloaded Album
link on the left. 

Upload Your Albums 
One of the biggest and the most

important feature of Picasa is its
integration with Google’s online photo
hosting service—Picasa Web. Click on the
Sign in to Web Albums link on the
top right of the Picasa window to log in
to the service—use your Google user ID
and password. Once signed in, select the
images you want to upload and click the
Web Album button at the bottom. Give a
title to the album and other description
if needed. Select the resolution you want
so that the images can be resized, and
choose whether you want to make the
album public or private. Click OK and
the images will be uploaded.

Creating Albums With Starred
Photos

Just like in Gmail and Google Reader,
you can “star” important photos. Browse
to the folders or albums where you have
all your photos. Select the ones you want

and click the Star icon at the bottom of
the screen. When you’re done, go to
File > New Album and give it a name
and description. Now click on Starred
Photos, select all the images and drag
them into your newly-created album.

Getting More Organised
When you install Picasa and run it

for the first time, it asks you whether you
want to scan your entire hard drive or
just scan your My Documents folder. All
the photos on the hard drive appear as
folders and albums on the left and
there’s no real way of identifying which
folders they belong to on your hard drive.
Sometimes, unnecessary images like ones
from your browser cache folders also
make their way into the list. The first
thing to do is to manually enter the paths
that you want to scan. You can do this by
going to Tools > Folder Manager.
Choose the folders you don’t want, select
the Remove from Picasa radio button
and click OK. Add any folders that Picasa
may have left out in the same manner.

Another way you can see from where
Picasa has listed all the photos is to go to
View > Folder View > Tree View. 

Backing Up Photos 
Every now and again, your hard

drive is bound to get clogged with
photos that you’ve taken and it is a good
idea to keep backing them up from time
to time. Picasa gives you the option to
burn your photos on to optical discs. Go
to Tools > Backup Pictures, select
New Set and give a name to it. Also
mention what formats you want to save
and if you’d like to save the backup into
a different folder or a network drive by
clicking on Disk-to-disk backup.
Click Create to finish. Now check the
checkboxes for the folders and albums
you want to backup and select Backup.

In the location that you backed up the
photos, you’ll find PicasaRestore.exe,
which you can run to restore the images
to the original path.

Picasa also has a Gift CD feature—go
to Folder > Create a Gift CD.

Click on Add More to add more folders
to the gift CD. Select the resolution for
the photos using the Photo Size drop-
down menu and give the CD a name.
Finally, click Burn Disc to burn the CD.

Adding Captions
To add a caption to a photo, double-

click on it and you will find a small text
area at the bottom of the photo. Enter
your caption here and hit [Enter]. To
delete the caption, click the Delete
this caption icon on the right. To
view the captions while in the main
photo index view, go to View >
Thumbnail Caption > Caption.

Host Your Own Web Albums
If you don’t want to use Google’s

online Web space to store your photos,
you can upload them to your own
personal Web site’s FTP server. Right-
click on the album you want to upload
and select Export as HTML Page.
Enter a name for the album title and the
resolution that you want to export the
images to. Click Next, choose a template
from the list and click Finish. The
finished page will be displayed in your
default Web browser. You can upload
that folder to your site and create a link
to it from your main page.

There’s a feature that Google claims
as experimental but it allows you to
upload the photos to the FTP server
directly through Picasa. Go to Tools >
Experimental > Publish via FTP.
Again, select a resolution, a save location
and a template. Now you’ll be prompted
to select an account. Click on Account
Manager to create a new account. Click
Add an Account and enter your FTP
server information—address, user and
password—and click OK. Now you can
select your new FTP server and click OK.

GMAIL
Google never stops plugging new features
into Gmail. We take a look through some
of the more useful ones added recently.

Colour Labels And
Organising

Labels and filters are a good way
to sort e-mail. To create a label, go
to Settings > Labels, give it
a name and click on Create.
Now your label will appear in a
box to the left side of the window.
Click on the blank box to the
right of the label and select a
colour to assign it to the label. 

You can set labels to your
mails manually by clicking the
checkbox for the mail and
clicking the dropdown menu for
more actions and selecting the
label of your choice. You can set

more than one label to the mail. 
Backup photo albums to a drive or even on a CD to gift
it to someone 
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Even More XP Secrets
Here are some things you thought you couldn’t do in XP

Asfaq Tapia

We won’t waste much time with this
introduction, so here it is—another

round of tips and tricks that will improve
performance, stability and sort little
annoyances in XP, among other things. 
Statutory warning: Playing with your Registry
can be injurious to your PC’s health.

System Volume Information 
If you use System Restore, you must have

noticed the System Volume Information
folders in the root of each of your drives.
This folder stores the files used by System
Restore. Their sizes can sometime balloon
to gigabytes, because System Restore
doesn’t delete your older restore points
when creating a new one. Moreover, every
time you try to access the folder, you get
the Access Denied error. Oh, and you can’t
delete the folder, either. So what do you
do when you want to view its contents? 

In an Explorer Window, go to Tools
> Folder Options > View. Here,
choose Show Hidden Files and
Folders. Uncheck Hide Protected
Operating System Files and Use
Simple File Sharing. 

You should now be able to access the
System Volume Information folder; if not,
you’ll have to add yourself to the list of
users allowed to access the folder. Right-
click on System Volume Information and
go to Properties > Security. Click
Add under Groups or User names
and enter your username in the dialog
that appears. Click OK, and in the bottom
half of the Security tab, grant yourself
all the permissions.

Sort Menus Alphabetically
Start the Registry editor: Start > Run
> regedit > [Enter]. Navigate to
HKEY_CURRENT_USER\Software\Micr
osoft\Windows\CurrentVersion\Ex
plorer\MenuOrder

Right click on the MenuOrder folder,
choose Permissions; go to Advanced
in the new window that pops up, and
uncheck the entry Inherit from
parent the permission entries
that apply to child objects.
Include these with entries
explicitly defined here. A
security dialog box will open up; choose
Copy. This will take you back to the
Advanced Security Settings for
MenuOrder dialog. Click OK here. In the
Permissions dialog, uncheck Full
Control in your account and security
groups. Don’t change the Read
permission. Reboot the computer and all
your menus will be alphabetically sorted.

Increasing Internet Bandwidth
Windows XP reserves 20 per cent of your
Internet bandwidth for Quality of Service.
This is unnecessary, and can be disabled:

Open the Group Policy Editor: Start
> Run > gpedit.msc > [Enter]

In the left-hand column in the
window, navigate to Computer
Configuration > Administrative
Templates
> Network
> QoS
Packet
Scheduler.

In the
right
column,
double-click
Limit
rese-
rvable
bandwidth
and select
Enabled. 

Change the Bandwidth Limit to 0
and click OK.

Getting Rid Of The “Unread Email
Messages” Message...
...on the Welcome Screen, that is. Here’s
how to do it:

Start the Registry Editor: Start >
Run > regedit > [Enter]

Navigate to HKEY_LOCAL_MACHINE\
SOFTWARE\Microsoft\Windows\Curr
entVersion

Right-click on the CurrentVersion
key and select New > Key. Name this
UnreadMail.

Right-click on the blank area on the
right side, and select New > DWORD
Value. Call it MessageExpiryDays
and give it a value of 0.

You may need to log off or restart for
the changes to take effect.

Modifying the “Internet” Key On
Internet Keyboards
You can change what programs you want
to launch with the Internet key:

Open the Registry Editor and navigate
to HKEY_LOCAL_MACHINE\SOFTWARE\
Microsoft\Windows\CurrentVersio
n\Explorer\AppKey\7

Right-click in the right column and
create a new String called
ShellExecute

Set the value as the application path,
for example, C:\Program
Files\Opera\Opera.exe. If you want
to disable the key, delete the value from
ShellExecute and leave it blank.

Open Explorer With A Single Pane 
When you use [Windows] + [E] to open a
Windows Explorer window, it opens in
the two-pane layout. To have it open
with a single pane by default, do
the following.

In the Registry Editor, navigate to
HKEY_CLASSES_ROOT\Folder\shell\
explore\ddeexec

Double-click on (Default) and
change the string to
[ViewFolder(“%l”, %I, %S)]
(including the brackets)

To revert to the double-pane window,
set (Default) to
[ExploreFolder(“%l”, %I, %S)]

asfaq_tapia@thinkdigit.com

Here is the error you’ll see when trying to
access the System Volume Information

The start menu gets sorted automatically, too

Increase your bandwidth by 
20 per cent
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To set up filters, go to Settings >
Filters and click on Create a New
Filter. Enter information for the
necessary criteria along with wildcards.
For example, if you want all your mails
from Orkut to be labelled, enter orkut
in the subject field. Go to the next step.
Check the box against Apply a Label
and select a label from the list. Set any
other options that you want and click
Create Filter.

Connecting To AIM Through
GMail

You can now login to your AIM or ICQ
user ID using Gmail. When you’ve logged
into Gmail, click on Options in the Chat
and click Sign into AIM. Enter your
username and password and click on
Sign in. You will be logged in, and all
your AIM contacts will be displayed along
with your Google Talk buddies with an
AIM logo on the side.

IMAP For Free!
Gmail has had POP3 for a while

now and now they’re taking it one step
further—you can now get IMAP too! IMAP
synchronises mail between the Gmail
server and your local machine or
devices. So now, you can have the same
mails on your Gmail account on the
Internet, your desktop computer, your
phone and so on, as long as the mail
client supports IMAP. Anything that you
do to your mail from any device will be
updated on the server. So if you move a
file from one folder to the other using
your phone, that change will be
reflected on Gmail and your mail client
at home.

First, enable IMAP for our account—
once you’re logged into your Gmail
account, go to Settings >
Forwarding and POP / IMAP.
Under the header IMAP Access, click
Enable IMAP and click Save
Changes. Next, set up IMAP for the mail
client. We’ll use Outlook Express since
it’s available on every Windows
machine. You can use similar steps for
any other IMAP-supporting mail client
that you may use. Create a new IMAP
account by going to Tools >
Accounts and select Add > Mail.
Enter a display name and your Gmail
address. Keep clicking Next till you
reach the Window where you need to
enter the server addresses. Select the
server type as IMAP from the drop-down.
Enter the address for incoming mail
server as imap.gmail.com and
outgoing as smtp.gmail.com. Click
Next. Enter your account name as
your_mail_id@gmail.com. Enter
your password and proceed to finish the
setup. Click on Properties for the
account you just created. Go to the
Advanced tab and enter the Outgoing

SMTP port number as 465 and incoming
as 993. Also check the boxes against
This server requires a secure
connection (SSL) for both the
incoming and outgoing ports. Before
clicking OK, go to the Servers tab and
check the box against My server
requires authentication for the
Outgoing Mail server. Click OK and click
the Send / Receive button. All the folders
on your Gmail server will be downloaded
and you can start using your IMAP
enabled GMail account.

ORKUT
We’ll be honest here—we’re not the
biggest Orkut fans, but you can’t
ignore it. With a Firefox add-on called
Greasemonkey, you can enhance your
Orkut-ing experience quite a bit.

Scripts for Firefox
Other than the general JavaScript

tricks that work on any browser, there
are some that work on Greasemonkey.
Greasemonkey is an add-on for Firefox
that allows you to run scripts that can
modify the characteristics of a page.

You can get information on
Greasemonkey from www.greasespot.
net. Download Greasemonkey from
there. Once you’ve installed the add-on,
restart Firefox.

Widescreen Orkut-ing
Widescreen LCDs are great for

gaming and for watching movies. It
turns out Orkut on widescreen is
pretty useful as well.

There’s a Greasemonkey script
which stretches Orkut pages so you see
a lot more and have far less vertical
scrolling to do.

When you have Greasemonkey
setup right, visit
http://userscripts.org/scripts/
source/12286.user.js. A window should
pop up to confirm the adding of the
script. Click Install. Orkut pages
will now be stretched to the width of
the window. 

Add A Formatting Bar
When it’s time to scrap your buddy

back and you want to keep things a little
colourful, you’re busy looking for the
formatting tools like in any other forum.
Orkut’s formatting tools can be accessed
by clicking the scrap tips link next to
the text entry box. There’s also a
Greasemonkey script that will make the
formatting tools show up right on top of
the text box. Download it from
http://userscripts.org/scripts/source/12841
.user.js. 

Adding a Talk gadget in Orkut
We’ve shown you how to use

Google Talk in your browser before, but
now you can go crazy chatting with
your buddies through Orkut itself.
Download this script:
http://userscripts.org/scripts/
source/12532.user.js. Go back to your
Orkut home page and you’ll see a
Google Talk addon above your friends
list. Click Show GTalk to show the
application.

Keyboard Shortcuts For Orkut
With the power of Greasemonkey

and its scripts, you can now use shortcuts
to quickly jump from your scrapbook to
your home page, for example. Download
the script from http://userscripts.org/
scripts/source/12784.user.js and then use
the shortcuts given below.

Home: [Ctrl] + [Shift] + [H]
Scrapbook: [Ctrl] + [Shift] + [S]
Friends list: [Ctrl] + [Shift] + [F]
Communities: [Ctrl] + [Shift] + [C]

Hiding Your Content
Google’s stepped up their effort to

make Orkut a little more private by

Greasemonkey can be used to add and modify
features in a page

Privacy has been implemented in Orkut

The lack of visible formatting tools can be
fixed by using a Greasemonkey script
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To The Rescue
Use Norton Ghost to keep your data safe from untoward incidents

Samir Makwana

Norton Ghost may cost a bit, but it’s a
brilliant solution to take backups

and images of your data. You can find the
trial version on this month’s DVD. 

The Basics
When you run the program for the
first time, you’ll be asked to select a
backup destination. Choose any healthy
drive or partition except for C:, or

better yet, an external hard disk. After
setting the backup destination, define
the source—choose Run or Manage
Backups under the Tasks menu or
the main screen. Ghost lets you back
up selected files and folders, or entire
drives. Drive backups are called
Recovery Points, and are saved with the
.v2i, .iv2i or .pqi extensions. The new
version of Ghost lets you create drive
images as well as file and folder
backups (the older versions were only
drive imaging utilities), so it’s a
complete backup solution. 

To define a backup, open the
Tasks tab in Ghost and choose Run
or Manage Backups. To back up
everything on your computer, select
Back Up My Computer. The Back
Up My Documents option will allow

back up your My
Documents folder, in
addition to file types
like music, movies and
so on. To change the
drives you want to back
up (or files in the latter
case), click on the drive
letter (or folder name)
in the dialog. 

The recovery points
you create can be copied
to CD DVD under Tools
> Copy Recovery
Point. 

Browsing A Recovery Point 
Once you’ve made a recovery point of a
partition or on your hard drive, you can
browse through the files as they were
at the time of the backup, and even
restore individual files instead of
restoring the entire recovery point. Go

to Tools > Recovery Point
Browser and open the Recovery
Point you want to browse through.
To restore an old version of a file,
right-click on it and choose
Recover.

You can also browse the
recovery point in Windows
Explorer by mounting it as a
separate drive. In the Recovery
Point Browser, select the
Recovery Point and click Mount.
Alternatively, you can use
Windows Explorer to browse to
the Recovery Point, right-click on
it and choose Mount. You’ll be

asked to give it a drive letter, and you’ll
be able to browse through it like you
would any other partition on your PC.
Any changes you make to the mounted
image will go away once you un-mount
the recovery point.

Unattended Backups And Restores
You can schedule incremental backups
under the Status menu by editing the
calendar. Right-click on the calendar
and choose Define New Backup. To
backup computers on the network, go
to Computers > Add and add the IP
address of the computer you want to
back up. Once it’s connected, you can
create recovery points, schedule, and
even restore backups on the computers
in the list.

Helpful Tools
Backups can be taxing on your system;
you can set a
default
performance
level for
backups in
Tasks >
Options >
Performance. 

You can
also set
security
options while
setting up a
backup under
the
Advanced
tab. You’ll get
different encryption options to password-
protect (the character limit depends on
the encryption level) the backup files.

Pay!
When you pay and obtain the full

version of Ghost, you get the
ability to convert recovery
points to VMware virtual disks,
and the ability to copy one
hard disk to another. Existing
recovery points can be
converted to the VMWare
virtual disk format for use as a
virtual OS. Go to Tools >
Convert to Virtual Disk.
To make a copy of your hard
drive, go to Tools > Copy My
Hard Drive.

samir_makwana@thinkdigit.com

A good backup strategy is always important

Specify critical files and folders for backing up

Timely backups can bring about peace of mind!

Backups stay secured by
setting password-protected
encryption 
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allowing you to hide parts of your
content. As usual, you can find these
permissions under Settings >
Privacy. There have been some new
options added here. Items like photos,
videos, feeds and testimonials can now
be made viewable only to your friends.

There’s also an option to disable
your Orkut profile from appearing in
Google’s search results! Click on the
hide information radio button and click
save changes when done.

COMODO FIREWALL
PRO 3.0

The “Pro” in Comodo Firewall Pro
might imply an expensive
commercial firewall, but it’s

available free on their site—
http://personalfirewall.comodo.com and
our CD every month. It’s no half-complete
software either—it’s loaded with features
and plenty of options to play around with. 

While installing the firewall, be sure
to choose Advanced Firewall with
Defense+, which gives you more alerts
and a few more advanced features. 

View Current Connections
Ever wonder which process is

hogging all your bandwidth? Comodo
Firewall has a feature that allows you

to view all the connections going from
your PC to the network or Internet and
vice versa. Click on the Firewall icon on
the top of the window and select View
Active Connections.

Here you can see all details such as
local and destination ports and IP
addresses. You can even force-close a
connection by right clicking on it and
choosing Terminate Connection.

Disable Popup Alerts
With the Defense+ feature enabled,

the pop-ups you’ll receive will be more
than your patience can handle. You’ll get
an alert for everything from connection
alerts to programs accessing other
programs. Right-click on the Comodo

Firewall icon in the system tray and un-
check Display Balloon Messages.
Click Apply.

However, if you don’t want Comodo
Firewall to monitor everything, click on
Defense+ and then on the Advanced
tab on the left. Click on Defense+
Settings. Select Monitor Settings
and then uncheck the activities you
don’t want monitored. Click Apply.

Quarantining Processes And
Programs

Similar to looking for connections made
by programs to and from the Internet,
Defense+ allows you to look for
programs and processes currently active.
Like in the Task Manager, you can
terminate programs or quarantine them
and move them to a safe folder. This is
useful to isolate suspicious programs—
which might be worms or viruses—on
the computer.

Click on Defense+ from the top
bar. Select View Active Process
List. Here you can right-click on any
process and click Terminate (or
Terminate And Quarantine to
terminate and move the program into
quarantine).

Blocking Networks And
Machines

To block IP addresses or entire
networks, go to Firewall > My
Blocked Network Zones. Select
Add > A New Blocked Address…
Here, you can choose to block IP
addresses or range of IPs or even MAC
address. Add the required information
and then click Apply.

Policies For Software
Policies aren’t limited to the

network in Comodo Firewall—you can
create policies for all kinds of software
running on your OS as well. You can

also create your own custom policies for
programs. Go to Defense+ >
Advanced tab. Select Predefined
Security Policies to view existing
policies and to add new ones. You can
change the existing policies by clicking
on any one, then clicking Edit and
choosing Access Rights or
Protection Settings.

To create a new policy, click on Add,
and set permissions and access rights in

the same manner. To set this policy to
an application, click on Computer
Security Policy. Select the
application you want to set the policy
for and click on Edit.

Check the Use a Predefined
Policy radio button and then select
your custom policy from the drop-down
menu next to it.

Parental Control
Now that you have your firewall

set up and restrictions in place, you
wouldn’t want other users to alter the
settings all the time. This is done by
enabling the parental control. Go to
Miscellane-ous > Settings. Click
the Parental Control tab and check
the box to enable password protection
for the settings you’ve made. Click
Change Password to set a password.  

Submitting Suspicious Files
Every once in a while, you come

across a worm or virus that your anti-
virus program can’t clean or even
detect. At such times, use the file
submission feature to send the file
across to Comodo’s developers. Comodo
Firewall allows you to upload the files
to them so they can analyse and create a
possible fix for it. Under Miscellan-
eous, select Submit Suspicious
Files. Click on Add to add files. Add a
description and mail ID if required.

Importing And Exporting
Settings

Once you’re
done
setting up
and
tweaking
Comodo
the way you
need it, you
want to be
able to store
and load
the settings
for future
use. You
can create
profiles and
switch to
any of them
whenever
you want.
Go to
Miscellan-
eous and
then on Manage My Configurat-
ions. Click on Export to export your
settings. Give a name and save the file.
To import a saved configuration, go to
Import > Import and select the file
you saved. Now you can switch between
profiles by clicking on Select and
check from one of the profile.

Setting policies and then applying them to
programs

You’ll find several types of predefined policies

Never lose your settings: you
can save them!



Machine Language
Whenever I restart my Windows XP
computer, I get this error message: “Stop

0xC000021A”.
Bhavesh Shah

This happens if the Wbemprox.dll library is
prematurely unloaded. You need to down-

load and install the hotfix from
http://go.microsoft.com/?linkid=6294451
(http://tinyurl.com/34jrgl). Restart your
computer and you should find it’s OK.

Unpacking The Service!
I recently installed SP1 on Windows XP and
then used System Restore to revert Windows

to the previous state. I am now not able to create
a network connection.

Ram Kapadia

If you reinstall SP1, the problem will be
solved, but if for some reason you don’t

want to install SP1, there is a workaround.
Open the Registry Editor and go to
HKEY_LOCAL_MACHINE\SYSTEM\CurrentCon
trolSet\Services\RasMan. Select File >
Export, type EXPKEY in the File Name box,
and click Save. Double-click on the
ObjectName String Value in the RasMan key,
type LocalSystem in the Value Data box, and
click OK. Go to HKEY_LOCAL_MACHINE\
SYSTEM\CurrentControlSet\Services\Ra
sMan\PPP\EAP\25 and delete the key. (Click
Yes to confirm.) Do the same with
HKEY_LOCAL_MACHINE\SYSTEM\CurrentCon
trolSet\Services\RasMan\PPP\EAP\26.
Restart your computer. You should now be
able to create a network connection.

Beep No More!
I want to turn off system beeps, but I don’t
want this to affect any other audio settings on

my computer.
S Gopal

To disable system beeps, open the
Registry Editor and go to

HKEY_CURRENT_USER\Control Panel\
Sound. Modify or create the String Value
Beeps in the right pane and set its value to 0.
Restart for the setting to take effect.

So It’s A Coaster...
Whenever I try to install ASHAMPOO WIN
OPTIMIZER 2007 from the Digit CD, it shows

the following error message: “An I/O error
occurred while installing a file.” When I abort it,
a message says “corrupt installation file.” How
do I install it?

Sunney

Like the error message says, this happens
when the installer file is corrupt or

damaged, and that often happens often when
the media itself is damaged.

Please e-mail help@jasubhai.com for a
replacement.

Slo-Mo
I have an Athlon XP 3000+, an ASUS V82-m
motherboard, and 512 MB of RAM. My problem

is that Quake 3 runs very slowly.
Shakti Dash

Check whether the latest ForceWare drivers
are installed; they are available at

www.nvidia.com.
Also, try playing the game at lower resolu-

tions and turn down the effects.
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Poof!
My computer suddenly shuts down after a
few minutes of activity. My service engineer

checked everything including the heatsink and
fans, but found nothing wrong. He replaced a few
capacitors on the motherboard, but the problem
persists.

J Ramesh

Since you’ve already gotten everything
checked, our guess is that your power

supply is at fault—either it is not able to deliver
enough power to your PC, or there is some
other problem with it. Get it examined and
possibly replaced. You could go through our
December issue for an idea about what kind of
PSU you need.

Playing With Partitions
I am aware that there is a partition resizing util-
ity in Vista, and I want to try it out, but I’m a

little afraid because of the risks involved. Please tell
me what I need to know.

Ankit Pathak

The Disk Management Utility in Vista is an
upgrade over that in XP; it can resize disk

volumes (partitions). Before getting into it, do
back up all your data, because although it can
resize partitions keeping the data intact, there is
always the risk of data loss in the case of a sudden
interruption (such as a power failure).

Open the Control Panel and type Partition
in the search box. Click on Administrative
Tools: Create and format hard disk partitions.
To shrink a volume, right-click on the parti-
tion to be shrunk (in Disk Management) and
select Shrink Volume. You will be able to see
the current size, space available to shrink, a
dialog box to enter the amount to shrink by,
and the volume size after shrinking. Enter
the amount to shrink (in MB) and click
Shrink. Similarly, to extend a volume

(increase the size), right-click on the partition
and select Extend Volume; the Extend
Volume Wizard will start. Here, you can spec-
ify the amount that you want to increase the
partition by. Click Next, then on Finish to
start the process.

It’s Just The Drivers
I’m having a problem with the game Gangland.
I’ve played the demo earlier, but now the full

version I bought gives this error:
===== Console::Initialize() =====
Compiled Sep 27 2005 10:58:36

(release build) 
Renderer rejected: RendererD3D.DLL
Renderer found: RendererOGL v. 1.3

(release build)
RendererOGL::GLInitialize(): Using

Microsoft Corporation GDI Generic
RendererOGL::GLInitialize(): OpenGL

version 1.1.0
RendererOGL::GLInitialize(): Card

doesn’t support
GL_EXT_texture_compression_s3tc

Error creating renderer instance
What should I do? I’m using an ASUS V9400

Magic graphics card.
Vijesh Vijayan

Your graphics card is based on the NVIDIA
GeForce4 MX 4000 chipset. The error

message indicates that your OpenGL renderer
does not support S3TC (S3 Texture
Compression). The error message also indi-
cates that the game is trying to use the graph-
ics renderer from Microsoft and not from
NVIDIA, so your OpenGL file could be corrupt,
or there could be a problem with your graph-
ics drivers. Since your graphics card supports
S3TC, we suggest you install the latest refer-
ence drivers for your card from
www.nvidia.com. Your problem should be
solved now.

Back From The Future
I upgraded from XP to Vista and I want to get
back to XP. How can I do it without losing any of

my program settings?
Manu Shastry

Currently, it is not possible to downgrade
from Vista to XP and retain all program

settings. You would have to do a clean format
of the partition and install XP. We’d advise our
readers to dual-boot between Vista and XP
(instead of upgrading) if they just want to get
a taste of the new OS. Assuming Vista is
installed on a partition different from where
XP is installed, do the following to uninstall it.
Boot into XP. Insert your Vista DVD into the
drive or load the image in DVD emulation soft-
ware. Run X:\boot\bootsect.exe /nt52
ALL /force where X is your Vista DVD drive
letter. Restart the computer and you will find
that the old XP boot menu has returned.
Format the partition where you’d installed
Vista, and remove Boot.BAK and Bootsect.BAK.
That’s it!

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Mode Mess
My Sony DRU-820A DVD-Writer takes almost an hour to
copy a DVD. What could be the problem?

Bhuvnesh Agrawal

The data transfer mode of the DVD-Writer is probably
set to PIO, which is a lower-speed mode than the DMA

mode it should run at. To check this, open the Device
Manager by running devmgmt.msc, expand IDE/ATAPI
controllers, double-click Primary IDE Channel, and click
on Advanced Settings. Set the Transfer Mode to “DMA if
available”, click OK, and restart the computer. If that does-
n’t help, you might need to delete that channel and restart
the computer to re-detect the hardware. You might also
need to repeat this with the Secondary IDE Channel if
your drive is not listed. If nothing happens after restart-
ing, you should uninstall the IDE channel from the device
manager and restart the computer so it can re-detect
everything on that channel. Your drive will now work in
DMA mode and its transfer speed will improve.

If it doesn’t, try changing the IDE cable. You might
need to replace the drive if none of the above helps.

Errors like these occur when installer files are corrupt

Make
sure the
IDE
Channel is
set to
“DMA if
available”

Question 

of the

Month

All your computing niggles and nags
are dealt with here!

Your Questions, Our Answers
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It Won’t Work...
I recently got myself a Tata Indicom Walky
phone with a cable to connect it to the PC. I

configured everything as told, but cannot connect to
the Internet. When I try to view the modem diagnos-
tics, I get an error.

Rajnish Mathur

Your PC is not able to communicate with
the modem in your phone. Check in the

Phone and Modem Options in the Control
Panel to see if you’ve installed a generic 33.6
Kbps model rather than a 56 Kbps modem.
Access the modem properties and enter the
initialisation settings as AT+CRM=1. This is
assuming you’ve created the dial-up connec-
tion and are dialling the number “#777”. The
username and password are to be entered as
“internet”. In the phone, using the menu, you
can access the modem settings; select the
modem speed as 115 Kbps. You should now be
able to connect.

Game Over—For Now
I have an Intel 915GAV chipset motherboard.
When I start playing The Sims 2, I get the

error message “ialmrnt5 display driver has
stopped working normally”, and I have to reboot
the computer.

Eklavya Ashar

This error is due to a bug in the Intel
graphics driver. Install the latest drivers

from downloadcenter.intel.com. If you still get
the error, right-click on the The Sims 2 icon,
select Properties, and add the switch -w to
the end of the target field so it looks some-
thing like “C:\Program Files\EA
GAMES\The Sims 2\TSBin\Sims2.exe” -w.
(The actual path may vary depending on where
the game’s been installed)

Direct Connect
I have a cable internet connection that
requires me to dial using PPPoE. I recently

installed a 4-port router and configured it to dial
directly to my ISP. The problem is that it is not
able to connect despite my having correctly
configured the router to use PPPoE and entering
the correct username and password.

M Krishnamurthy

It looks like your ISP has locked your
account to the MAC address of your

network card, so you can only dial through that
card. First, find the MAC address of your
network card by typing ipconfig /all in a
command prompt window. Copy that MAC
address. Launch the administration page of
your router and search for the option to set the
WAN MAC address (sometimes referred to as
“WAN MAC Address Cloning”). Enter the MAC
address of your network card here and save the
settings. This will set the MAC address of your
router to the same as that of your network card,
and it will seem to your ISP’s server that the
number is being dialled through your network
card. You will then be able to connect to the
Internet via the router.

Dead On Install!
I tried to install the
Adobe GoLive! Tryout

and Adobe Illustrator Tryout
from one of your DVDs. They
got installed, but when I try
to run them, I get a message
saying the products have
expired, even though I’ve
never installed them before.

Sabyasachi Sadhu

Some software can
work in the demo

version mode only for a
limited period of time (like
three months) from the
date of release. Usually,
after this period, a newer
trial or demo version of the
software is released. Get it
from www.adobe.com.

Wired—But Not Quite
I own a cyber-café with five computers
running XP connected to an 8-port switch

and one server. I am not able to access any of the
five computers from any one of them. I can still
ping them one from the another. What could the
problem be?

Abhishek Gupta

This often happens when File and Printer
Sharing is disabled or if the Guest

account is disabled. Open Network
Connections, right-click on the network
connection being used, and click Properties.
Make sure the box next to File and Printer
Sharing for Microsoft Networks is checked.
Click OK.

You might be prompted to reboot the
computer—do so. Open User Accounts in
Control Panel and click Guests. In the next
window, click on Turn On the Guest Account.
This should solve the problem.

Cyber-Empty-Space
I can connect to the Internet but I can’t open
any Web sites on my Windows 98 SE PC.

Sunil Bihari

Ping any site—ping www.yahoo.com in a
command prompt—and if you get a reply,

your browser is corrupt, and reinstalling it is
the solution.

If you do not get a reply, run winipcfg.
Click on the More Info button and verify that a
DNS is specified. If the DNS is blank or 0.0.0.0,
the computer is not being assigned a DNS
address.

Close winipcfg. Disconnect from the
Internet. Double-click on Network in the
Control Panel, highlight TCP/IP > Dial-Up
Adapter, and click Properties. Click on the
DNS Configuration tab and verify that
Disable DNS is selected.

If this was already selected, then contact
your ISP to verify if any DNS settings need to
be set up. 
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Enable File and Printer sharing

Jayesh Limaye

Fact of life: when hard drives
crash, they usually do so without
warning. What results is a

headache and, more importantly,
heartache. But the data is usually not
wiped clean from the crashed hard
drive; rather, the file allocation
table—which contains filenames and
points to data on the drive—is what
usually gets damaged. It is therefore
technically possible to recover data in
such situations; you only need to
know the tools of the trade. The tool
we’re talking about is PC Inspector
File Recovery—a freeware that can be
downloaded from www.pcinspector.de/
file_recovery/UK/welcome.htm.

If you’ve lost data on a partition
on a drive other than C, just install
the program in Windows. If your
entire hard drive has crashed and
you’re unable to boot, install the
program on another computer and
attach your hard drive as a secondary
drive on that computer.

Launch The Program
Launch PC Inspector File
Recovery, choose English as
your language, and click

on the green tick button. Choose what
kind of data you wish to recover by
clicking on one of the three buttons to
the left. If you choose Lost Data, go

directly to Step 6; if you choose lost
drive, go directly to Step 8. If it is
deleted data that you wish to recover,
click on the icon at the top left.

Select The Drive
The program will scan
your hard drive for some
time for available parti-

tions, after which it will display them.
You will most likely be able to select
the drive from the Logical Drives tab. It
may sometimes be listed twice; select
the entry containing the drive’s letter.

To verify the drive’s content, click the
Preview button. Click on the tick
button to continue to the next step.

Sniffing Out Deleted Files
The selected drive will now
be scanned; this may take a
few minutes. A Deleted

folder will be displayed (with the
Recycle Bin icon). You need to go
through this folder to locate the files
you wish to recover. You might find
that the original filename has not been
preserved. You can opt to search for the
file in the following way: choose
Object > Find, enter the file type,
and click on the green tick to search.

Recovering The File
A list of matching files will
appear after the search
process ends. If the file

you’re searching for does not appear,
you can use the Size and Date Modified
columns to help identify it (assuming
you know these details). Click on the
top of these columns to arrange them
accordingly, to make it easier to locate
the file. Select the possible candidates
by keeping on clicking on them while
keeping [Ctrl] pressed. Keeping
[Ctrl] pressed, right-click on them
and choose Save to. Choose a location.

Check And Rename
After they are restored,
you should try to open the
files to see if they are

indeed the files you were looking for.
After confirming this, you can
rename them to what they were and
copy them to the original location
later. If the files are not the ones you
were searching for, return to PC
Inspector File Recovery and try to
search for them again.

Find Your Lost Data
Sometimes data is lost due
to a quick format or due
to system or program

crash. In such cases, you should
choose the Lost Data button (the
middle button on the left) in the
main screen of PC Inspector File
Recovery. In this case, data is
retrieved in a way similar to deleted
files. Select the drive from the
Logical Drives list and click on the
tick button when the Select Cluster
Range dialog appears. The process of
identification of files to be retrieved
begins; this will take some time.

Retrieve The Lost Data
You will see that PC
Inspector File Recovery
has found hundreds of

“lost” files—many will be fragments.
It will take quite a bit of your time to
go through them all, but it is worth-
while because you have a chance of
getting back precious files. Repeat
steps 3 to 5 to find your file and
check its integrity.

Find The Lost Drive
If your partition table has
been damaged, you may
no longer be able to view

any drive from the affected hard
drive in the Logical Drives list. You’ll
have to manually search for it. Click
on the Physical drive tab from the
Select Drive dialog, and select your
hard drive—usually named fixed disk
#1. Click on Find logical drives.

Search Within Clusters
You can choose to scan
the entire drive for lost
drives, or if you have
some idea about where

the partition was physically located
on the disk, you can move the sliders
to concentrate the search on that
particular area. Now click on the tick
button and wait for the search to
complete, after which you can select
the logical drive to recover your files
and folders (as explained in the
previous steps).

jayesh_limaye@thinkdigit.com

Launch PC inspector File Recovery

Recover Data From 
A Crashed Hard Drive
Recover Data From 
A Crashed Hard Drive

Scanning for lost data

Select the drive form which to recover data

1STEP

2STEP

3STEP

4STEP

5STEP

8STEP

9STEP

6STEP

7STEP

Here’s a crash course on recovering data from a crashed hard drive!
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Not Quite Prime Time
panel. It costs 4,200 rupees, and the TV Dongle
will be very suitable for laptop users due to its
size. The guy told me he could arrange for a
Hauppauge Win TV-PVR-150 for Rs 5,100. This
card has all the features you’d need in order to
set up a Media Center PC.

Incidentally, the Win TV-PVR-150 is digital.
I was impressed by this guy’s contacts, because
I remember wanting to buy a Hauppauge TV-
Tuner myself a few months ago—and having
given up either because people couldn’t get it,
or were pricing it exorbitantly. We also saw a
Compro VideoMate Gold Plus M500, costing
Rs 2,200. This is an older model from Compro,
proved by the bundle, which although rich,
contains software versions older than what’s
currently available. The evergreen Compro
VideoMate Gold was also on display: Rs 4,500.
This is a full-size PCI card. Once again, it’s a
previous-generation product. It seems the
latest Compro cards haven’t reached Lam-
ington Road yet.

Decision time for my friend. I had filled him
in earlier on the CAS (Conditional Access
System) issue doing the rounds. CAS will mean
encrypted channels, which a regular satellite
dish cannot receive. It will ultimately prevent
exploitation of consumers by TV operators who
have been hiking prices for no rhyme or reason.
CAS will mean investing in a set-top box and
subscribing to individual channels, or a
“package” of channels. For those who aren’t
aware, once conditional access comes into force,
TV-Tuners without digital connectivity won’t

function properly, because set-top boxes
use a digital cable. Your TV-Tuner

will therefore only receive any
analogue channels if

they’re still being
transmitted. Need-

less to say, your TV-Tuner remote
will also cease to function. You’ll
control channels with the remote
of the set-top box instead.

Considering that digital TV-
Tuners are costlier than their ana-

logue counterparts, and that my
friend wasn’t willing to upsize his

budget, we decided to wait a bit before
investing in a TV-Tuner. Sure, the dig-
ital ones won’t really be affected by the
CAS decision, but my friend wasn’t
willing to splurge. All considered, we
decided to sit this one out a bit till
things become clearer. 

I’ve a good friend who recently moved to
Mumbai. Being an IT guy, he’d brought along
his PC and set it up here. He isn’t a gamer like

me, so he gets his kicks elsewhere. I’m not
talking booze and discos—nothing so dramatic—
he’s a TV buff, and would spend his weekends
back home glued to Star World.

One of his first purchases in Mumbai, there-
fore, was a TV… no surprises there. Problem is,
he isn’t at home most of the time, so he decided
to opt for a TV-Tuner card or box to record his
favourite serials, the ones he just couldn’t miss.
But after investing in a mammoth 500 GB hard
drive (and the TV of course), he could only spend
3,000 bucks for a TV-Tuner. Naturally, we ended
up at Lamington Road rather early in the day...

Unfortunately, I’d miscalculated, and very
few shops were open upon our arrival. Well, even
Agents trip up! A couple of Cokes later, we found
shutters starting to open. The first shopkeeper
greeted us with a toothy smile. Ahh, the joy of
being first customers…

The smile done, he went on to show us a Pin-
nacle PCTV 50e (Rs 4,250). It’s a rather bland-
looking external TV-Tuner that can record
directly to DivX. We were also shown a Dazzle
internal TV-Tuner for Rs 1,400; however, the box
didn’t have any specific model number; there
was just “Dazzle PCI TV Tuner”.

Dealer #2 showed us a couple of Leadtek TV-
Tuners. One was an ultra-compact WinFast
PalmTop TV, a cute, orange-coloured tuner box.
The PalmTop TV has a host of powerful features
including seamless playback for multiple video
and audio files. It was priced at Rs 4,000. Next,
we saw a Leadtek DTV 2000H. This PCI model is
digital, and sports a host of features. The retail
cost of the bundled software is more than that
of the card itself! You can also directly burn pro-
grammes to DVDs. It costs Rs 4,600, but the DTV
2000H supports HD output as well.

Variety being the spice of life, it
was on to dealer #3. Before entering
the shop, my friend informed me
that he would prefer an internal
card, citing desk space as the reason.
We came across a Leadtek
WinFast TV Dongle. It was
ultra-compact, a little larger
than a pen drive. The volu-
minous feature set will go
down real easy, especially
when you consider its
diminutive size. In fact, this
miniature TV-Tuner doesn’t
give up any features to its much larger
brethren. The remote control unit, while
feature-rich, does look bland with its array
of similar buttons—like some sort of control

Agent 001

Now isn’t the best time to go around looking for TV-Tuners—thus spake Agent 001

DIGIT JANUARY 2008

Want more of Agent 001? Turn over to read his
answers to your buying questions

Shrikrishna Patkar
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Luxury!

I want to buy an LCD TV for my room. The viewing
distance will be 8-10 feet. Could you suggest which

brand and size of LCD to buy? My budget is between Rs
75,000 and Rs 1,00,000 for a 32-inch (or above) TV. I’d
also like to know the significance of features like
Dynamic Contrast Ratio and Full HD.

Amit Jain

Dynamic Contrast Ratio (DCR) refers to the
ratio of luminosity of the brightest and

darkest colors that a display can produce over
time. Static Contrast Ratio (SCR) measures the
luminosity values simultaneously, i.e., without
the time factor. Values for DCR will be typically
higher than those for SCR because DCR simply
cancels the effect of the room, causing equal
amounts of light to reflect from the display to the
room and forth. Therefore DCR values are
inflated, and an LCD with an SCR of 3000:1 will
outperform an LCD with a DCR of 3000:1. 

Full HD simply means HD viewing at its
highest possible resolution, i.e., 1080p. This
equates to a progressive scanned display con-
sisting of 1920 x 1080 pixels. The next-best thing
would be 1080i, i.e., 1920 x 1080 pixels interlaced. 

Samsung has some real beauties in their LCD
TV range. The Bordeaux series, for one, proves that
beauty isn’t always skin-deep. I liked the body
shape of the series; build quality is also right up
there. Choose between two colours—the
LA32R71W (white) and the LA32R71B (black). Both
cost around Rs 70,000 (Mumbai street price).

Money Matters
I want to upgrade from my W550i SE to a new
handset. I have zeroed in on the K790i SE for its

3.2MP camera and the loads of other features. Any
other suggestions for the same price and features?

Vikas Maurya

You seem to primarily want a good camera
phone. The Nokia N73 also has a 3.2MP

camera, and even outperforms the K790i when it
comes to camera quality. Needless to say, the N73
is feature-rich, with greater application support,
mainly due to its Symbian platform. Another
advantage is a better screen (320 x 240). Music
playback quality is around the same. The only
deterrent for you as far as I can see is the fact that
the N73 will cost at least three thousand rupees
more, going by today’s street prices. If you’re
willing to upsize your budget, go with the N73,
else stick with the K790i.

C2D All The Way!
I am assembling a PC for animation work with
some gaming on the side. I am confused between

two processors: the Pentium 630 and the Pentium D
820. Which would perform better? Could you also sug-
gest a suitable motherboard?

Ganesh Badgujar

Between the two processors you’ve men-
tioned, a Pentium D 820 would perform

better on multithreaded applications or while
multitasking, simply because it’s a dual-core.

Since you seem to be going in for a brand new
system, I’d suggest you scrap both these and invest
in a Core 2 Duo instead. The E6300 (1.86 GHz)
would easily outperform both the processors you
mentioned while costing just a couple of thou-
sand bucks more. A good motherboard to pair a
Core 2 Duo with is the MSI 965P Platinum.

PSU Pointers
I use a 300-watt SMPS and am planning to
upgrade to a 400-watt model, because I’m plan-

ning on attaching another hard drive and CD drive
soon. Will a higher power supply overload my mother-
board? Which brand should I look at?

Tushar Mathur

Using a higher-rated power supply will not
damage your motherboard in any way. The

processor, motherboard, graphics card, memory,
and other peripherals only draw as much power
as they need. People use higher-rated power sup-
plies simply because power supplies perform opti-
mally when they are under a maximum load of 60
per cent, so a 500-watt power supply will perform
optimally if the load is not more than 300 watts.
This is also because most manufacturers state
inflated output figures. Some 400-watt power sup-
plies may actually be capable of only 300 watts. 

VIP is a good brand, known for their reliable
power supplies. I’d suggest a 400-watt VIP PSU.

Wanted: A Box And A Screen
I have decided on the following configuration (pri-
marily for gaming):

NVIDIA nForce 680i motherboard, Intel Core 2 duo
E6600, Samsung SP2504C 250GB SATA 2 HDD, 2 x 512
MB DDR2 @ 667 MHz, XFX-PV-T73G-UDL7 (NVIDIA
7600GT), iBall Power Key Designer, Lite-On DVD-Writer

Please comment. I need help choosing a cabinet,
power supply, and a 19-inch LCD monitor. My budget
for the cabinet and PSU is Rs 4,000, and for the mon-
itor, Rs 14,000.

Vamsi N

Some pretty good choices there. Since it’s
going to be a gaming rig, I’d suggest a

high-end graphics card. I’d recommend a
7900GTO or an X1900XT. If you can spend Rs
27,000 on graphics alone, the BIG 8800GTS is avail-
able, which is a future-proof option. If budget
becomes a problem, I’d suggest an E6300 in lieu
of the E6600—game performance won’t be
affected much. If you don’t plan to SLI, you can
consider a motherboard based on Intel’s P965
chipset. I recommend the MSI P965 Platinum.

Games benefit from more memory. I suggest 2
GB of RAM—two sticks of 1 GB each; make sure to
use them in dual-channel mode. 

For the kind of power your system will need, I
don’t think you should cost-cut on the PSU. Invest
in a VIP 500-watt supply at the least. You could also
consider Cooler Master’s 600-watt Extreme Power
series. The Zebronics Peace is a good cabinet; its
flashy, functional, and won’t cost a bomb. 

19-inch widescreens are the in-thing today. Go
with a Samsung 940BW. It’s the best monitor for
its price, period. 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related
questions in this space.

Ask Away!

Ask Agent 001
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Asfaq Tapia

As the field of Biotechnology began
to grow after 2001, it became
increasingly clear that computers

would play a big role in the future of com-
mercial biology. Over the years, computers
have played their part in decoding the
human genome, drug and vaccine design,
determining the bio-molecular structure
of cells, and studying cell metabolism,
among other things. This gradually
evolved into a specialised industry called
Bioinformatics. 

Bioinformatics can, in simple terms,
be defined as an interdisciplinary area
involving biological, computer, and infor-
mation sciences to manage, process, and
understand large amounts of data, for
instance from the sequencing of the
human genome, or from large databases
containing information gathered from
plants and animals for use in discovering
and developing new drugs. Mutation sim-
ulations and modelling of bio-molecules
and biological systems is also done using
the data. (Unfamiliar terms are explained
in the box Indicative Terms, which might
give you a flavour for what one deals with
in this discipline.)

According to the Confederation of
Indian Industries (CII), the Bioinformatics
industry is still in its nascent stages, and is
set to grow to $25 billion (Rs 1,00,000 crore)
by 2011. Among other significant develop-
ments in the sector, the government of Kar-
nataka along with ICICI invested, in 2001,
Rs 5 crore to develop the Institute of Bioin-

formatics and Applied Biotechnology (IBAB)
in Bangalore, to offer diploma courses and
short-term training in bioinformatics and
biotechnology.

The Bioinformatics industry today is
heavily dependant on researchers who are
able to work with custom software that
involves data mining (sifting through
large volumes of data to look for patterns
and trends), downstream processing
(referring to the separation or purification
of biological products), and model
analysis. Researchers comfortable with
using Virtual Reality tools are also much
sought-after in drug design and unicel-
lular organism design.

This could be the industry for you if
you are excited by the prospect of coming
up with new cures for diseases,
unlocking the secrets of life, and so on...
and as you can expect, work here is
highly research-oriented.

A Preview Of The Industry
You’ll generally find bioinformatics
applied in three broad cases: pharma-
ceutical companies that have a bioinfor-
matics division; IT companies that have a
bioinformatics wing—a small team
working on specialised in-house projects
for better data retrieval techniques; and
companies that offer bioinformatics solu-
tions to pharmaceutical companies.
These range from research institutions,
pharmaceutical companies, and chem-
ical industries to the agriculture and
allied industries. These companies
recruit the bulk of the bioinformatics
professionals today.

Tech Careers

Shrikrishna Patkar
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An offshoot of the Biotechnology industry, Bioinformatics is gathering pace like never before. It is
still a niche industry, though
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tion of Senior Research Fellow. In this role, you
would be in charge of suggesting the tests and
research paths to follow in order to reach the
goals of the project. For example: a project
related to the design and analysis of DNA
microarrays, with the goal being to extend an
existing Java application that models, say, 
the behaviour of synthetic DNA under certain
circumstances.

Most biotechnology companies in India
today work on techniques involving docking,
modelling, sequence analysis, and advanced bio-
statistics. You can also branch out to being a
Quality and Data Analyst, in charge of over-
seeing the data generated by the various tests
and validating their authenticity.

After another three to four years of experi-
ence, you could qualify to be a Head Researcher—
in charge of providing inputs to the project in
your field of specialisation. After two years, you
could aim to become Project Head. This role
would require you to have in-depth knowledge
in your field of specialisation, and thorough
experience on the software tools used in the
bioinformatics industry; you would be expected
to lead—and define a roadmap for—a project that
falls within the scope of sequence assembly, data-
base design and maintenance, sequence analysis,
and Proteomics.

The table overleaf lists the educational back-
ground required for each position in the
industry, with an estimate of the remuneration
one could expect.

Parting Notes
The bioinformatics industry will continue to
evolve into a highly specialised sector that will
service biotechnology companies. Solutions
developed will help researchers sort and retrieve
data more effectively. For the industry to grow in
India, global pharmaceutical companies need to
conduct their research and development activi-
ties here, rather than just doing field trials,
which is mostly the case today.

The science is constantly evolving; students
need to constantly update themselves on the
latest trends, as well as the software and tech-
niques used. 

asfaq_tapia@thinkdigit.com
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It must be noted, though, that bioinfor-
matics is still very niche in India, with only a
handful of companies carrying out research that
requires the use of bioinformatics. It is prima-
rily large companies doing outsourced work
from multi-national pharmaceutical companies
that recruit. Also remember that bioinformatics
is an application-oriented subject and demands
a clear understanding of biological and allied
concepts, and that students therefore need to
build a research-oriented mindset.

Syllabi
Until recently, due to the specialised needs of the
bioinformatics industry, there was no fixed
course one could opt for. Companies employed
graduates who had completed an M.Tech. and had
a little background in biology, or those who had
a B.Sc. background with a flair for programming.
The bioinformatics courses available today are a
mash-up of the B.Tech. and B.Sc. syllabi, covering
concepts in programming and in biology. These
days, to get into the industry, you need to have a
B.Tech. or similar qualification. This is a stepping
stone into the industry, to get further; you need a
Master’s degree with a super-specialisation in the
research area you’ve opted for. 

Due to media hype and a rush of students
wanting to take up bioinformatics courses, there
are many fly-by-night colleges, not affiliated to
any reputed university, that offer courses in
bioinformatics. Most equipment for biotech /
bioinformatics courses is expensive; it is there-
fore important to check for lab facilities. It is also
important to check the background of the fac-
ulty members of the college you are applying in
before registering for a course. If you can, speak

to alumni of the college regarding the lab facil-
ities and such.

MBA degrees specialising in bioinformatics is
a new phenomenon. Since these courses have only
recently started, it is important to remember that
their marketability has not been proven.

Head-starts
The computational software that most bioinfor-
matics companies use runs on UNIX-like oper-
ating systems like Red Hat Linux and Fedora; it is
therefore good to have hands-on experience with
these while pursuing your graduation.

You can take up summer apprenticeship
courses during the holidays or between semes-
ters. These courses help you gain an under-
standing of how a bioinformatics project works,
and can be an add-on to your résumé. They nor-
mally last for between three and six months.
You could apply for a summer apprenticeship at
certain institutions.

The Remuneration
Working in this industry requires patience and
analytical skills. The ability to analyse statis-
tical data from graphs and statistical tables is
an added bonus. 

According to Dr S K Mahajan, Gharda Pro-
fessor of Biotechnology, Institute of Science,
Mumbai, “The field of bioinformatics is
demanding as well as low-paying. In spite of the
number of students graduating from these
courses every year, only a select few are offered
lucrative placements.” According to
Raghothama Chaerkady, Research Fellow at
McKusick-Nathans Institute of Genetic Medicine,
Johns Hopkins University, a competent bioinfor-
matician assisting in research can make up to
Rs 12,000 to 16,000 as a Junior Research Fellow.
With a Master’s degree, working on Proteomics,
mass spectrometry based sequencing,
microRNA, and such, it could be Rs 40,000 per
month, and at the Ph.D. level, around Rs 40,000
to 80,000 per month.

When a company first recruits you, you start
as a Junior Research Fellow. Here you would be
in charge of assisting Senior Research Fellows in
conducting tests on preset parameters of the
project. This work is, for the most part, very basic
and repetitive in nature. After three years of
experience, you would be eligible for the posi-

Though we don’t
actively look for
students from
“bioinformatics
courses,”
candidates who
have a B.Tech. or
M.Sc. in any
branch of the life
sciences are
preferred”

Dr M Vidyasagar
Executive vice
president (Advanced
Technology)
Tata Consultancy
Services

Human genome: The genetic map of
the human body’s DNA, including
chromosomes and genes.
Mutation: A permanent structural
alteration in DNA; in most cases, this
refers to DNA changes done by
researchers to improve an organism’s
chance of surviving.
Modelling: Refers to the theoretical
methods and computational
processing used to mimic the
behaviour of biological molecules.
Proteomics: Roughly speaking, the

study of proteins.
Mass Spectrometry: A technique used

to determine the composition and
abundance of the atoms in a
molecular substance.
Sequencing: A technique for
identifying nucleotide sequences in a
DNA fragment.
MicroRNA: A short piece of single-
stranded RNA that controls the
expression of genes.
Docking: Computational exploration
of the possible binding modes of DNA
Biostatistics: The application of
statistics to a wide range of topics in
biology, medicine and to agriculture
in particular.

Indicative TermsMoney Matters

Educational Pre-requisites
B.E., B.Tech., or B.Sc.

M.E., M.Tech., or M.Sc.

M.E., M.Tech., or M.Sc.

Ph.D. in your field of super-
specialisation

Ph.D. in your field of super-
specialisation, in-depth knowledge of
BioPerl and GMOD/Chado based
applications

Remuneration (PA)
0.5 to 1 lakh

2 to 3 lakh

2 to 3 lakh

4 to 7 lakh

7 to 9 lakh

Position
Junior Research Fellow

Senior Research Fellow

Quality and Data
Analyst

Head Researcher

Project Head

Getting An Education

URL
http://tinyurl.com/2vxdkf
http://tinyurl.com/3a5k74
http://tinyurl.com/2o6lee
http://tinyurl.com/3dhd4v

http://tinyurl.com/33jc93
http://tinyurl.com/3ce52d
http://tinyurl.com/2lzbaj

http://tinyurl.com/2olfd6
http://tinyurl.com/36tq2f
http://tinyurl.com/2kpqqe

http://tinyurl.com/3aohj8
http://tinyurl.com/2p5q3k

http://tinyurl.com/2oo6m3

http://tinyurl.com/2moz69

http://tinyurl.com/3dq5p9
http://tinyurl.com/2ofeyp
http://tinyurl.com/2jjv73
http://tinyurl.com/3exfgy
http://tinyurl.com/3y2oc7
http://tinyurl.com/2zloyb
http://tinyurl.com/3dndxp

Undergraduate Courses
Amity Institute of Biotechnology—B.Tech.
Vellore Institute Of Technology—B.Tech.
Tamil Nadu Agricultural University—B.Tech.
Sathyabama Institute of Science and Technology- .Tech.
Postgraduate Courses
Pune University—M.Sc. in Bioinformatics 
Jamia Millia Islamia University—M.Sc. in Bioinformatics 
Tamil Nadu Agricultural University—M.Sc. in
Bioinformatics
Madras University—M.Sc. in Bioinformatics 
University of Hyderabad—M.Tech. in Bioinformatics
University of Madras—M.Sc. in Bioinformatics
Advanced Diploma Courses
Pune University—Advanced Diploma in Bioinformatics 
Madurai Kamaraj University—Advanced Post-graduate
Diploma
University of Hyderabad—Post-graduate Advanced
Diploma in Bioinformatics 
Bioinformatics Institute of India—Post-graduate
Diploma in Bioinformatics 
Ph.D. Research Courses
IMTECH—Protein Science and Engineering 
CCMB—Bioinformatics
NII—Bioinformatics 
IGIB—Genome Informatics 
CDFD—Computational Biology 
IICB—Structural Biology and Bioinformatics
IICT—Research Projects

Digital Business l Tech Careers



Digital Business l Smart SoHo

Image Or File?
Like hardware, data backup software comes with
varying levels of features and complexity. Backup
software basically performs two types of backups:
image and file. Image backup is when you restore
data along with all the settings of the system. The
software creates bit-for-bit copies of the source
disk—something like the System Restore feature in
Windows. This is ideal when you’re not planning
on upgrading your hardware, or when you need to
get back up and running minutes after a disk
failure. However, image-based backups typically
take a lot of time, which might mean that the user
can perform less frequent backups. 

File backup, on the other hand, is the conven-
tional copy-and-paste (rather, copy and burn to
storage media). The software copies the selected
files on demand, or on a predetermined schedule.
This is fast, and is suitable even when you install
new hardware. The problem with file backup is
that if and when the OS crashes, you will have to
start installing everything—Windows, device
drivers, and your software, before you can use the
data. Then again, there is the chance that you
might just forget to back up an important new doc-
ument because it wasn’t in the usual source folder
for the backup software. 

A third type of backup solution is offsite, online-
based backup. For a price, storage companies allow
you to automatically back up data to their servers.
This works well if you have a broadband connection.
Online backup is file-based; it takes less time, and
less space is utilised because only the data is copied
(without any settings).

Software
When it comes to software, customers have a number
of choices based on budget and requirements. Data
backup and recovery software comes in both paid
and free versions. We’ll look at both categories. 

Norton Ghost 12
This is Symantec’s data recovery software; it falls
in the image backup segment. It costs $69.99
(Rs 2,800); find a free evaluation copy on this
month’s DVD. Norton Ghost works on Windows
and does a comprehensive backup of your hard
drive. You can also back up individual files and
folders. Restoration is as easy as clicking a button.
However, it is a resource hog. Ghost analyses your
hard drive when you start it, so startup times
depend on the amount of data on your hard disk(s).

Some options
with Norton Ghost
are the scheduling
of backups and use
of password protec-
tion on the backed
up files. It creates
periodic restore
points, like System
Restore does in
Windows. Norton
Ghost does not
need to be running
for a scheduled
backup to start: it
will start all by
itself. It even allows
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Bhaskar Sarma

M
ost of our personal and business
data exists as bits and bytes stored
on optical media and hard disks in
computers. We live in a digital
world. The robustness of computers,

though, is still often thrown into question—think
virus attacks, system failures, and hardware mal-
function. It’s therefore important not to keep all
your data in just one place: back up.

Traditionally, the process of backing up
valuable data has been glossed over, probably
because of the absence of affordable storage
and the lack of easy-to-use software. However,
this doesn’t apply today, when you have storage
available at dirt-cheap prices as well as great
software—some of which are free. Such soft-
ware has a plethora of features that enable you
to set up a backup system once, and then forget
about it; and they are suitable both for indi-
viduals and businesses.

The Basics
If you’re convinced about the necessity of data
backups, you need to sit back and understand
your requirements. The frequency of generation
of data will determine your choice of software,
as there are some upper limits to how frequently
you can back up. Likewise with issues of
retrieving older copies: some software allow you
to store multiple versions of the same files, while
others overwrite older versions and keep only
the latest version in storage.

Data backup methods have evolved over the
years. Until about a few years ago, most SoHos
used the older and cheaper way of data backup—
optical media (CD / DVD). But though CDs and/or
DVDs are still useful for one-time backups, they
can be a pain in the neck when regular backups
are needed. More user-friendly storage would be
external USB hard drives. Many drives feature
the “one-touch backup” option; they come with
software that automatically backs up data at the
press of a button.

Chaitanya Surpur

Multiple
Redundancies

Data today, 
gone tomorrow.
That’s why you
always need
plan B

Security options in Ghost



offers 2 GB of storage space for free, with
unlimited space for personal use at $49.50 (Rs
2,000) per year, and 50 GB to 500 GB for busi-
nesses at yearly rates starting from $99.50 (Rs
4, 000). These services typically require the
installation of a client on the local machine;
this is used to control settings and options.
They offer the full range of features, right from
scheduled backups to encryption—just like
those offered by Desktop software.

At The End Of It
For a SoHo user, the best solution would be to
use backup software and back up data to
another hard disk, preferably an external drive.
It is not advisable to use another internal disk
to back up the data, as both data and backup
could be lost at the same time.

External hard disks are pretty affordable
these days—a 160 GB drive, for example, costs
between Rs 4,500 and 6,000 (internal hard drives
of the same capacity cost about Rs 3,000).  Since
you can carry all the data with you, you have
yourself a great solution.

Online backup can be expensive or afford-
able depending on your budget, needs, and con-
nectivity. It’s definitely worth considering. 

bhaskar_sarma@thinkdigit.com
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you to back up more than once in a day, which
is ideal for a busy day at office. Backups, espe-
cially image-based backups, are a performance
hog when they run, and Norton Ghost has a
Progress and Performance feature which allows
you to slow down the backup if you are in the
middle of something. You can even back up sys-
tems that are dual-booted.

The backup sets can be burnt onto CD / DVD
or transferred onto a USB drive. Security for your
backups is rock solid—the files are protected by
256-bit AES encryption, one of the best methods.
Apart from scheduled backups, backups can also
be triggered by user-set events like the installa-
tion of a new application, or when the size of the
backup source folders increases beyond a certain
limit. Multiple computers running Ghost can be
controlled remotely from a single machine.
(Each computer needs to have an unique license
key, so this proposition would be very costly if
your network is large.)

Restore times depend on the amount of data
that is imaged. However, the process is easy—it is
basic point-and-click. If you have no time to do an

image backup, Ghost will let you do an individual
backup of files and folders. It will do incremental
backups when space is a concern. The backup files
can be searched either through Ghost’s inbuilt fea-
ture, or synced with Google Desktop Search.

Norton Ghost is a costly choice, but it does it
job pretty well. The documentation is pretty
detailed, and technical support can be obtained
via e-mail. For more details on how to use
Norton Ghost like a Pro, check out this month’s
30 Minute Expert in our Tips & Tricks section.

Vembu StoreGrid Backup Software
For those businesses that run more than one com-
puter, this is a godsend. Each computer on the net-
work usually has some free space. Vembu
StoreGrid allows you to back up data across an
intranet utilising this free space. Find the soft-
ware on our August 2007 DVD. The free edition
runs on Windows, though the paid versions run
across all platforms. 

Unlike Norton Ghost, StoreGrid runs very
well on systems with average system specifica-
tions. The free version does not have all the fea-
tures of the paid one, but it does the job of
backing up your files. Some nice features are
the ability to do incremental backups by
default—StoreGrid will back up changes each
time they appear in the file, but it won’t save
multiple copies of the same file. Rather, the
changes will appear in a single file, which
results in space and time savings.

If you’ve spent hours tweaking your Registry
for optimum performance, those changes can
be saved, too. User data is encrypted up to 448
bits using the Blowfish algorithm, and is pass-
word-protected. StoreGrid supports hardware
like Network Attached Storage (NAS) and
external hard drives. The Pro version has the fea-
ture to back up files via secure FTP (File Transfer
Protocol). It also stores Outlook, Outlook
Express, and browser settings and will back up
data to Microsoft SQL and Exchange Server.

The interface is intuitive, and setting up the
software is easy. There are three modes of con-
figuring the software. The first is client / server

Schedules can be set for backup, at your convenience 

You can choose to back up only select file types

The browser-based console in Vembu 

Configuring Vembu for a network is as simple as adding
IP addresses.

mode, in which the computer can be used to
store backups of other systems and also back up
its own data to others. The other two options
are client and server: systems configured for the
client mode cannot have backups of other sys-
tems stored on their hard drives, while systems
configured for server mode cannot have their
data backed up elsewhere.

Control is through a browser-based inter-
face, and you need to type http://localhost:6060
into your browser’s address bar to start the
console. Backups can be scheduled on a cal-
endar, or set up so that every time a file is
updated, it is backed up. For users who use
both a laptop and a Desktop, StoreGrid can be
configured such that data on specific folders
on laptops will be automatically backed up on
connecting to the network.

Back2Zip
For those on a budget, Back2Zip is a simple and
effective data backup software. It is freeware; find
it on this month’s CD. 

This is a no-nonsense, no-frills software. It
sports an extremely simple interface with a
minimum of options, but does all that you’d
expect it to do. It can either do a simple copy, or
compress the files into zipped folders; the level
of compression can be set to low or high. (The
higher the compression, the slower the backup.)
Back2Zip backs up whole files and folders; it is
not image backup. The duration between suc-
cessive backups can be set from 20 minutes to
6 hours; the 20-minute option is ideal when you
are working on important documents.

This software leaves a very small footprint.
The compression method used is the industry-
standard ZIP and ZIP-64.  

Over The Wires
Online backup is typically a costly option for
individuals and small businesses because of
recurring costs, but you can get some good bar-
gains if you hunt for them. Some companies
like IDrive (www.idrive.com), Mozy (http://mozy.
com/), and Carbonite (www.carbonite.com) offer
packages tailored to the needs of individuals
and small businesses. The offerings are com-
parable in terms of cost. IDrive, for example,

Multiple backups of the same file can be archived by Back2Zip.



Online Services Vs. Software Suites

Neev Technologies provides software services specialising in
Web-related solutions. They are involved in the development of
rich Internet applications using AJAX, Flash, Java/J2EE, Ruby
on Rails, .NET, and others.

“In general, we believe the world is moving
more towards online services. Prices of storage
and bandwidth are both following Moore’s

law and are falling rapidly. It has finally become
feasible to be always connected, have all your
documents online, and free yourself from being
dependant entirely on a machine. We have been in
this mode for around four to five months.

“Several reasons make online services enticing.
There’s no need to buy hardware—hardware brings
with it so many costs—air conditioning, space, IT
operations, electricity, racks, and if you add up
everything, it’s significant. For our company, the cost
benefits were secondary, though; the most important
benefit was time saved, which is the most expensive
resource for a young, growing company.

“It was easy, since people are used to online
applications these days. We still haven’t been
successful in optimally exploiting the potential of
complex documents, presentations, and spreadsheets,
but simpler spreadsheets or documents are so much
better online since you can collaborate easily. We
haven’t done a quantitative analysis, but qualitatively,
there has been a substantial improvement. 

“Overall, our IT team is now more productive,
since common shares or mail servers need not be
managed. The number of servers in the company has
been kept to a minimum. The major limitations are in
the creation of documents like proposals,
specifications, and costing sheets. Online suites have
some way to go in those areas.

“Online office suites would be apt for new
organisations where inertia is low and the (younger)
staff is more eager to use such apps, since they use so
many other online services anyway.”

GlobalLogic, Inc. offers full product development lifecycle services
to start-ups as well as emerging and established tech companies.

“At GlobalLogic, we’ve been using Microsoft
Office for the last five years, and our experience
with it has been very good so far. Although it is

termed “productivity software,” it has become an
important tool for our day-to-day business operations.

“Every company has different IT policies, but they
use the popular Office software suite to remain in sync
with others. The common Office suite acts as a tool for
easy communication with most of our clients while
working on their projects. The suite has helped us

directly improve productivity, which has indirectly
increased our profitability.

“Besides that, it is also helpful in database
management, documentation and inventory
management, which form an essential part of our
development processes.

The main limitation of the Office software suite is
its incompatibility with different office suites.

“By using the Office package, various functions like
communication through e-mail and Word documents,
setting up meetings, presentations, preparing complex
spreadsheets and so on, have become very systematic
and organised. These software packages have fuelled the
routine activities like the preparation and maintenance
of project status reports.

“The main limitation of the Office software suite is
its incompatibility with office suites like OpenOffice,
StarOffice, and Lotus SmartSuite, which are used by
various companies. To fix this issue, we have to use the
same office suite that our clients use.

“We would highly recommend the use of offline
office Suites to anyone, as they substantially improve
productivity. It helps with day-to-day activities, and also
helps stay on a common platform with clients.”

As told to Samir Makwana
(samir_makwana@thinkdigit.com)

Sanjiv Kumar
Senior Manager IT 
GlobalLogic, Inc.

“People can collaborate
easily, do simultaneous
edits on shared docs,
and are not dependant
on one machine.”

“The main limitation of
the Office software suite

is its incompatibility with
different office suites.”

Saurabh Chandra
CEO and co-founder,
Neev Information Technologies

How open are you to using an online office suite for your daily work?

Overall, our IT team is now more
productive

“Our offline suite has helped us
directly improve productivity”
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others. Each of these companies have donated
approximately 7 crore to the initiative.

The OLPC project revolves around five core
principles, including the fostering of the idea of
ownership in children between the ages of six and
12, by providing them with their own laptops.
These would have hardware and software
designed for them, in keeping with their age. The
project aims at promoting the constructivist way
of education by donating laptops to needy
schools, for free, all over the world, whenever
possible, and allow them to connect and share
ideas using free and open source tools.

In India, the OLPC project is supported by
Reliance ADAG, which takes care of the logistics
and provides the resources necessary for imple-
menting the project in villages and small towns.
That apart, the OLPC project works closely with
the Digital Bridge Foundation—created by the
Dhirubhai Ambani Trust—to work with inter-
ested organisations, NGOs, and volunteers in
India to identify and sponsor needy schools.

The first school to be sponsored in India is
Khairat School, 40 km from Navi Mumbai, close
to the Mumbai-Pune expressway. We wanted to
take a look at what things were like at the school
now that the laptops were there, and we wanted
some views and first-hand information from the
people behind the project. We were half-suspect-
ing that the laptops would just be gathering

cobwebs; however, what we saw was quite
different. So how exactly is this project

making an impact in the lives of the chil-
dren in Khairat village?

The Visit
The Khairat School comprises classes (stan-
dards) I to IV, all in one room. The XO laptops
were donated to the school in October last
year; the children had had some time to
explore their laptops by the time we met
them. The instructional material is
prepared by the only class teacher of the
school, Mr Surve, but Manusheel Gupta,
Technical Consultant, One Laptop Per

Child Inc., says they have been approached
by a number of organisations interested in

sharing the curriculum they’ve developed.

Digit went to Khairat village near Mumbai, the pilot site of the OLPC project in India

Asfaq Tapia

Y ou’ve heard almost too much about it in
the news—now here’s a little first-hand
report: the One Laptop Per Child (OLPC)

association is a non-profit organisation that was
formed by faculty members of the MIT Media Lab
in Delaware in the United States to oversee the
construction of an affordable laptop for children;
the laptop was christened the XO. The organisa-
tion is supported by industry bigwigs like AMD,
Google, eBay, Red Hat, and Intel, among

Digital Leisure l Touched By Tech
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AG: At present, we intend to start with rural
schools. We are in talks with various state
governments, NGOs, and corporate bodies to
assist us. We are building an ecosystem for the
collection of funds, and are working with educa-
tionists and interested volunteers to create
educational content and plan for its deployment
into the system.

CGM: The issue is not only the size of the
class, but also how the laptops are used to foster
the children’s learning.

Don’t you think that donating only to govern-
ments is impeding the progress of the project?
MG: Our goal is to reach the rural children of
developing countries. Dealing with governments
makes this process efficient. However, this is not
the only strategy that we are adopting. We have
various running programmes—like “Give 1 Get
1” and “Give Many,” where the purchase made
by an individual or organisation benefits rural
parts of the world. You can find more informa-
tion at http://tinyurl.com/yo4s3h.

CGM: The idea was to have governments
sponsoring for their people.
In most countries, govern-
ments run the entire educa-
tional system, especially for
public schools. It is easier to
work with one well-estab-
lished and influential entity
in a country than to create
ecosystems in each country
to make it happen. That’s
why the first approach was
through the governments.

The landing cost of the XO
in India is about Rs 8,500.
Taking that into considera-
tion, don’t you think the
ASUS Eee PC is a more
viable proposition? Though
it does not support the abil-
ity to create mesh networks on the fly, it
supports an interface that teachers are familiar
with (MS Windows)...
SC: We believe in following the constructionist
approach to teaching. The XO laptops are aimed
at children in specific age ranges, and contain
activities tailored for them. It would be unwise
to compare the two.

AG: Comparing XOs to other laptops defeats
the whole purpose. Remember, we are targeting
young minds and want to create a system that
triggers their thinking and creative abilities and
not one that turns them into experts at Word,
Excel, or PowerPoint. Some key features that
stand out are that the laptops are very sturdy,
consume low power, and foster collaborative
learning through the mesh network.

What happens if a student says a laptop is lost?
Do you provide for a replacement?~
MG: That depends on the definition of “lost.” If a
laptop is stolen, the security mechanism enabled
on the laptop will disable it within hours.

AG: The kids are given some basic instruc-
tions about handling the laptops, thus minimis-

ing the chances of it getting lost. Having said
that, some laptops are needed as spares for
compensating for rough handling by the kids.

Earlier in the year, there were reports of
students in some countries being caught view-
ing pornography on their XOs. What has been
done since to combat that problem?
SC: The porn menace can be easily solved in
India. Most rural villages do not have access to
the Internet. When we do provide them with
Internet access, we can have filters installed to
block pornographic and malicious Web sites.

In one of his mailing list posts, Gogna said: “OUR
OLPC MESH NETWORK is going to set its NODES
all across the NATION.” Does this mean that
Reliance ADAG will provide the backbone
network connectivity for the OLPC project in
India? If yes, by when will this be completed?
MG: We’re glad to have seen the best support
from Reliance ADAG in the first OLPC pilot proj-
ect conducted in Khairat School. We don’t know
the answer, and will take some time depending

upon various parameters.
We’d be happy if Reliance
ADAG provides us with the
networking services.

AG: That statement
was much more of an anal-
ogy than fact. What I
meant by “OLPC Mesh
Network” was the forma-
tion of the ecosystem for
the project to spread
across various parts of the
country, acting as nodes.

CGM: The analogy
comes from how the actual
Mesh Network of the XO
laptops works. The XO
laptops can connect to
each other (without being
connected to the Internet)

and thus collaborate on all the different software
applications (“activities”). The XOs can also be
nodes that replicate the Internet signal among
them, in case only one of them has access to the
Internet. They can do it even when turned off.

What are the goals (and roadmap) of the OLPC
project in India?~
MG: The OLPC project in India and all around
the world aims to revolutionise the way we teach
children. We hope to reach the remotest parts of
India by means of the “Digital Bridge Founda-
tion,” comprising corporate partners, non-profit
organisations, Ministers at the state level, and
most importantly, interested volunteers.

AG: We also intend to reach most villages
and towns across the country.

The OLPC project seems to have started off on
the right foot in India. There are loose ends,
however; foremost amongst these is the problem
of creating awareness about the project. The OLPC
team is indeed working with state governments to
provide support to schools in Gujarat and Kolkata.
We’ll be keeping our eyes open. 

asfaq_tapia@thinkdigit.com

The students just can’t get enough of the XO

“The XO laptops
are aimed at chil-
dren in specific
age ranges, and
contain activities
tailored for
them. It would be
unwise to com-
pare it to the
ASUS Eee”
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It’s interesting that the students are given a
free hand to explore and discover their XO.
When we were at the school, we saw many
students taking photos and video clips of us!

We saw quite a few animated clips that Mr
Surve had prepared—on various topics such as
the earth’s orbit and the water cycle system—
which were distributed to those in the class on
their XOs. The laptops act as individual nodes
and create a wireless network, also known as a
mesh, when two or more XOs are in a 1 km radius.
This can be used to chat and transfer files with-
out the need for an Internet connection. We
found Surve using the chat application innova-
tively by asking the class a question that required
a written reply. The students would reply via the
chat tool. The kids are taught how to write
Marathi words in eToys, an application similar
to MS Paint, and they complete their homework
on Write, an MS Word-like application. Accord-
ing to Surve, the students are now eager to come
to school because they get to learn something
new about their laptop every day, either from
him or from their classmates. Parents, who were
earlier not interested in sending their kids to
school, have changed their attitude because they
know that their kids are getter a good level of
education, thanks to the XO.

There are, however, hurdles to overcome.
Foremost amongst these is the availability of
electricity, which, of course, is needed for charg-
ing the laptops. There are plans to get solar
panels for recharging the batteries. There also
happens to be a contraption to aid in recharging

the laptops, which has been developed using
local materials and runs on cow power! A cow
moves in a circle, driving a system of belts and
pulleys connected to a dynamo to generate
power to charge all the laptops. The dynamo is
the one used in Fiat cars, very commonly seen as
taxis in Mumbai. It takes one to two hours to
charge all the 20 laptops in the village simulta-
neously. This is possible due to the extremely low
power consumption of the laptop and the robust
power supply built into it. The contraption is the
brainchild of Arjun Sarwal, an OLPC volunteer.

The XO has a robust frame, but we noticed a
few laptops without antennas, and two non-func-
tioning ones. The OLPC volunteers who accompa-
nied us said they would be replaced. We also saw

that the keyboards were in English; this might,
we thought, initially hinder students from work-
ing on the XO; plans are under way to create a
keyboard with keys in the Devanagri script, but
it’s not clear when it will be introduced.

The laptops the students have been given are
early prototypes of the XOs available today, and
are not likely to be replaced, though.

Q&A
We were looking to get some questions answered
by the OLPC India team. For example, we wanted
to know what the roadmap for the programme
was, how they were planning on taking the
programme to other parts of the country, and so
on. The questions below were answered by

Manusheel Gupta (MG), Technical Consultant,
One Laptop Per Child Inc; Sumit Chowdhury (SC),
CIO, Reliance Communications; Carla Gomez
Monroy (CGM), OLPC India team member; and
Amit Gogna (AG), OLPC India team member.

What is being taught in Khairat School using
the OLPC laptops? Is there any courseware
available for it?
AG: We’re working on a booklet for teachers
with a basic introduction to activities on the XO.
It’s too early to talk about courseware. The XO
gives teachers the liberty to create projects and
use various “activities” that suit their needs as
they go about with their daily curriculum.

How long do the laptops have to be cranked
before they are fully charged?
MG: We have several research groups looking at
different human-power solutions, including a
hand crank, a foot treadle, a yo-yo, and a pulley
system. Our goal is a minimum of a 1:10 ratio of
“cranking”—one minute of cranking should give
you 10 minutes of use. The XOs can also be
charged using a solar device, which is a good
solution for India.

AG: The laptops currently shipped to us do
not come with the crank mechanism. They get
charged using an AC adaptor. In addition, one
student at the school uses solar panels to
charge his XO.

SC: We do not have laptops that have to be
cranked. Getting more solar-powered battery
chargers seems to be a more effective alternative.

The XO is aimed at students of what standard
(or class, or grade)?
CGM: It is targeted at primary school children. In
most countries, children start primary school at
the age of five. However, in some schools, there
are children who could not start school at that
young an age, which means that in some cases we
have children as old as 15 or 16 in primary school.

How do you plan to introduce the OLPC
concept in classrooms across India, where the
average head-count per class is 60?
SG: We will look to adopt entire schools or
communities with the help of the Digital Bridge
Foundation—comprising corporate partners,
non-profit organisations, ministers at State level,
and most importantly, interested volunteers—
and try to provide laptops to all the students.

The Cow Power charging device, stowed away for later use

There are plans
to get solar pan-
els for recharging
the batteries. For
now, the laptops
are recharged
using a contrap-
tion that turns
cow power to
electricity



XFX GeForce 8800 Ultra,
Intel Core 2 Duo E6600,

4 GB DDR2 RAM

GAMING PC

A
ugust 7, 2020. An asteroid
crashes on Lingshan Island in
the Phillipean Sea. August 14,
2020. A distress call from a
group of archaeologists who
were investigating the crash

zone is intercepted. It seems the area is
swarming with Korean troops. An artifact of
unknown origin has been uncovered from the
crash site, and the scientists have been
detained to analyse its properties. A few days
later, you and your elite team are sent to res-
cue the scientists, and find out what the heck is
going on.

Things get plenty nasty after you see a
teammate who’s been torn to shreds by some
Unknown Entity.

Essentially a “sandbox” game, Crysis’
brilliance lies in its simplicity. Huge levels,
missions and complete freedom—do as you
will! Your Nanosuit is your best friend, and will
give you an array of powers—from boosting
your armour during fire-fights, to cloaking you
for stealth kills and recon and increasing your
speed or strength. The suit runs off an energy
pack, so you won’t be able to use these powers
indefinitely—run too fast in stealth mode and
your power meter will drop like pins in a
bowling alley. Weapons and weapon mods like
scopes, laser sights, and damage modifiers
are aplenty.

Enemy AI is ferocious, even on easy set-
tings. They’ll flank you, grenade you and take
pot shots at you from behind cover. They’ll also
(quite irritatingly) call for reinforcements.

Although your suit makes things easier, you’ll
be surprised how quickly your health and
armour nosedives if a couple of Koreans catch
you in their sights.

The level of detail that Crysis achieves is
nothing short of incredible. Lush jungle envi-
ronments come to life, dappled sunlight
through trees and the corona effects of dust
and fog will dazzle you. Battles are spectacular,
with smoke and flame spewing from weapons,
debris and concussions from explosions—all
extraordinarily life-like. The environment’s
completely destructible too: imagine machine
gunning a palm tree to have to fall on a couple
of opponents and crush them! Very immersive,
and very, very realistic, I say.

The only minus point—Crysis eats most
CPUs and GPUs for breakfast. In fact, if you
want to experience Crysis the way it’s meant to
be played (no pun) then you better have a
GeForce 8 series or a Radeon 2xxx series card—
preferably two! It’ll be worth the upgrade.

The long and engrossing storyline has
three distinct parts (no, we’re not going to
spoil it for you). The multiplayer component
isn’t much with its paltry selection of maps,
but the single player experience is frantic fun.
Genre defining? Yes! Genre redefining? No.
Crysis takes the best components of Far Cry
and adds a few of its own—which isn’t a bad
thing, although there’s nothing in the way of
path-breaking differences.

I have two bits of advice: upgrade, and play
this game...

michael_browne@thinkdigit.com

Rating: 8/10
Developer: Crytek Studios

Publisher: EA
Price: Rs 1,000

Digital Leisure l Game On



investigation leads. In the
recent past, even news
dailies have started looking
in on online social
communities for people
involved in various crimes.

Mark Zuckerberg,
Facebook founder, had a
heart attack (14 December
2007) when he learnt that
his personal documents and
information were floating
online for free download.
(Actually, we’re just
speculating—about the
heart attack and the date,
that is.) His application to
Harvard University—which
carried his social security
number, the New York
address of his parent’s
house, and also his
girlfriend’s full name, was
available to anyone with an
Internet connection.

What happened was that
a freelance reporter, in an
independent magazine
called 01238 (yes, that’s what
it’s called) wrote a story
“poking” a conversation
about the suit filed by
ConnectU.com on Facebook
for stealing their idea. (Yes,
we know it’s complex, and
we’ll leave out further
details because (a) You might
not understand them, (b)

They’re not interesting, and
(c) We don’t understand
them ourselves.) At the end
of the article were
documents like Zuckerberg’s
correspondence with
Harvard, Facebook’s cash-
flow statement for 2005, etc.

Find out more at
http://tinyurl.com/2w9w9p
(don’t blame us if the
article’s been removed).The
original documents that
carry Zuckerberg’s details
have, naturally, already been
removed. As it stands now,
The Magazine Whose Name
Contains No Words might
face serious legal action...

But do you care? (We
don’t). The point is, when the
owner of a social networking
site cannot prevent his
privacy (and a lot of it) being
violated online, how can
users be comfortable with
putting up personal
information on social
networking sites?

Possible morals of the
story: (a) Never trust anyone
on the Internet. (b) Magaz-
ines with no letters in their
names can sometimes be
really stupid. (c) Reaffirm
your belief in Scott McNealy’s
wisdom (“You’ve got zero
privacy anyway...”)

EGO-SURFING

Where Do I
Stand,
Virtually?

Google’s search
function has all but
crippled humans.

From recipes to research,
people have stopped
thinking; they Google stuff.
(It might well be eventually
proved that the average
human neuron has shrunk
in length by 40 per cent,
that its shape has changed
to vaguely resemble a “G”,
etc.) Very helpfully, all those
billions of searches don’t
vanish into the digital void:
Google’s Zeitgeist comes out
with statistics about the
most searched-for terms. At
the end of each year, we get
a clear picture of what the
year was like in terms of
search (and therefore
popular culture). The 2007
year-end Zeitgeist says the
most popular search terms
were iPhone, Transformers,
Heroes, Facebook, and Anna
Nicole Smith. (Most of
which are guessable.) 
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You’ve won a lottery…
Get a free iPhone…
Resize your manhood…

The bigger the better… You
can easily recognise these as
the subject lines of the
delete-worthy mails in your
Inbox. However, intriguing
subject lines do entice a
select few idiots into
opening the mails—in case
you didn’t know.

Creating good spam
filters to tackle such mails
has been the agenda of many
security companies, working
with Web-based mail service
providers. McAfee recently
decided to think outside the
box; the company said they
would be hiring volunteers
from the UK and the US for a
thirty-day spam analysis. The
research has been dubbed
“Super Spam Me.” The
distasteful thing the
volunteers would have to do
is to reply to the spam
messages; this act will
supposedly help the

researchers figure how that
will affect the flow of spam.

The project, if one may
call it that, will only include
a few paid volunteers.

Here’s the first bit of
hilarity: applicants would
have to send an e-mail to
the company that oversees
McAfee’s PR work. Seeing as
the job (namely, to reply to
spam messages) is easy to
perform, there will
doubtless be thousands of
volunteers (people tend to
like money). The poor slobs
will now receive more
McAfee PR mails than other
spam, we can bet.

In case you haven’t
figured it already, the second
point here is that everyone
knows what’s going to
happen. When you respond
to a spam mail, you’re going
to get more spam—for those
not in the know, this is
because the spammer gets to
know that yours is a valid,
active e-mail address. So

what’s with the bit about
analysing how the flow of
spam would be affected? If
you can guess, if we can
guess, McAfee can guess,
too—more spam, period.

The deal, evidently, is
this: get paid to get more
spam—from your spammers
as well as from us. Quite
normal for a regular Web
company to be offering
something like this—but not
quite normal for a company
that should be spending its
time making spam filters.

PRIVACY WOES

No more
Pokey-
Pokey!

Whether it is to spy
on a cheating
husband or to

probe into a murder, social
networking sites have
become a major source of

You don’t gawk at people
around you when they
use their mobiles, but it
was a novel experience
for New Yorkers when
they saw Martin Cooper
talking on a phone while
walking along the street
on 3 April 1973. At the
time, he was head of R&D
at Motorola; he made the
first cell phone call to
Joel Engel, his
counterpart at competitor
Bell Labs, on that

definitive April day. The
mobile that Cooper used
was a clumsy affair,
though, a big as a brick
and weighing almost a
kilogram.

Portable phones were
not new; there were
already car phones, using
which one could place a
call from inside a car. But
the concept of a portable
phone  was novel. An avid
Star Trek fan, Cooper says
he dreamed up the idea
when he saw a character
talking on a wireless
communicator. And we
call TV the Idiot Box…

Cooper is also known
for Cooper’s Law, which
states that the number of
conversations that can be
carried out in a particular
slice of the radio
spectrum doubles every
30 months. An electrical
engineer by training, he
began his career with the
US Navy and later joined
Motorola in 1954. Cooper
won the 2003 Wharton
Infosys Business
Transformation Award for
his contributions to
telecommunications.

Lakhya Jyoti Nath, Sonitpur, Assam
How he did it:
It’s confusing—is he running Windows? Is he
running Linux? Both? What Lakhya’s done here is a
variation of an old trick—customised his Windows
XP desktop to his liking and taken a screenshot on
it. He then fired up SLAX from our December 2006
CD and applied the XP desktop as a wallpaper! So
simple, yet so befuddling.

People Who
Changed

Computing

Audiophiles Are Pirates
According to the Recording Industry Ass. Of America (RIAA),
ripping personal CDs to the MP3 format on your PC is copyright
infringement—even the possession of such copies could be
unauthorised and illegal. This means audiophiles backing up the
digital copies of their CDs are pirates. Play safe, now! 

PAY TO GET SPAMMED

Exploring Charted Territory 

The Communicator

My Desktop

Whatever 
Happened To…

The Semantic Web is an
idea that promises to
make Net-connected

computers understand human
language. When we search for
information on the Net or files
on a computer, we enter a
specific set of keywords; with
the Semantic Web, if you enter
a search query saying that you
want to book flight tickets for
Mumbai to Bangalore at the
lowest possible fares for the
last flight on Sunday, the
computer will automatically
sift through all the data and
present to you the best
result—essentially, better data
retrieval and more accurate
results.

According to Tim Berners-
Lee—the inventor of the Web—
and his colleagues at the
World Wide Web Consortium
(W3C), the Semantic Web will
make use of detailed
metadata present in
documents to identify and tag
each and every file on a
network. This tag will then
work with other technologies
to further categorise the
document and its contents.

The idea seems brilliant,
but there are problems
galore. It is practically
impossible for the entire Web
to be made semantic,
because the documents on
the network today do not
contain detailed metadata,
and modifying them in the
future is an insanely
formidable task. But when
you consider that Berners-Lee
has been actively working on
this for the past decade, you
start to wonder what’s been
happening to it!

W3bster Says w00t!
From the online gamers’ lingo, the word ‘w00t’—an
expression of joy—was crowned as Word of the Year 2007 by
Merriam-Webster Inc. The entry in the dictionary will reflect
thus, and is the first time l33t language has made it into the
world of “propah” English. 

Please open the door to your Windows

WIN!
Send in your entry and you could win an exciting
gift by sharing an amusing picture with a tech
angle to it. The picture should have been shot by
you, and should not have been published
anywhere earlier. 
E-mail your picture with “DigiPick” in the
subject line, mentioning your postal address, oonn
oorr bbeeffoorree tthhee 2200tthh ooff tthhiiss mmoonntthh to
digipick@thinkdigit.com. One prize-winning
picture will be published each month.

Send us your desktop  with a description of how you
made it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject
““MMyy DDeesskkttoopp””,, and tell us your postal address, too.

Participate in this contest
and win next month

.net Interview 
Questions
by Nagaraju B

Published by

Participate and 
win next month:

Beginning 
Access 2007 VBA
by Denise Gosnell

Published by

The Semantic Web

Last month’s winner:
Benoy Somanathan
Chennai

Martin Cooper 

n Canadian man gets $85,000 phone bill for using phone as a modem n A new feature in Ask.com will allows users to erase porn searches n Iranians make supercomputer from banned AMD parts; is XP capable n US School bans mobiles after pupil films principal fighting with a student
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Scandoo, Foonance, Kelkoo.
Actually, you wouldn’t
recollect the names even if
you’d stumbled upon them.

In this, the Web 2.0 era,
a new site is launched
every fortnight (they’re all
in beta, but no matter; they
exist). Why do these sites
come up with the most out-
of-the-world names, which
sometimes sound goofy,
and are sometimes
unpronounceable? What a
group of directors used to
do behind closed doors
earlier is now done...
untrained monkeys armed
with typewriters. (No, that
was speculation; we do a
lot of that in this space).
Actually, the thanks go to
online services like Dot-o-
mator.com: no more
wasting time. Just couple of
clicks and voila... a new
domain and Web 2.0 
site name!

In the past, sites had
names that actually meant
something, and those
names were associated with
a brand name and with
services offered. (For
example, god.com is a
spiritual site.) Some big
names might seem like
exceptions, though, for
example, Yahoo!. But then,

after some soul-searching,
illumination dawns: Yahoo!
Is an expression of joy,
ostensibly upon receiving
an e-mail. (At the time the
name was conceived, people
just loved to receive mail.)
Google refers to one googol
Web pages; Googol means 1
followed by 100 zeroes.
Then there are the self-
explanatory names: Amazon
(which obviously refers to
the vastness of the site, just
like the Amazon basin);

Digg (referring, doubtless,
to the digging up of
information); eBay (who can
possibly not know that
electronic commerce began
in the Bay area?); etc.

But Yokld, doodlekit,
Bykaee, Yamli, Sphinn,
Yuku… ? The only way out
we can see is to impose the
following Three
Commandments upon new
domain registrars:

The name of your
domain shall roll freely

off the tongue and shall
not generate in the
listener the question
“Beg pardon?”
At least five minutes of
thought, with valid brain
activity being measured
and certified by an EMG,
shall have gone into the
creation of the name.
When in public, you shall
pin to your breast pocket
a badge bearing your
name following the name
of your site. 

Of Change And Small Change
Bidding farewell to Deepak Ajwani as

Editor—in fact, as a member of this
organisation—was a mixed affair. It was sad
for most of us; one or two women wept the
way some women do when the time comes
to say good-bye. The chaiwala, however, was
glad, because Deepak never had never given
him a tip—we know because he told us.

The outgoing (rather, the out-went) editor
had won our minds and hearts by virtue of
his genuineness, his big heart, his lack of
attitude and ego issues, and his
unwillingness to wield the stick of discipline
(the above, not in any order—really!). But in
particular reference to the last point, we
should mention that Nimish and Robert got
to play Quake, Ram got to sleep, Samir got to
use his PSP, Bhaskar got to do
his Wikipedia edits, Asfaq

got to chat, Vijay got to surf for exotic
pictures, etc. etc.—during official, paid, office
hours. Still, we should reinforce the idea that
this thing about Deepak’s not having been
strict about discipline was not the biggest
reason for our loving him.

Raaabo now manages the things Deepak
did, and we’ll soon begin to treat him in this
space the way we’ve been treating Deepak.
For example, fun shall often be poked at
him, and gentle ridicule shall sometimes be
directed his way.

We collectively gifted Deepak a good
phone, because it’s better to give than to
receive (and when you know you won’t receive if
you ask, it’s even better to quietly give).

We do know that the chaiwala has no
complaints with Raaabo, though—he

tips enough for all of us!

n Windows Explorer identified as virus by Kaspersky, quarantined n Facebook accuses British MP of impersonating self, disables account 

Jonathan Bradford and Ian Leader
http://tinyurl.com/2ogfxk
http://www.readwriteweb.com/archives/online_accoun
ting_google_apps.php

...So what’s next for Google Apps? What might be the
next killer app? We think it will be an accounting system
and in this article we will outline why. There are strong
benefits to an online accounting service in Google
Apps—both to users and to the targeted advertising-
driven business of Google...every site. What does this
have to do with the portals?

...Google could bring significant expertise to online
accounting, thanks to their ability to deliver simple,
effective online applications with high-performance and
reliable infrastructure.

Steve Rubel
http://tinyurl.com/24n7va
http://www.micropersuasion.com/2007/12/wikipedia-
and-w.html
Google announced last night they are starting a project
called knol that will allow anyone to create wiki-like
pages on topics. In particular, Google is encouraging
people who know a particular subject to write an
“authoritative” article about it. The search engine will
not vet any of the content, however, they will prioritize

the most credible entries and rank them first in search
results. It remains unclear how Google is measuring
credibility—a scary thought.

...My initial take on this is that knols are going to
kill Wikipedia—but it will take time. This theory,
however, hinges on whether people actually start
creating knols, but I believe they will. Here are several
reasons why Wikipedia and Wikia are dead ...

Mark ‘Rizzn’ Hopkins
http://tinyurl.com/2gdjsv
http://mashable.com/2007/12/13/citizen-journalism-
dangerous-and-irresponsible/

Why are Thomas, Hazinkski, and a growing number of
mainstream journalists suddenly saying that those of us
who are in the New Media shouldn’t be trusted? Has
there been some major faux pas that we’ve committed
and didn’t know? Did the bloggerati collectively all break
one of the “unwritten ethical standards” recently?

No, the impetus for the criticism lately from all
sides isn’t something we did, it’s something CNN did.
Those that remember the controversy I caused a few
weeks ago even intimating that New Media could be
getting a black eye from the Republican YouTube-CNN
debates are likely groaning right now, because what I
predicted is starting to come to pass...

Serious issues this
month. What’s the
connection between
social networking and
large portals? Then,
the OLPC project still
runs strong in
blogging circles... and
then, what’s gotten
into the head of the
Chinese government?

So Call Us Warped

There’s this sad site at
www.avazo.com. From the

Welcome Page: “Welcome to
the online web magazine,
modern digital media
newspaper, blog—
www.avazo.com. This is a great
portal for articles publications
and discussions, demonstration
all kind of images legal,
acceptable and pleasant for the
whole family. You could publish
any information about you in
the modern world, how you live
and what you like! We accept
and will publish your personal
opinion and you could see what
other people think about it. 

“What you’ll find here...
Everything I want to include, as

an editor and owner of this
Internet digital magazine.”

We’re calling it “sad”
because it’s so genuine, so
innocent, so depressingly
naive. And it’s so sad, it’s funny.
Call us warped.

The editor and owner of
that Internet digital
magazine is Russian. This,
therefore, seems to be a site
for Russians in America to
feel sort of American and
democratic, to feel free and
brave. A sample from the
“Last Additions” (sic):
“Buying a home, although is
a good investment and it can
put a tremendous strain on
your finances. Actually the
monetary cost of buying a

house or a piece of property
is so large that most people
would not be able to pay for
it straight from their pockets.
This is where a mortgage
comes into play.” Russians in
America, unite! You have
nothing to lose but your
debt! Learn from fellow
Russians about buying
property in America, owning
your own money, even that
capitalist banks will give you
a loan! 

Don’t miss “Google: Good
or Evil?” in the Articles section.

You need to have a
genuinely heartless sense of
humour to be able to laugh at
the site. Don’t forward the
joke—people will like you less.

But it’s rather more
interesting to go over it
country-by-country, just so
we can poke fun at people by
means of crude comments.

We didn’t know the
Internet had extended to
Afghanistan yet, but very
apparently, it has. Interesting
top search terms include
“map” at #1 (they need to
know!), “afghanistan” (talk
about ego surfing!),
“pakistan” (talk about hero-
worship), “vida guerra” (oho,
they’re a**-men!), and BBC
(ego-surfing again; they
know they’re constantly
reported about).

In India, “PAN card” and
“income tax department”
wer getting really popular in
November. (Oh well, just
money matters.) But there
were two more money-
related terms on the list:
“tata mutual fund” and
“financial express”. Probably
signs of a healthy economy.

“Priyanka Chopra” was
at #2, and “Times of India”
was at #7, for the UK in
November. We aren’t too
Bollywood-savvy, and
neither do we read the
newspapers too much, so
we have no idea why... but
we’re guessing there are
more Indians in the UK
than ever before (but that
could have been deduced by
means of basic logic

anyway, since those that go
there don’t come back).

FAIR DEAL 

Let’s Get Bad
This
Christmas

It’s amazing what fathers
will go through for their
prized offspring. It’s also

amazing how said offspring
can go into blithering-idiot-
mode with alarming
regularity. A combination
of the two can lead to one
ticked-off parent, as one
wayward 15-year old in
Canada was soon to learn.

The father—a
schoolteacher—had gone
through extraordinary
lengths to get his son a copy
of Guitar Hero III for the Wii—
which is apparently the
Ultimate Christmas Gift, if
the ridiculous demand is
anything to go by. 

Alas, heartbreak was
soon to ensue. As he
returned early from work
one day, this father caught
his son smoking marijuana
with his “delinquent
friends”. He kept his cool in
the moment (well, not
really), secretly plotting a
punishment that befit the

crime, and then some. That
copy of Guitar Hero III he so
painstakingly bought? He
sold it on EBay. As a reason
for selling, he mentioned
his son’s indiscretions and
told buyers, “If you can
convince me that he still
deserves the gift, then I will
end the auction.” Not
enough people thought so,
apparently, because the
auction closed when an
Australian buyer put up $
9100.01 (Rs 3.64 lakh) for
the game (we told you it was
the Ultimate Gift). 

The father—whose
nickname on EBay is k_lid—
still loves his son though,
and plans on getting him
another game for his Wii—
”something like Barbie
Island Princess”, he
contemplates. Punish kid,
make a pile, punish kid
again. You can’t make up
happier Christmas stories.

FROM DINGO TO LIMBU

What Is In A
Name,
Really?

You probably haven’t
heard of these
recently-up Web sites:

Squidoo, Kayak, Pownce,
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Audio Remixing
A remixed song is, simply
speaking, an alternative,
augmented version of a song:
multiple other tracks, music
samples, loops, and sound
effects are added to the
original. Since remixes are so
popular these days, you might
just seem silly if you don’t
know how it’s done. Here are
some terms to help you not
seem silly.
Console: Also known as a
mixing deck, it is the control
panel for making the changes
to the audio track. 
Synthesizer: An instrument
that can be used for
generating new sounds from
raw audio material such as
waveforms—and also for
generating original sounds.
Filter: A circuit that carries
hundreds of knobs, used for
eliminating certain
frequencies and letting other
frequencies pass through.
Scratching: The technique of
moving a vinyl record to and
fro by hand on the mixer with
the phono cartridge for
creating different rhythmic
sound patterns.
EQ (Equalisation): The
process of altering, cutting,
or boosting the levels of
individual frequency bands
within an audio signal using a
number of filters. This control
can be simple or highly
complex, depending on
software or hardware.  
Fader (Slider): This acts as a
control device used for the
precise manipulation of audio
levels—something like an
advanced volume control.
BPM: The unit that defines
the pace of music—beats per
minute.
Usage: Last night, I got a
chance to remix some songs
at a local discotheque on the
DJ’s console hooked up to
their synthesiser. Whenever I
increased the BPM—or used
the fader to change the track,
the audience would roar like
crazy! I need to improve my
scratching technique and
learn EQ by working on filter
adjustments.

Wild Wild Web

n In a bottle-cap promo, Pepsi will offer 1 billion DRM-free songs on Amazon n Blu-ray site hacked; redirects to the official HD-DVD site 
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You’ve won a lottery…
Get a free iPhone…
Resize your manhood…

The bigger the better… You
can easily recognise these as
the subject lines of the
delete-worthy mails in your
Inbox. However, intriguing
subject lines do entice a
select few idiots into
opening the mails—in case
you didn’t know.

Creating good spam
filters to tackle such mails
has been the agenda of many
security companies, working
with Web-based mail service
providers. McAfee recently
decided to think outside the
box; the company said they
would be hiring volunteers
from the UK and the US for a
thirty-day spam analysis. The
research has been dubbed
“Super Spam Me.” The
distasteful thing the
volunteers would have to do
is to reply to the spam
messages; this act will
supposedly help the
researchers figure how that
will affect the flow of spam.

The project, if one may
call it that, will only include
a few paid volunteers.

Here’s the first bit of
hilarity: applicants would
have to send an e-mail to
the company that oversees

McAfee’s PR work. Seeing as
the job (namely, to reply to
spam messages) is easy to
perform, there will
doubtless be thousands of
volunteers (people tend to
like money). The poor slobs
will now receive more
McAfee PR mails than other
spam, we can bet.

In case you haven’t
figured it already, the second
point here is that everyone
knows what’s going to
happen. When you respond

to a spam mail, you’re going
to get more spam—for those
not in the know, this is
because the spammer gets to
know that yours is a valid,
active e-mail address. So
what’s with the bit about
analysing how the flow of
spam would be affected? If
you can guess, if we can
guess, McAfee can guess,
too—more spam, period.

The deal, evidently, is
this: get paid to get more
spam—from your spammers

as well as from us. Quite
normal for a regular Web
company to be offering
something like this—but not
quite normal for a company
that should be spending its
time making spam filters.

PRIVACY WOES

No more
pokey-
pokey!

Of Change And Small Change
Bidding farewell to Deepak Ajwani as

Editor—in fact, as a member of this
organisation—was a mixed affair. It was sad
for most of us; one or two women wept the
way some women do when the time comes
to say good-bye. The chaiwala, however, was
glad, because Deepak never had never given
him a tip—we know because he told us.

The ourgoing (rather, the out-went) editor
had won our minds and hearts by virtue of
his genuineness, his big heart, his lack of
attitude and ego issues, and his
unwillingness to wield the stick of discipline
(the above, not in any order—really!). But in
particular reference to the last point, we
should mention that Nimish and Robert got
to play Quake, Ram got to sleep, Samir got to
use his PSP, Bhaskar got to do
his Wikipedia edits, Asfaq

got to chat, Vijay got to surf for exotic
pictures, etc. etc.—during official, paid, office
hours. Still, we should reinforce the idea that
this thing about Deepak’s not having been
strict about discipline was not the biggest
reason for our loving him.

Robert now manages the things Deepak
did, and we’ll soon begin to treat him in this
space the way we’ve been treating Deepak.
For example, fun shall often be poked at
him, and gentle ridicule shall sometimes be
directed his way.

We collectively gifted Deepak a good
phone, because it’s better to give than to
receive (and when you know you won’t receive if
you ask, it’s even better to quietly give).

Now, a source says Robert hasn’t yet given
the chaiwala a tip either. Surprising: his

name doesn’t end in “-ni”...

n Xxx n Xxx 

Jonathan Bradford and Ian Leader
http://tinyurl.com/2ogfxk
http://www.readwriteweb.com/archives/online_accoun
ting_google_apps.php

...So what’s next for Google Apps? What might be the
next killer app? We think it will be an accounting system
and in this article we will outline why. There are strong
benefits to an online accounting service in Google
Apps—both to users and to the targeted advertising-
driven business of Google...every site. What does this
have to do with the portals?

...Google could bring significant expertise to online
accounting, thanks to their ability to deliver simple,
effective online applications with high-performance and
reliable infrastructure.

Steve Rubel
http://tinyurl.com/24n7va
http://www.micropersuasion.com/2007/12/wikipedia-
and-w.html
Google announced last night they are starting a project
called knol that will allow anyone to create wiki-like
pages on topics. In particular, Google is encouraging
people who know a particular subject to write an
“authoritative” article about it. The search engine will
not vet any of the content, however, they will prioritize

the most credible entries and rank them first in search
results. It remains unclear how Google is measuring
credibility—a scary thought.

...My initial take on this is that knols are going to
kill Wikipedia—but it will take time. This theory,
however, hinges on whether people actually start
creating knols, but I believe they will. Here are several
reasons why Wikipedia and Wikia are dead ...

Mark ‘Rizzn’ Hopkins
http://tinyurl.com/2gdjsv
http://mashable.com/2007/12/13/citizen-journalism-
dangerous-and-irresponsible/

Why are Thomas, Hazinkski, and a growing number of
mainstream journalists suddenly saying that those of us
who are in the New Media shouldn’t be trusted? Has
there been some major faux pas that we’ve committed
and didn’t know? Did the bloggerati collectively all break
one of the “unwritten ethical standards” recently?

No, the impetus for the criticism lately from all
sides isn’t something we did, it’s something CNN did.
Those that remember the controversy I caused a few
weeks ago even intimating that New Media could be
getting a black eye from the Republican YouTube-CNN
debates are likely groaning right now, because what I
predicted is starting to come to pass...

Serious issues this
month. What’s the
connection between
social networking and
large portals? Then,
the OLPC project still
runs strong in
blogging circles... and
then, what’s gotten
into the head of the
Chinese government?



118 DIGIT JANUARY 2008

Which of these ridiculous-
sounding theories was floated

on the Internet in December?
(a) Most Xbox 360 units are
assembled by lepers
(b) The Wii emits a cockroach-
attracting hum
(c) The PS3 emits a lizard-repelling
hum
(d) For each PSP sold, one Chinese
kid gets richer by $1.50

What turned 60 on 17
December of last year?

(a) The typewriter
(b) The transistor 
(c) The vacuum tube
(d) GDDR3 RAM

What character can’t be part
of a filename on a Mac?

(a) The hash (#) 
(b) The backslash (\)
(c) The caret (^) 
(d) The colon (:)

What organisation devised
the printed circuit board?

(a) The US National Bureau of
Standards
(b) Texas Instruments
(c) NVIDIA
(d) Xerox

Which of the following is a
computer language?

(a) Stonehenge (b) Taj
(c) Eiffel (d) The Sydney
Opera House

Which of the following is true
about the Netscape browser

before 2000?
(a) It would crash when
“www.ww.w” was typed into the
address bar
(b) It had no Reload button
(c) The page would reload upon
resizing of the window
(d) It would crash when there were
more than 32 images on a page

Belgium, February 1998, Bill
Gates was hit in the face with

a pie. What did he do?
(a) Sued the pie-thrower
(b) Swore at the pie-thrower: “You

Steve!”
(c) Quietly wiped his face
(d) Said it wasn’t very tasty

In UNIX systems, the OS
views every entity (including

a disk!) as...
(a) A directory (b) A file
(c) A logical address (d) A virtual
location

9
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ACROSS
7. Graphics (6)
8. A machine that captures data for the computer
(6)
10. ‘C’ in CPU (7)
11. Business Process Outsourcing (abbr.) (3)
12. Short for Infosys (4)
13. Spreadsheet programme from Microsoft (5)
17. Personal Web sites in the form of online
journals (5)
18. Network configuration in which all computers
are connected by direct cables to a main hub (4)
22. Makers of the Macintosh line of computers (5)
23. ‘A’ in AOL (7)
24. In GUI-small windows containing messages
and a button to click to dismiss the windows (6)
25. One unit (6) 

DOWN
1. -----breaker- device that interrupts an
electrical path (7)
2. Zoom tool function-to increase in size (7)
3. SI unit of inductance symbolized H (5)
4. Type of printer from Hewlett Packard (4,3)
5. Graphical software solutions for network
publishing (5)
6. Server----—have codes in the 500 range (5)
9. Trademark for a tough transparent acrylic plastic that
can be substituted for glass (9)
14. Computer that can request information from a server
(6)
15. Contiguos set of alphanumeric characters that do not

contain numbers for calculations in programming (7)
16. Advanced Research Projects Agency Network(abbr)
(4,3)
19. Radio Detection and Ranging (abbr) (5)
20. -----case or capital letters (5)
21. -----player- software application that
controls audio and video of a computer (5)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

What Would Gates Do?
US Presidential Candidates
are doing this for votes:

(a) Wooing younger voters via SMS
(b) Wooing
older voters
using greeting
cards
(c) Using ad
slots on free
Net radio stations
(d) Podcasting gay-and-lesbian-
friendly speeches

1

Tim Berners-Lee, who
invented the WWW (if

we must remind you), once
said: “It staggers me that people
have actually put up with
HTML. It was never supposed to
be something that you would
see, but something produced by
an editor program.”

Did You
Know?

Answers
1. A
2. B
3. B
4. D
5. A

6. C
7. C
8. D
9. B

Crossword by Nitta Jaggi

November’s Solution

Due to an error on our mail
server, we lost all your entries
for November’s crossword.
Our sincerest apologies

Send in your entries to
TQ@thinkdigit.com on or
by 20th of this month.
One lucky participant will 
win Amazon.com
Mashups
By Francis Shanahan
Published by

Win!
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magazines, even if they were painful to
handle for you.

Team Digit

Seeing Double
First of all I would like to wish Team Digit
and all Digit readers a Happy New Year and
Merry Christmas. This is the first time I’m
writing to you, and I’ve been a reader for
the last 4 months. Digit is exactly what I
was looking for, and I save my pocket
money every month to buy it because it’s
now an important part of my life. 

The December Mega Issue is superb,
and I have read it again and again. I
would like to compliment you on this
five pack issue, especially the editorial
team. The “Tips and Tricks” in this
issue are wonderful. The “How Tos”
even more so.

I liked the Connect issue the best,
as it is related to the Web and I am
currently learning Web programming.
I have a complaint as well, I got two
Connect DVDs and no Computing DVD.
Please send it to me because I need
Ubuntu! It’s your articles that have
inspired me to stop pirating software
and use Open Source alternatives. 

I also loved the PDFs of all past Digit
and Fast Track issues. I request you to
publish a Fast Track to Web programming,
or programming in general.

Mohammad Khalid
Chandigarh

We’re so tempted to tell you that we sent you
two Connect DVDs on purpose, because we
knew you’d love that section the most. Don’t
worry, that’s not our official stand, and we’ve
already sent you a Computing DVD. We’re also
glad that you’ve gone the Open Source way
instead of pirating software like most others do.
Every such mail makes us proud to know that
we’re doing everything we can to rid India of
the “pirate nation” tag that it’s earned. It’s a
slow process, but we’re glad that people like
you have decided to lead by example.

Team Digit

On A Personal Note
I know “the editor” status is a
respectable one, so forgive me for
considering you my “editor brother”. I
was born and brought up, and studied
in Bangalore, and am currently
studying—second year, BE, Electronics
and communications. I came across
Digit in our college library and from
then on, I’m a regular reader. I’ve been
planning to write to you, but
something always came up. 

Inbox

Ads Are Good
I started to read Digit 2 years ago. I
appreciate the efforts which Digit puts in
while providing an outstanding
magazine to us. I have no complaint
regarding the Ads in Digit because it is
necessary for you and as well as readers
since these Ads provide information
about new products and technologies in
the market, and keep the price of our
Digit down. You should consider adding
some more reading materials (Articles,
Tutorials) in the Disc. It may be a good
idea if you add a Letter Section in the
Disc as well, so that more and more
Letters from the readers can be included.

Deepak Bhalla 
Aligarg (UP)

At last, someone who understands the value
of advertising. Yes it’s true. It’s the
advertising that keeps the cost of all print
media down. We like your suggestions as
well, and are planning on enhancing Digit’s
multimedia content over the next few
months. All we can say is keep reading, you
should be pleasantly surprised shortly.

Team Digit

Someone Stole Our Tagline
I’m a subscriber, (and a loyal one at
that!). Incidentally, you should know that
a new shop opened in my town, and I am
shocked to see that they are using your
slogan. The shop is called Saravanaa’s
Computer Sales & Service, and its slogan
is Your Technology Navigator. You may want
to look into this. 

I have been a reader for the past
five years, but this is my first letter to
you. I want to buy SKOAR! As well, but
it’s not available in my town. Please
tell me how I can get my monthly dose
of SKOAR! as well. 

Digit’s November issue rocked, and
my friend bought himself a PC as per
your advice, and is very happy. Only
one complaint, I haven’t received my
copy of the December issue yet, and it’s
the fifteenth already. In fact, I always
get special issues late. Please look into
this matter.

S. Prasanna
Karaikal

Imitation is the finest form of flattery, and we’re
flattered that the small business in your town is
inspired by us, and uses our slogan. Although
we’re usually quite strict about such copyright
issues, I have a feeling that our legal department
will let this one slide. We’re glad your friend
benefitted from our reviews, and you should
urge him to get his own subscription!

The December issue was delayed because
of some complications with our DVD replicator,
and thus was late going out to both stands and
subscribers. We’re trying to make sure such
issues never crop up again. Still, we understand
your point completely, and will put all our
efforts to ensure that all our readers start
getting their magazines sooner—especially our
content-packed special issues.

Team Digit

Wonderfu(e)l
I am a regular reader of your esteemed
magazine. This edition is wonderfu(e)l
(Dec 2007),  because of several reasons:
The biggest being the e-archives. I have
asked our college librarian to put them
on the library LAN under the head e-
journal, so that all students can access
any pages, anytime. Unfortunately, in
the Fast Track PDFs, you have forgotten
to include the Fast Track To Google
(Dec 2006). I have searched every nook
and cranny of all the DVDs and can tell
you that it wasn’t even accidentally
moved to another folder—it’s just not
there. Wishing you all at Digit a very
Merry Christmas and a Happy New Year
in 2008. 

V K Adarsh

Whoops! You’re absolutely right. As soon as
we got this mail we searched every “nook
and cranny” of our DVDs as well as our
backup servers and just cannot find it. We’re
guessing someone yawned a little too hard at
4 am while making DVDs and accidentally
pressed [Delete]. Yes, we mean you, Nimish!
We’re going to have to dig into our archives
and recreate the whole PDF from scratch.
We’ll provide it in our February 2008 DVD. 

Team Digit

No Competition
I am a regular reader of Digit for the
past one year. I must say that yours is
the best magazine because I had also
subscribed to two other magazines, but
quickly discontinued because Digit
satisfies all my needs. I would like to
publish your articles on my blog. I
assure you that I’ll give the necessary
credits. Hope you’ll help students like
me to help my blog visitors learn
something useful. Also, if you want I
will put a link to your subscription
page in my blog. Please give me the
requisite permission to do so.

Ajay Shivaa
Tamil Nadu

All of our articles are already published online
at www.thinkdigit.com. Our policy for requests
such as yours is to allow linkage to the articles,
and although you can post excerpts from those
articles, you cannot copy-paste the entire
article. We realise that your intentions are
noble—the fact that you asked for permission is
testimony of that. However, our legal
department makes the laws on such things.

As a personal note to our readers: if you
want to increase traffic to your Web site, try
adding unique content, instead of relying on
content that others generate. Try writing articles
of your own, and reserve the usage of content
from Digit, or other sources, as excerpts or
expert opinions. If you do so, and start getting a
lot of hits, make sure you send us your CV. 

Team Digit

Bah Humbug
I wasn’t impressed by your December 07
issue. Personally, I feel that dividing the
magazine into 5 parts was not a great idea.
The lack of a Fast Track, which I consider to
be one of the best parts of your magazine,
was even more disappointing. On the
other hand, the magazine contents and
the CD/DVD contents were fine. Please try
and give full system requirements for your
game reviews. 
OVERALL A GREAT MAGAZINE!

Ahmad Nadeem

Wow! We love it when you guys are candid
with us. To be quite honest, we received a
dozen or so mails criticising us for the 5
magazine idea. However, we’ve also received
a lot of positive feedback—see the letters that
follow—and we know we can’t please
everyone. If it’s any consolation, this was a
one off idea, and Digit is safely back to its
original form. We’re glad you liked the 5
DVDs, and the content inside the 5

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, KPT House, Plot 41/13, Sector 30, 
Vashi, Navi Mumbai 400 703

Digit will publish the best letters on these pages. Letters may be edited for clarity.
PPlleeaassee iinncclluuddee yyoouurr ccoommpplleettee aaddddrreessss iinn aallll ccoommmmuunniiccaattiioonn.. 

For subscription queries 
send an e-mail to help@jasubhai.com
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Since the story telling is
probably boring you, I’ll get right to
the point. 

Since childhood, technology has
fascinated me. I want to be a
“computer geek”, and achieve
something in this field. But I don’t
know what to do. Some people tell
me to learn programming, others
tell me to get certifications (Cisco,
MCSE, MCP, RHCE, etc.), and some
even tell me to join NIIT, IIHT and do
animation. I’m totally confused! 

All I know is that I want to be
able to achieve something great in
technology, and lead from the front.
I desperately need your help to sort
out my confusion about this vast
field of IT.

Vivek
Bengaluru

Our deepest sympathies, Vivek. We know
how vast the technology industry is, and it
really can be quite confusing. However, we
must point out that your confusion is
largely your own doing. You’re going
around asking too many people for their
opinions, and that’s never a good thing,
especially when it involves something as
vital as your career. We’re not going to add
to your confusion by suggesting a career
option for you without knowing you. We
will, however, tell you that you should read
through our Tech Careers section on a
regular basis, try and identify a field of
technology that really interests you, and
then read more about it online. You might
even want to consult a career counsellor
to see if you fit into the field that interests
you. What you need to remember is that
the field you choose needs to be very
intriguing and interesting to you, you
should have an aptitude for the kind of
work that is involved, and most
importantly, look for good growth options.
We have no doubts that once you do this,
you will succeed, and probably be featured
in a Digit article. We love your spirit
though, so make sure you never lose the
passion for technology that you possess.

Team Digit

DIGIT 2007 GTX:
EXTREME FATAL1TY
EDITION
Now that’s a DIGIT! Packed
to the brim with loads of
Tech stuff any geek would
want. I really loved your idea
to split Digit into 5 sections
with relevant individual content. I
appreciate all the work you guys put in
this month. The 2020 Love Story was very
good. I really liked the Agent 001 section,
huge reviews and articles covering every
detail possible. Mission accomplished 001!

The Gaming section was the best. I
really loved the previews of upcoming
games, and I’m happy to learn that the
PS3 will finally brush off all that dust,
with a huge collection of superb
upcoming titles. 

The five DVDs was the best ever-huge
collection of all that one would ever
need. The articles on how mobiles work,
stop motion animation, how to build an
HTPC, the weirdest gadgets,
overclocking (obviously) & the input
devices shootout were excellent. 

Now for the complaints:
l I really missed the Fast Track
l The price of a humble YES YMP45 was
priced at a hazardous 70,000 instead of
7,000.
l A shootout of the latest DVD-writers
etc., would have really helped. 
l Those without DVD drives would have
suffered.
l There was no poll!
l Way too many ads, eating up valuable
space that could have been filled with
even more information. (I really liked
the Intel ad on the DVD though)

Please continue your fight against
piracy, you guys are really contributing a
lot to bringing it down. Agent 001 has
really completed his mission! I also wish
to congratulate the artists who have done
a great job throughout the magazine. The
covers especially looked glorious. Overall,
this was the best Christmas and New Year
gift for any Digit reader.

Praveen Prakash
Kochi, Kerala

Whoa! All we can say is thanks for
appreciating the work we put into the
December issue. It wasn’t easy, especially
with the shifting of office bang in the middle
of the preparations for the issue. The
graphics designers and artists have pinned
your letter on their walls, and thank you
from the bottom of their hearts for noticing
the hard work they put into every issue.

Team Digit

Letter 
of the
Month

December 2007

ERRATA—December 2007 Personal Tech

Page 32, ASUS P525 review:
For sales inquiries contact, IDLDPL Pvt Ltd,
011-46096400, contactus@idldpl.com 
Page 35, YES YMP45 review: 
The price is wrongly printed as Rs 70,000—
it’s really Rs 6,499; Contact: IDLDPL Pvt Ltd,
011-46096400, contactus@idldpl.com



People And Events That Grabbed The Headlines—For Better Or For Worse

Deep down in our hearts,
we always want to be
like our favourite

celebrity. No, don’t deny it:
those sunglasses, clothes, and
cars—how we want to look like
them! Alas, for us ordinary
fans, the hoi polloi, these
things don’t come cheap. Their
shoes cost more than our
monthly paycheck, and we
wouldn’t be able to afford
their cars even if we worked
our arses off for life. So what’s
a ordinary guy / gal to do? Use
the cell phones the celebrities
use, of course.

The above solution might
be a tad difficult if you are a
fan of a celebrity who has a
particular attraction for gold-
plated, diamond-encrusted
mobiles. However, last we
checked, most of the usual
suspects use common
Motorolas and Nokias and
such. Maria Sharapova has
often been spotted with a pink
Motorazr. In Hollywood, phone
companies give away free
phones as publicity; business
phones from Blackberry are
the most popular among

celebs. Among its long list of
users are Tom Cruise, Angelina
Jolie, Brad Pitt, Katie Holmes,
Paris Hilton, Lindsay Lohan,
and Cristina Augilera. The
Blackberry also seems to be a
favourite assault weapon:
Naomi Campbell has been
prosecuted after beating
housekeepers and assistants
with it. The iPhone, however, is
not a hot favourite, which is
surprising because of its now-
certified hotness. This is partly
due to Apple’s not cosying up
to the Page 3 type. Another
reason would be its poorer e-
mail capabilities compared to
business phones.

Closer home, our desi
celebrities might be endorsing
handsets left, right, and
centre, but we can bet they’re
not all using the phones they
profess to love. Now while we
won’t go about naming
brands, we suggest you do a
little harder staring when next
you see a photo of your
favourite celebrity on the
phone. Then e-mail us so we
can share the data with the
rest of our readers.

Politicians are pretty much
the same the world over.
They take minor issues,

blow them out of proportion,
conjure up doomsday scenarios,
then promise voters that
deliverance lies in electing him
or her to office. They also have a
peculiar knack for missing the
forest for the trees (read:
focusing on trivial issues while
serious ones go unattended).

By these standards, Hillary
Rodham Clinton is now a full-
blown politician. While America
is in the midst of a bloody war in
Iraq, Clinton had gotten all hot
under the collar over virtual sex.
This indignation was apparently
prompted by an Easter Egg in
Grand Theft Auto: San Andreas,
where a scene shows characters

having sex. To access that part of
the game, players had to
download and install a patch,
which was far more complex
than simply Googling for more
realistic porn. This issue
occupied quite some time of the
august lawmakers, and also led
to the introduction of a failed
Senate bill. In her latest
campaign declaration, Clinton
announced that if elected
President, she would take
stringent steps to monitor
virtual sex peddled by the
gaming industry. Which would
mean countless press
conferences, debates—the works.
Now if that isn’t a nanny state,
then what is?  

Clinton is in the news for
another wrong reason: Two

anonymous, recently-
launched Web sites
featured attacks on
her main competitor
Barack Obama.
Serious allegations
were raised, and there
was quite a bit of
speculation as to who
was behind these
sites. Then someone
did some snooping
around—and found
that the official Web
site of Hillary Clinton
and these Web sites
were hosted on the
same domain. Sniping
at political rivals is
part of the game, but
getting caught due to
a minor oversight is
pretty embarrassing.
Surely with all those
campaign dollars,
they could have
afforded a different IP
address...

I f you have been reading our
past few issues, you’d have
noticed a sprinkling of

stories about music companies
suing individuals for illegaly
copying music. The premise of
these cases was that file sharing
is harmful to the interests of
artists who have toiled so hard
for success. By not buying
music, fans are cheating the
musicians of their livelihood,
and the record companies are
being the good guys, fighting
dirty legal battles while the
musicians can keep the creative
juices flowing, bless them.

All well and good, but has
anybody bothered to ask the
artists themselves what they
think? We were wondering
when some hack would try to

get it straight from the horse’s
mouth, but rapper 50 Cent has
himself stepped forward to set
the record straight. For those
not in the loop, Curtis James
Jackson III, who goes by the
undeniably silly name of 50
Cent, is one of the most suc-
cessful rappers today. The guy is
also a canny businessman and
markets his own music. Accord-
ing to him, all the hullabaloo
over file sharing is misplaced,
and artists are not really feeling
the pinch when their music is
illegally copied. He displays a
rare degree of pragmatism
when he says that musicians
have to keep up with the times,
especially musicians like him-
self, whose fans were younger
and more likely to adopt newer
technologies. 50 Cent sees cur-
rent DRM business models out-
dated, and feels that music com-
panies are not doing enough to
exploit marketing opportuni-
ties in merchandising and the
crowded concerts.

In other words, his message
to the music label suits was: “get
off your lazy behinds and think
smart.” We may not like his
music, but we sure appreciate
the message.

Getting The Rap

Hillary: Over 
The Hill

Phones Celebs Use

128 DIGIT NOVEMBER 2007




